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This chapter covers more advanced features found in the Color page, including how to create 
secondary adjustments to manipulate specific features in an image using Qualifiers and Power 
Windows, and how to use motion tracking to make Power Windows follow along with the motion 
of subjects and the camera. Additional features are also covered such as image stabilization, blur, 
sharpen, and mist effects, transforms, stereo grading, and window burn insertion. A section on 
advanced node structures show you how to combine Color page effects in even more detailed 
ways. Lastly, a section on keyframing describes how to create animated effects.
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Secondary correction describes isolating a specific part of the image, or a specific subject, using 
a key. Keys in Resolve are grayscale images that define which areas of the picture you want to alter 
(in white) and which parts of the picture you want to leave alone (in black). Keys are generated 
either using the controls in the Qualifier palette, by using a Power Window, or by importing an 
external matte.

This section covers the use of the Qualifier palette, which lets you pull a Chroma or Luma key, with 
which to isolate the correction you need. The Qualifier controls are fast and flexible when you 
need to isolate an irregularly shaped subject with a distinct range of color or lightness. Since you’re 
generating a key by sampling the image, there’s no need for tracking or keyframing, so in the right 
situation Qualifiers can be your fastest solution. In the following example, the client likes the slightly 
cool treatment overall, but wishes that the skin tones were a little more vibrant. This is exactly the 
sort of situation where Qualifiers can help out. Adding a second node, and using the HSL Qualifier 
to isolate the face makes it relatively simple to add color exactly where you want it.

Top–The image with a simple primary correction. Middle–Adding a second node and using HSL Qualification to  

isolate the skin tones. Bottom–The final adjusted image.

Secondary Qualifiers
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Just about every control in the Color page can be limited using qualification. This makes the 
Qualifier palette a jack-of-all-trades tool with 101 uses. A few practical examples include keying a 
red element that’s too intense for broadcast to darken it or desaturate it, keying a range of green 
foliage to shift its hue to a more attractive color, keying an actor’s skin tone in a commercial to apply 
some selective softening to it, or keying a range of sky to add blue.

Adding a Secondary Operation to the Node Editor

Any node can be switched between functioning as a primary correction, where the adjustments you 
make affect the entire image, and a secondary correction, where you’re adjusting a specific element 
in the scene. The only difference is that nodes being used for secondary corrections are limited 
using a Qualifier, Power Windows, or an external matte.

If you’re planning to add a secondary operation to the current grade, you’ll need to first add another 
node in the Node Editor. With regard to HSL qualification, it’s important to understand that you’ll be 
sampling the YRGB values being fed to that node from any previous nodes in the tree. That means 
that the state of the image being fed to a node you’re qualifying affects the key you’re pulling.

For example, if the image coming out of Node 1 is well saturated and has a neutral color balance 
with a wide range of colors, but the image coming out of Node 2 applies a low saturation, 
monochromatically orange color wash, you may find it more difficult to pull a detailed key from 
Node 2 than you would from Node 1. 

Choosing your battles–the image coming out of Node 1 will be easier to key then the highly stylized image coming out of Node 2

This is important because you have the flexibility of determining from what image you want to 
try pulling a qualified key. By connecting the node that’s outputting the best YRGB image for the 
key you’re trying to create to the node you’re qualifying, you can control what you’re keying. This 
flexibility is described in more detail in Chapter 6, “Manipulating and Combining Keys.”
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The DaVinci Resolve Qualifier palette interface is straightforward. To the left, graphical controls 
above numeric parameters let you manually adjust what ranges of each color component contributes 
to the key you’re creating. To the right, Blur and Shrink parameters let you alter the key, while a set 
of Selection Range tools below lets you define a key by sampling pixels of the image, either using 
the pointer, or by using the fourth trackball of a DaVinci control surface.

Qualifier palette with HSL controls selected

The default qualification mode is the HSL Qualifier, which uses three color components, hue, 
saturation, and luma, to define a key. However, you can also use the RGB or LUM (Luma) qualification 
modes to pull keys using other combinations of color components. The LUM qualifier mode, in 
particular, lets you make targeted adjustments to specific ranges of image lightness. This is a 
technique employed by many colorists to alter color temperature within a specific range of image 
highlights or shadows.
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Basic Qualification: Sampling the Image

The most straightforward way to use image qualification is to sample the image in the Viewer. A set 
of four controls let you sample the image in different ways.

 > Sample Eyedropper: The first control you use whenever sampling the image. It defines the 
initial range of the qualification; you must use this tool before any of the others. Clicking 
once with this tool selects a single pixel value, while clicking and dragging selects a range 
of image values that add together.

Color Picker button

 > Add/Subtract Color Range: These two controls let you add areas of the image to, or subtract 
them from, the currently selected inner range of values that define the core of the key. As 
with the eyedropper, you can click on single pixels, or drag over a range of color.

Add and Subtract color buttons

 > Add/Subtract Softness: These two controls let you redefine the softness that transitions 
from the inner range of the key, falling off towards the outer edge of the key. Just like the 
other controls, you can click on single pixels, or drag over a range of color.

Add and Subtract qualifier softness

Note: When you select one of the sampling controls, it remains selected until you select another 
sampling control. If you select another clip in the Timeline, then click in the Viewer to sample a key 
and nothing happens, make sure that you select the Eyedropper control in the Qualifier palette.

If you’re working with the Resolve on-screen interface, the easiest way to qualify a subject is to use 
the pointer in conjunction with the sampling controls.
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Example image to qualify

To sample a subject in the Viewer for qualification:

Eyedropper in the OSD menu of the viewer

1. Open the Qualifier palette, and click the eyedropper.

2. Either click a pixel of the subject you want to sample, or click and drag across a range of pixels 
within that subject.

Picking to qualify the ocean

3. To see the key you’re creating as you work, click the Highlight button. The area of the image 
you’re isolating appears in color, while the area of the image being excluded appears 
solid gray. 
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Viewer image with highlight turned on, isolated region appears in color, omitted region appears gray

 Even though the highlight obscures the rest of the image, this doesn’t prevent you from using 
the sampling tools to select pixels you can’t see.

4. To subtract from the inner range of the key you’re creating, click the minus Color Range control, 
and click or drag across the portion of the keyed image that you’d like to exclude.

5. To add softness to the outer range of the key you’re creating, click the plus Softness control 
and then click or drag across the portion of the image you’d like to include as a soft edge.

6. When you’re finished, click the Highlight control to turn the highlight off, and make whatever 
adjustment you need. In this example, the saturation has been raised and the color balance 
changed to make the adjustment obvious.

Increased saturation of the qualified blue shirt

If you have a DaVinci control surface, you can use the fourth trackball to sample the image, referring 
to either the Viewer or the display connected to the video output of your DaVinci workstation.
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To sample a subject using the DaVinci control surface:

1. Press VECTORS on the T-bar panel to open the Qualifier palette, which defaults to the HSL 
Qualifier controls.

2. Press CURSOR (the third button above the fourth trackball) on the Center panel, to display the 
small cursor crosshairs in both the Viewer and the video output display.

3. Use the fourth trackball to position the cursor over the subject you want to sample, and 
press the leftmost of the three buttons appearing underneath the fourth trackball to sample 
the image.

4. Press HILITE on the Transport panel to turn on the highlight so you can see the key you’re 
creating, and then use the knobs at the top of the Center panel to adjust the range and 
softness parameters to obtain the most accurate key for your purposes.

Qualifier Presets

There is a set of HSL Qualifier presets, or Six Vector presets, that you can use to isolate automatically 
a predefined wedge of color (green, blue, red, magenta, yellow, or cyan) or chroma intensity (chroma 
light, chroma dark, or both). These presets are available either from the Color > Presets menu, or 
from the DaVinci control surface.

Selecting one of these presets automatically sets the HSL Qualifier to the corresponding range or 
color or lightness. Afterwards you can continue modifying the HSL Qualifier to suit your purpose.

To choose a Six Vector preset from the DaVinci control surface:

1. Press the PRESETS soft key on the Center panel. The Center panel’s soft keys update with all 
the available lightness and color presets.

2. Press the soft key corresponding to the preset you want to use. The HSL Qualifier updates with 
the new settings, and the Center panel goes back to the main page of soft key controls.
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Using Highlight to See What You’re Isolating

The Highlight control lets you overlay a representation of the key you’re creating over the current 
image in the Viewer. Overlays are also mirrored to your video output, so they’ll show up on an 
external display as well, in the event that you’re hiding the on-screen Viewer.

There are two types of highlights with which you can evaluate a qualification you’re creating. Each 
is useful for different tasks.

 > Flat-Gray: The default highlight that Resolve uses shows the selected portion of the image 
with the original colors, and the unselected portion of the image with a flat gray. It is useful 
for seeing the subject you’re isolating even while you’re adjusting the Qualifier controls, 
which lets you also see the color or contrast adjustments you’re applying at the same time.

Oranges qualified and highlighted

 > High-Contrast: Pressing Option-Shift-H, you can show what’s called a “high-contrast” 
highlight, which should be familiar to you if you’ve used other color correction applications 
and plug-ins; it’s a more typical display wherein the selected portion of the image is white, 
and the unselected portion of the image is black. The high-contrast highlight is useful in 
situations where you need to eliminate holes in a key, or evaluate how “chattery” a key is 
since irregularities are easier to spot when divorced from the original image.

Hi-Contrast B&W highlighting
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To enable or disable a flat-gray highlight, do one of the following:

 > In the Qualifier palette, click the Highlight control.

 > Choose View > Highlight (Shift-H).

 >On the T-bar Panel of the DaVinci control surface, press HILITE. To enable or disable a high-
contrast highlight, do one of the following:

 > Choose View > Highlight BW (Option-Shift-H).

 >On the T-bar panel of the DaVinci control surface, press SHIFT DOWN and then press HILITE.

To make high-contrast black and white the default highlight:

1. Open the Settings window.

2. Open the General Options and turn on “Mattes display high contrast black and white.”

3. Click Save.

 The next time you click the Highlight control in the Qualifier palette, or press HILITE on the 
DaVinci control surface, the high-contrast highlight will display.

Using Highlight to Solo Nodes

There’s one other use of the Highlight control, and that’s to solo individual nodes in the Viewer and 
video out, rather then outputting the sum of the entire node tree. For example, if you’re trying to 
adjust a stack of nodes attached to a Parallel or Layer Mixer node, it’s difficult to see what you’re 
doing while adjusting one of the stack of nodes, because only the final result is being output. 

However, if you turn on Highlight with no key being generated, then only the currently selected 
node is output, making it easy to view just one node as you adjust it. Just make sure you turn 
Highlight off before moving on, or you may confuse yourself.

Qualifier Parameters

Each of the Qualifier modes has parameters that correspond to the relevant color components 
for that mode, with which you can identify a range and softness, similar to using the sample tools. 
These parameters can be edited as virtual sliders using the pointer, or you can modify them using 
the knobs of the DaVinci control surface.

HSL Qualification Controls

The HSL Qualifier is by far the most versatile mode of the Qualifier palette. It’s also the qualifier 
that’s easiest to understand, and the easiest to adjust by hand if you don’t feel the need to sample 
the image. By selecting range and softness for each of three different color components, hue, 
saturation, and luma, you can isolate a wide variety of colorful subjects, or ranges of image lightness 
and saturation.
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Oranges qualified and highlighted

One of the HSL Qualifier’s key strengths, and one of it’s most underutilized features, is that you can 
enable or disable each of the three HSL components using the Hue, Sat, and Lum checkboxes, 
found at the bottom left of each Qualifier range control. This lets you ignore specific color 
components, while focusing on others that are more important. For example, if you’re trying to 
isolate the saturated parts of an image, regardless of the hue or brightness, you can turn off the Hue 
and Lum qualifiers so that only Sat is used to sample the image.

Qualification with saturation only to isolate the most saturated portion of the picture
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The HSL parameters include:

 > Hue Center: Defines the center of the range of Hue being isolated.

 > Hue Width: Defines the width of the range of hue being isolated. Widening or narrowing 
this parameter widens and narrows the range of hue about the current Hue Center.

 > Hue Soft: Widens or narrows the falloff at both sides of the currently selected range of hue.

 > Hue Symmetry: Lets you selectively alter the angle of Hue Soft falloff at either the right or 
left side. Lowering this parameter makes the softness to the right of the hue range grow 
steeper. Raising this parameter makes the softness to the left of the hue range grow steeper.

 > Sat Low/High: Two parameters let you define the upper and lower range of saturation 
being isolated.

 > Sat Low Soft/High Soft: Two parameters let you define the upper and lower softness falling 
off outside the current range of saturation.

 > Lum Low/High: Two parameters let you define the upper and lower range of luma 
being isolated.

 > Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of luma.

RGB Qualification Controls

The RGB Qualifier mode lets you isolate range and softness in the Red, Green, and Blue channels 
of an image. While this is not necessarily an intuitive way of manually creating a qualification from 
scratch, it can provide a different way of isolating potentially trickier ranges of the RGB color space. 

If you start by sampling the image, then you can widen and narrow each color channel’s isolated 
range of values. In some cases, you may find it’s faster to isolate a specific range of continuous color 
by adjusting these controls.

RGB qualification controls
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The RGB parameters include:

 > Red Low/High: Two parameters let you define the upper and lower range of the Red channel 
being isolated.

 > Red Low Soft/High Soft: Two parameters let you define the upper and lower softness falling 
off outside the current range of red.

 > Blue Low/High: Two parameters let you define the upper and lower range of the Blue 
channel being isolated.

 > Blue Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of blue.

 >Green Low/High: Two parameters let you define the upper and lower range of the green 
channel being isolated.

 >Green Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of green.

Luma Qualification Controls

The Luma Qualifier mode simply pulls a key from the Luma channel all by itself. It’s identical to the 
HSL qualifier with H and S turned off. This single-component keyer is more useful than you might 
think; it’s a common technique to isolate a range of highlights, midtones, or shadows throughout 
the image to alter the color temperature selectively.

Also, keep in mind that the luma component is the sharpest keyable component when you’re 
working with heavily compressed video. Keys that are noisy or chunky with HSL qualification may be 
sharper if you just use the Luma Qualifier, although you won’t be able to be chromatically specific.

The Luma Qualifier has four parameters:

 > Lum Low/High: Two parameters let you define the upper and lower range of the luma 
component being isolated.

 > Lum Low Soft/High Soft: Two parameters let you define the upper and lower softness 
falling off outside the current range of luma.

Matte Finesse Controls

After you’ve used the sample controls and Qualifier parameters to create the most useful key for 
your purposes, you may find that it has problems that cannot be overcome easily by the available 
adjustments. Issues such as chattery edges, holes, or noisy bits can sometimes be easily fixed 
using the Matte Finesse controls. These controls filter the output of the Qualifier controls and are 
adjustments that are made to the matte itself, so they may work well in some instances, and poorly 
in others, depending on what you’re trying to do.
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Denoise

Raising the Denoise parameter selectively reduces the noise in a key, getting rid of stray areas of 
qualification and filling small “holes” in a difficult matte. Raising Denoise excessively can result in 
a soft spread around the edges of the matte. The range is 0 (minimum) to 100 (maximum), with 0 
being the default setting.

Before/After raising Denoise

Black Clip

Raising Black Clip applies a “lift” adjustment such that translucent areas of the matte (gray areas 
when viewing a high-contrast highlight) are pushed towards black. The range is 0 to 100, with 0 
being the default setting.

Before/After raising Black Clip

White Clip

Lowering White Clip applies a “gain” adjustment such that translucent areas of the matte (gray 
areas when viewing a high-contrast highlight) are pushed towards white. The range is 0 to 100, with 
100 being the default setting.

Before/After lowering White Clip
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Blur Radius

In small amounts, blurring a key does well to take the edge off problem edges. However, blurring a 
key can also feather the edges of a key past the border of the subject you’re keying, with the result 
being a visible “halo” around your subject depending on the adjustment you’re making. The range 
is 0 to 2000, with 0 being the default. With such a large maximum blur radius, combined with the 
capabilities that the In/Out Ratio provides in customizing the direction of spread, you can turn some 
pretty precarious mattes into surprisingly smooth and useful results.

Tip: If haloing is a problem, you can try adjusting the In/Out Ratio parameter, or you may want to 
consider using the Qualifier Softness parameters to feather the edges of the key, instead. 

Using the blur parameters to soften the edges of a key

In/Out Ratio

Controls whether the “Blur Radius” is applied equally to the inside and outside of the edge of the 
matte (zero), applied only within the matte (negative values), or applied only outside the matte (positive 
values). Using In/Out Ratio can help eliminate fringing when using the Blur Radius parameter.

(Left) In/Out Ratio lowered so blurring ends at the edge of the matte and feathers inward,  

(Right) In/Out Ratio raised so that blurring starts at the edge of the matte and feathers outward

However, you can also use In/Out Ratio even in situations where no Blur Radius is applied at all. 
Raising In/Out Ratio will fill in small black holes in the matte, while lowering In/Out Ratio below 0 will 
eliminate speckling by pushing small white bits of the matte towards black.

(Left) In/Out Ratio controls lowered to expand holes in the Matte,  

(Right) In/Out Ratio controls raised to fill in small black holes in the matte
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The Many Ways to Invert a Key

Sometimes, you’ll need to isolate a subject or range of values in an image, and then make a change 
to everything else. One way to do this is to add an Outside node after the node in which you’ve 
created the key. This lets you make one set of adjustments to what you’ve keyed, and another set of 
adjustments to everything outside the key.

If you just need to make a simple adjustment, you can invert the key from within the Qualifier palette. 
However, there are three other ways to invert a key.

 > The Qualifier Invert button: Clicking this control simply inverts the key being generated by 
all of the controls within the Qualifier palette.

 > Key Palette Input Invert: The Qualifier Invert control within the Key palette provides another 
control with which you can invert the key that’s generated by the Qualifier palette.

 > Key Palette Output Invert: The Output Invert control within the Key palette is notable 
because it inverts the sum of all keys applied within that node. For example, if you’re using 
a Qualifier in conjunction with a Window, the two invert controls mentioned previously 
will only invert the Qualifier key; the Window key remains unaffected. However, using the 
Output Invert control inverts the overall combination of the Qualifier key and the Window, 
all together.

Combining Qualifiers and Windows

This is covered in more detail shortly, but if you create a key using one of the Qualifier modes, and 
you then add a Window, the final key that’s output by that node is limited to the intersection of the 
Qualifier key and the Window. This makes it easy to use a Window to “garbage matte” out bits of a 
key that you don’t want, that can’t be eliminated by further adjustment of the Qualifier controls.

(Left) The woman’s skin tone is too close to other elements in the scene.  

(Right) A Circular Power Window is used to further isolate the woman being isolated.
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Power Windows are another way of making secondary correction, being essentially shapes you can 
use to isolate regions of the image. Different controls let you use oval, rectangular, polygonal, or 
custom curved shapes. Because you can isolate regions of the image by drawing, Power Windows 
produce exceptionally clean results, with edges that can be precisely positioned and feathered to 
achieve a variety of effects.

Before/After PowerCurve Power Window isolates the sky area for a targeted correction

Power Windows are excellent when what you need to adjust can be encompassed within a clearly 
defined geometrical area. For example, the oval of a person’s face, the front of a car, or a wide 
expanse of sky are all good candidates for windowed adjustments. A drawback of windows can be 
that they must be animated to follow whatever subject they’re isolating. Fortunately, this is where 
DaVinci Resolve’s powerful tracker comes in, making it easy to track Power Windows quickly and 
accurately to follow along with the subject being isolated.

Circular Power Window to focus attention to the skin

Power Windows
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DaVinci Resolve makes it easy to combine multiple Power Windows in different ways, to intersect 
with one another and create even more sophisticated shapes. For example, multiple windows can 
be added together, or one window can be used to cut out part of another window, which saves you 
from the need to make complicated keyframing operations to animate that window’s shape.

Multiple Windows combined to isolate and mask the image

This section covers the use of Power Windows, how to create and modify them, as well as how to 
combine multiple windows, and combine windows and qualifiers to create highly specific isolations.

Adding Nodes with Windows

As with qualifiers, you must first add a node to a grade’s node tree before you begin windowing a 
correction. This is because all of the windows within a particular node work together to limit that 
node’s grade. As a reminder, any node can be changed from a primary operation that affects the 
entire image, to a more targeted secondary operation, simply by turning on a window, using a 
qualifier, or enabling an external matte.

Serial nodes showing the window on Node 2

If you don’t create a new node before creating a window, you’ll discover you’ve inappropriately 
changed a primary correction into a secondary correction. If you create a new serial node, you’ll 
then need to use the controls found within the Window palette to turn on a window to customize 
for your purposes. However, there are also a set of commands you can use to add serial nodes with 
a window already turned on, saving you a few clicks or button presses in the process.
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To add a new node with a window already turned on:

 > Choose Nodes > Node + CPW (Option-C), or press the button of the same name on the 
T-bar panel of the DaVinci control surface to create a new serial node with a circular window.

 > Choose Nodes > Node + LPW (Option-Q), or press the button of the same name on the 
T-bar panel of the DaVinci control surface to create a new serial node with a linear window.

 >Choose Nodes > Node + PPW (Option-G), or press the button of the same name on the T-bar 
panel of the DaVinci control surface to create a new serial node with a polygonal window.

 >Choose Nodes > Node + PCW (Option-B), or press the button of the same name on the T-bar 
panel of the DaVinci control surface to create a new serial node with a PowerCurve window.

When you add a node with a Power Window, the Window palette automatically opens up, ready 
for editing.

The Window Palette

The Window palette is divided into three sets of controls: the Window list, the Presets, and the 
Transform and Softness controls.

The Window Palette Interface

Once you’ve created a node with which to apply a Power Window correction, you need to open the 
Window palette if it hasn’t been opened already.

To open the Window palette:

 > Click the Window palette button.

 > Press the WNDWS button on the T-bar panel of the DaVinci control surface.
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The majority of the Window palette is occupied by the Window List, within which you can create as 
many windows as you need for the task at hand. There are five types of windows you can create, 
each of which has a different geometry. You can use these windows individually, or you can combine 
them to create even more complex shapes and interactions. The Window palette has four groups 
of controls that let you use these windows in different ways.

The Window palette Window list

 >Window List: A row of buttons at the bottom of this list lets you add new windows to this 
list, which you can then customize as necessary. Each window in the list exposes an On/
Off button, shape type, invert button, mask button that governs how that window interacts 
with the other windows that are currently enabled (adding to other nodes by default, 
or subtracting from other nodes in Mask mode), and a Layer Name field you can use to 
identify what each window is for.

 > Transform parameters: Controls the overall size, aspect ratio, position, and rotation of the 
currently selected window. 

 > Softness parameters: Controls the edge softness of the currently selected window. Different 
window shapes have different softness options.

 >Window Preset pop-up menu: A menu to which you can save presets of individual or 
multiple windows for easy recall later.

 >Option pop-up menu: The Option pop-up menu has commands for resetting windows, 
deleting windows, saving and managing window presets, and copying and pasting 
track data.

There are five types of windows you can create:

 > Circular: An oval that can be shaped, sized, and feathered to solve an amazing number 
of problems.

 > Linear: A four-point shape that can be edited into any kind of rectangle or trapzoid you 
might need. In addition to the center and corner controls, you can also drag any of the four 
sides to change the shape.

 > Polygonal: A four-point shape that can be expanded with additional control points to create 
complex sharp-cornered polygonal shapes.

 > PowerCurve: A Bezier drawing tool that you can use to create any kind of shape, curved, 
polygonal, or mixed, that you require.

 >Gradient: A simple two-handled control for dividing the screen into two halves, with options 
for the center, angle, and feathering of the shape. Good for fast sky adjustments.
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Managing Windows

To manipulate a window, first you need to create the type of window you want to use, or if you’ve 
got a group of windows created already, you need to select the window you want to work on.

Methods of creating and selecting windows:

 > To create a new window: Click the Create Window button (at the bottom of the Window list) 
that corresponds to the window you want.

 > To create a new window using the DaVinci Control Surface: Press WNDOWS on the T-bar 
panel, then use the UP and DOWN buttons on the Trackball panel to select the window 
type you want to apply, and press ADD.

 > To select a window using the on-screen controls: Click anywhere within a window to select 
it in the Viewer.

 > To select a window from the Window list: Click the Shape icon button corresponding to the 
window you want to select. 

To delete a window you no longer want: 

 > Select a window, then choose Delete Selected Window from the Option pop-up.

To reset one or all windows:

 > To reset one window to its default shape: Select a window, then choose Reset Selected 
Window from the Option pop-up.

 > To reset all windows: Choose Reset All Windows from the Options pop-up.

Showing and Hiding On-Screen Window Controls

When you open the Window palette, the Viewer goes into Power Window mode. Enabling a window 
makes that window’s on-screen controls appear within the Viewer, and are mirrored to video out so 
you can see the window controls on your external display. If you like, you can change how and where 
the on-screen controls appear.

To choose whether on-screen controls are mirrored to video out, or disabled:

 > Choose an option from the View > Window Outline submenu.

There are three options:

 >Off: Hides the window outline on both the external display and the Viewer.

 >On: The default, shows the window outline on both the external display and the Viewer.

 >Only UI: Hides the window outline on your external display, but leaves it in the Viewer.

To show or hide window on-screen controls using the DaVinci control surface:

 > Press SHIFT UP and then DISPLAY/CURSOR, above the fourth trackball on the Center panel.
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This command is a three-way toggle. The first use of this command hides the window outline 
on your external display, but leaves it in the Viewer. The second use of this command hides 
the window outline on both the external display and Viewer. The third use of this command 
shows the window outline on both the external display and Viewer.

Window Transform Controls

Windows have transform parameters that are similar to those found in the Sizing palette. These 
parameters let you alter the window, affecting all of its control points together.

Window transform controls

 > Size: Scales the entire window up or down. 50.00 is the default size.

 > Aspect: Alters the aspect ratio of the window. 50.00 is the default value, larger values make 
the window wider, and smaller values make the window taller.

 > Pan: Repositions the window along the X axis. 50.00 is the default position, larger values 
move the window to the right, smaller values move the window to the left.

 > Tilt: Repositions the window along the Y axis. 50.00 is the default position, larger values 
move the window up, smaller values move the window down.

 > Rotate: The default value is 0. Increasing this parameter rotates the shape clockwise, 
decreasing this parameter rotates the shape counterclockwise. 

 >Opacity: Lets you vary the transparency of an individual window’s contribution to a 
node’s key.

The transform parameters also correspond to onscreen controls found in the Viewer, which can be 
manipulated directly using the pointer.
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Manipulating the window position on the Viewer

While many of the on-screen controls correspond to parameters within the Window palette, 
some on-screen controls, such as the control points that govern reshaping linear, polygonal, and 
PowerCurve windows, are only adjustable via the pointer.

On-screen controls for window transforms:

 > To select a window: Click on one of an arrangement of many windows to select it, making 
that window’s controls active.

 > To reposition a window: Drag anywhere within the window’s onscreen control. Window 
position corresponds to the Window palette’s Pan and Tilt parameters. For a Gradient 
window, drag the center control point.

 > To resize a window while locking its aspect ratio: Drag one of the four blue corner points out 
to enlarge, or inwards to shrink. This corresponds to the Window palette’s Size parameter.

 > To squish or stretch a window, altering its aspect ratio: Drag one of the blue top, bottom, 
left, or right control points. These adjustments correspond to the Window palette’s 
Aspect parameter.

 > To rotate a window: Drag the top inner blue rotate handle, in the middle of the window. For 
a gradient, drag the bottom arrow handle.

 > To change a window’s center of rotation: Command-drag the bottom inner blue rotate 
handle to a new location.

 > To alter window softness: Drag any one of the magenta softness handles. Different window 
shapes have different sets of handles, which correspond to the Softness parameters.

 > To reshape a linear window: Drag any of the green corner handles to corner pin the window, 
or drag one of the green top, bottom, or side handles to move an entire side segment of 
the window around.
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 > To reshape a polygonal window: Turning on a polygonal window reveals a simple green 
rectangle with four corner control points. Click anywhere on the surface of the rectangle to 
add additional control points with which to reshape the polygon, and drag any green control 
point to alter its shape. Polygonal windows are limited to a maximum of 128 control points.

 > To change the size and aspect of a PowerCurve or polygon: Command-drag any control 
point to freely resize the PowerCurve about the center point.

 > To remove control points from polygonal or PowerCurve windows: Middle-click the control 
point you want to remove.

Note: Removing a control point from a Polygonal window that has already been  
animated results in that control point abruptly popping on and off at the keyframes 
creating the animation.

Window Softness

Each type of window has different Softness parameters, depending on how adjustable that window is.

 > Circular: A single parameter, Soft 1, lets you adjust the uniform softness of the oval’s edge.

 > Linear: Four parameters, Soft 1-4, let you adjust the softness of each of the four sides of the 
linear window independently. Magenta softness control points on the top, bottom, left, 
and right let you adjust the softness of each side of the linear shape independently.

 > Polygon: Two parameters, Inside Softness and Outside Softness, let you adjust the overall 
softness of a polygonal window. There are no on-screen softness control points.

 > PowerCurve: Two parameters, Inside Softness and Outside Softness, let you adjust the overall 
softness of a PowerCurve. Using the on-screen controls, you can adjust the magenta inside 
and outside softness control points independently, creating any softness shape you need. 

 >Gradient: A single parameter, Soft 1, lets you adjust the uniform softness of the gradient 
window’s edge.

Drawing a PowerCurve

The PowerCurve window is the only window that doesn’t display any on-screen controls when it’s 
first turned on. Instead, you must click within the Viewer to add control points, drawing your own 
custom shape to isolate whatever region you want.
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PowerCurve window to isolate a car

Tip: Turning on the Viewer’s full-screen mode can make it easier to draw detailed shapes. You can 
also zoom into and out of the Viewer while you’re drawing, using either the scroll wheel of a mouse 
or by pressing Command-Plus or Command-Minus.

To draw a PowerCurve:

1. Turn on the PowerCurve window style control.

2. Click anywhere in the Viewer to start adding control points and drawing the shape you need. 

3. Click and drag to add and shape Bezier curves, or just click and release to add a hard angle.

4. To finish drawing and close the shape, click the first control point you created.

Methods of modifying a PowerCurve:

 > To add points: Click anywhere on a PowerCurve to add control points.

 > To reshape a PowerCurve: Drag any control point to a new location.

 > To resize a PowerCurve: Command-drag any control point to resize the whole shape. 
Vertical and horizontal sizing are not locked.

 > To move a PowerCurve: Drag anywhere within or just outside a PowerCurve to move it.

 > To symmetrically alter a Bezier curve: Drag any Bezier handle. The opposite handle 
automatically moves in the other direction.

 > To asymmetrically alter a Bezier curve: Option-drag any Bezier handle. The opposite handle 
stays in place while you drag the current handle. Once you’ve created an asymmetric pair 
of Bezier handles, they move together as one if you simply drag a handle. You need to 
Option-drag to change the angle.

 > To change a curve into a corner: Option-double-click any Bezier curve control point to 
change it to a sharp-angled corner point.
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 > To change a corner into a curve: Option-click any corner point and drag to pull out a Bezier 
handle, changing it to a curve.

Note: Corner points cannot be moved; dragging them always turns them into curves.

 > To remove points: Middle-click the control point you want to remove.

Note: Removing a control point from a PowerCurve that has already been animated results 
in that control point abruptly popping on and off at the keyframes creating the animation.

Resetting the Window Palette

The entire Window palette can be reset using the Option menu’s Reset command.

Combining Power Windows With the Mask Control

Adding multiple windows to a single node is an easy way to create composite keys. When combining 
windows, the Mask control defines whether one window adds to another window, or subtracts from 
that window.

In the following example, Circular and PowerCurve windows have both been created, and each 
window’s Mask control is also turned on (by default), resulting in both masks being added together 
so that the sunset look correction affects both the sky and the woman’s face.

The two images show the combination of the key mattes
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By turning the Mask control of the Circular window off, the Circular window is subtracted from 
the PowerCurve.

Turning off the Mask control of the Circular window

Now, the woman’s face is being protected from the aggressive sky treatment.

The two images show the result of subtracting the circular window
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Since windows can be individually tracked and keyframed, you can quickly set up complex 
interactions of windows to solve common problems you’ll encounter. For example, when you’re 
tracking a window to follow a moving subject that moves behind something in the frame, you can 
use a second window with Mask turned off to cover the object in front. Now, when the tracked 
window intersects the subtractive window, the correction will disappear along with the subject.

You can also use the Mask control to create more complex shapes than you can with a single window.

Mattes and mask used together to make complex shapes

Furthermore, once you reach the limits of what shapes you can create using the four available windows, 
you can combine multiple nodes containing multiple shapes and qualifiers using the Key Mixer. 

Copying and Pasting Windows

If there’s a particular window you’ve created that you want to either duplicate within the current 
node, or apply to another node, you can copy and paste an individual window’s shape from one 
item in the Window list to another.

Methods of copying and pasting Windows:

 > To copy a Window: Click any enabled Window in the Window list, then click the Window 
palette option menu and choose Copy Window.

 > To duplicate a Window: After copying a window, create another window of the same type 
that you copied, and then click the Window palette option menu and choose Paste Window.

 > To paste a Window to another node: Double-click or otherwise select another node, open 
the Window palette, choose the same type of window that you copied in the Window list, 
and then click the Window palette option menu and choose Paste Window.

Saving Window Presets

If you find there’s a particular window shape or combination of windows that you use frequently, you 
can save one or more windows as a preset for easy recall whenever needed. For example, if you’re 
working on a documentary within which you find you need to do a lot of face brightening, you can 
create preset face ovals for close-up, medium, and wide shots, to save you from having to customize 
a stock circular window for every single new shot. You can also save groups of windows together as 
a single preset, in order to reuse complicated multi-window shapes.
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Window presets are available from a group of Presets controls in the upper right-hand corner of the 
Window palette.

Methods of working with Power Window presets:

Controls for saving, applying, and deleting window presets

 > To save a window preset: Once you’ve created one or more windows you want to save, click 
the plus button, type a name into the resulting dialog, and click OK. That preset is now 
available in the Preset pop-up.

 > To recall a window preset: Choose a preset in the Preset pop-up, and it’s instantly applied. 
Recalled window presets overwrite whatever other windows were set up in that node.

 > To update an already saved preset: Recall a preset, change the resulting window(s), then click 
the Checkmark button to overwrite the current preset with the altered window arrangement.

 > To delete a window preset: Choose a preset in the Preset pop-up, and click the 
Trashcan button.

Once recalled, windows created by presets can be modified and tracked just like any other window.

Using Windows and Qualifiers Together

Another use of windows is to act as a “garbage matte” when used together with a qualifier. By 
default, when you use a window and qualifier together, a key is only output where both the window 
and qualifier intersect. This makes it easy to exclude unwanted parts of a key that are too difficult to 
eliminate by further refinement of the qualifier controls.

For example, the following qualification is intended to isolate the woman’s face, but some of the 
similarly colored wood and sky in the background is also included.

Instead of driving yourself crazy trying to eliminate the unwanted parts of the key by modifying 
the current qualification, which is doing a great job of isolating the skin tones, you could instead 
use a window to isolate her face, excluding everything outside the window, and simplifying your 
job considerably.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

617

ADVANCED COLOR FEATURES12

A qualified image with highlight on

If she moves, then you can simply track the window to follow. Simple tracking is covered later in 
this chapter.

Now with additional Power Window isolation

Furthermore, you can use the window’s Invert control to do the reverse, excluding all qualified portions 
of the key inside the window, and including all qualified portions of the key outside the window.

If you need to build more complex qualifier/window combinations than this, you can add more 
windows, or you can use multiple qualifiers and windows with the Key Mixer node, which is discussed 
later in this chapter.
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Manipulating Windows Using a Control Surface
Window shape and position can also be manipulated using the DaVinci control surface. All Windows 
controls are located on the T-bar panel, except for the ADJ WINDOW button above the fourth 
trackball of the Center panel.

To enable, mask, or disable a window:

1. Press WNDWS on the T-bar panel. The Window palette should appear.

2. Press the soft key that corresponds to the type of window you want to turn on, CPW (Circular Power 
Window), LPW (Linear Power Window), PPW (Polygonal Power Window), or PCW (PowerCurve 
window). The appropriate window controls should appear with an orange highlight.

3. Press the MATTE/MASK soft key to toggle among turning the window on, turning Mask on, 
and turning the window off.

To reposition a window using the Pan and Tilt knobs:

1. Press the unlabeled soft key at the bottom-right of the T-bar panel to toggle between the 
current knob mappings on the T-bar panel, and the PAN and TILT mappings.

2. Use the Pan and Tilt knobs to adjust the window’s position.

To reposition a window using the fourth trackball:

1. If necessary, press WNDWS on the T-bar panel to open the Window palette.

2. Press ADJ WNDW, above the fourth trackball on the Center panel.

3. Use the fourth trackball to reposition the window.

4. When you’re finished, press ADJ WNDW again to exit adjust window mode.

To alter a window’s Zoom, Aspect, or Rotation:

 > Use the ZOOM, ASPECT, and ROTATE knobs on the T-bar panel.

To alter a window’s softness, do one of the following:

 > For Circular and Linear windows: use the SOFTNESS knob on the T-bar panel.

 > For Polygonal and PowerCurve windows: press the unlabeled soft key at the bottom-right of 
the T-bar panel to toggle between the current knob mappings, and the PAN, TILT, INSIDE 
SOFT and OUTSIDE SOFT knob mappings.

To invert a window:

 > Press the INVERT soft key on the T-bar panel.
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The Tracker palette has two modes, available from the Palette menu. In Window mode, the tracking 
controls let you match the motion of a window to that of a moving feature in the frame. In Stabilizer mode, 
the same underlying technology is used to smooth or stabilize the motion within the entire frame.

Window Tracking

DaVinci Resolve has an incredibly simple, yet powerful, object tracker that allows you to track  
quickly and accurately any Power Window (Circular, Linear, Polygonal, PowerCurve or Gradient) to 
follow any moving feature. This avoids the need to use dynamic keyframes to manually animate a 
window’s position. 

In particular, you can use the tracker to match a window’s position to either foreground or background 
elements that move within the frame.

A Power Window tracking a woman’s face; the motion path resulting from the track is shown as the wiggly white line

Simple Tracking Using the Tracker Menu

The simplest way to track a feature using a Power Window is to use the commands found in the 
Playback menu. These commands include:

 > Track Forward (Command-T): Tracks a window to a feature from the current position of the 
playhead forward, ending at the last frame of a clip.

 > Track Reverse (Option-T): Tracks a window to a feature from the current position of the 
playhead backward, ending at the first frame of a clip.

 > Track Stop (Command-Option-T): Interrupts any track. This is useful for letting you cancel 
a long track that goes wrong (the Stop button of a control surface stops tracking as well).

Most window tracks are easy to accomplish using these three commands.

Window Tracking and Image Stabilization
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To track any Power Window to match a moving feature within the frame:

1. Move the playhead to the frame of the current shot where you want to begin (you don’t have 
to start tracking at the first frame of a shot).

2. Turn on any window, and adjust it to surround the feature you want to track.

 Typically, you’ll have done this anyway, for example, framing someone’s moving face with a 
Circular Window to lighten their highlights.

3. To initiate tracking, do one of the following:

 > Choose Color > Track Forward (press T)

 > Choose Playback >Track Backward (Option-T)

 >On the T-bar panel of the DaVinci control surface, press OBJECT TRACK MODE, and then 
press either the TRACK FWD or TRACK REV soft keys on the Center panel.

Resolve automatically opens the Viewer page, places a series of tracking points within the window 
you’ve created, and performs the track from the current frame; forward to the last frame or backward 
to the first frame.

Resolve analyzes a cloud of tracking points that follow the vectors of every trackable group of 
pixels within the window you’ve created, and the results are fast and accurate. After tracking, the 
window you’ve placed automatically moves, resizes, and rotates to match the motion of the feature 
you’re tracking.

Object tracking in progress. Tracking points are automatically placed over trackable features of the image

Once a clip has tracking data applied to one of its windows, a small tracking icon appears within 
that clip’s icon in the Thumbnail timeline.
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A tracking icon in the top left corner of the Thumbnail timeline shows that clip has been tracked

If the track you’ve performed is unsuitable, you can reposition the window to cover a different area 
of the subject you’re trying to track, and initiate tracking again. New tracking data overwrites any 
previous tracking data applied to that window.

Once you’re satisfied with your track, you can continue to resize, reposition, or reshape the window 
being tracked. Tracking data is separate from the window transform parameters (which can be 
keyframed), so changes you make to a window offset it from the originally tracked path.

Simple Ways of Working With Existing Tracking Data

If there’s a portion of a shot that you haven’t tracked (for example, you started tracking at a later 
frame, or you ended tracking before the end of the shot), then the window you’re tracking remains 
wherever it was at the first or last frame that was tracked. If you want to fill in these gaps, you 
can always move the playhead to the first or last frame that was tracked, and then use the Track 
Backward or Track Forward command to track the rest of the frames in that shot.

Tips For Better Tracking

In situations where a feature changes shape in such a way as to confuse the tracker, you can try 
tracking a smaller part of the feature by using a smaller window. Once you’ve achieved a successful 
track, you can resize the window as necessary, and it will have no effect on the track that’s already 
been made.

Also, if you’re tracking a feature that moves behind something onscreen and disappears for the 
rest of the shot, there’s an easy way to avoid having an awkward window sitting in the middle of 
the scene. You can use dynamic keyframes to animate the Post Mixing Gain slider (in the Key tab of 
the Color page) to fade from the correction’s full strength of 1.0 down to 0, the value at which the 
correction disappears, along with the window itself.

Tracking One Frame at a Time

Holding the Option key down while clicking the track forward or track backward buttons in the 
Tracker palette lets you track a moving feature one frame at a time, making it easier to make 
adjustments to follow a difficult track when you’ve set tracking to Frame mode (by clicking the 
Frame button). 
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In Frame mode, you can move the window you’re tracking to more faithfully conform to troublesome 
motion as you’re moving one frame at a time through the track; manual changes to a window’s 
position will be stored frame-by-frame, rather than used to offset the entire tracked motion path as 
in Clip mode.

Copying and Pasting Tracking From One Window to Another

There will be plenty of times you’ll apply multiple windows to a single moving subject, such as a car, 
when you can use a single motion track for all the windows. Commands in the Option menu let you 
copy and paste track data from one window to another within the same node, saving time when you 
want several windows tracking together as one.

To copy track data from one window to another:

1. Open the Window palette, then select a window that has tracking applied to it (indicated 
by a tracking badge in the corner of the shape icon), and choose Copy Track Data from the 
Option pop-up. 

2. Select another window, and choose Paste Track Data from the Option pop-up.

Once you’ve copied track data from one window, you can paste it to as many other windows as  
you like.

Combining Tracking and Dynamic Keyframes

You can easily combine object tracking and keyframing to animate windows. For example, you’ll 
typically use object tracking to make a window follow the position and orientation of a moving 
feature, but you can add dynamic marks to the window track of the correction in the Color page 
with which to alter its size and shape to better conform to a feature’s changing form.

Controls in the Window Tracker Palette

Occasionally, you’ll run into a shot that doesn’t quite track well enough using the Tracker menu’s 
simple controls. In these cases, the Viewer page provides the complete set of object tracking 
controls that can be used to modify tracking operations in different situations.
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The Tracker palette

The Object Tracking Controls are divided into seven groups.

Tracking Type

The Tracker palette’s Option pop-up menu lets you choose between Window mode (for matching 
a window to the motion of a feature in the frame), and Stabilizer mode (for subduing unwanted 
camera motion, covered later).

Object Tracking

The Object Tracking controls provide the most basic tracking functions, some of which are mirrored 
within the Tracker menu.

Choose which type of transform you want to track before tracking

A series of four checkboxes let you turn on and off which transforms you’d like motion tracking to 
apply automatically to the window. These checkboxes must be selected before you perform a track 
in order to restrict the transforms that are used. 
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 > Pan: Enables tracking of horizontal position.

 > Tilt: Enables tracking of vertical position.

 > Zoom: Enables tracking of size.

 > Rotate: Enables tracking of orientation.

Note: Once tracking or stabilization has been done, disabling these checkboxes does nothing to 
alter the result. To make changes, you need to enable or disable the necessary checkboxes first, 
and then reanalyze the clip.

After you’ve defined the transforms you want to use for the track, the next three buttons let you 
proceed with the analysis of the subject being tracked.

 > Track Reverse button: Initiates tracking from the current frame backward, ending at the first 
frame of the clip.

 > Pause button: Stops tracking (if you’re fast enough to click this button before tracking is 
finished).

 > Track Forward button: Initiates tracking from the current frame forward, ending at the last 
frame of the clip.

Clip/Frame Controls

Two buttons let you set how manual adjustments to the position of tracked windows affect the 
overall track.

Selecting clip or frame to apply adjustments

 > Clip: The default mode, in which changes you make to the position of a window are globally 
applied to the entire track. For example, if you track a feature, and then move the window, 
the window moves along a motion path that’s consistently offset from the original track 
for the duration of the clip. Use this mode if you’re happy with the track, but you want to 
modify the window’s overall shape and position relative to the motion path it’s following.

 > Frame: In this mode, changes you make to the position of a window are only applied to the 
current frame. This mode is required for using the Interpolate commands explained below. 
Key Frame mode is also useful for making corrections to individual frames that were badly 
tracked, or for making manual, frame-by-frame adjustments to window position to cover 
untrackable sections.
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Interactive Mode Controls

The Interactive controls let you make manual changes to the automatically generated tracking point 
cloud that Resolve creates, so you can try different ways of obtaining better tracking results in 
challenging situations.

Interactive mode actions

 > Interactive Mode checkbox: Turns the Interactive tracking mode on and off. When you 
enter Interactive mode, you can manually alter the point cloud that Resolve uses to track 
the feature within the current window. You’ll then make your track while in Interactive mode.

 > Insert: Lets you add tracking points to whatever trackable features exist within a bounding 
box that you’ve drawn in the Viewer. Inserted tracking points are automatically placed 
based on trackable pixels in the image.

 > Set Point: Lets you use the cursor (using the DaVinci Resolve control surface), to manually 
place individual tracking points, one by one, with which to track a feature. If there is no 
trackable pixel group at the coordinates where you placed the cursor, a tracking point will 
be placed at the nearest trackable pixel group.

 > You must place at least two tracking points at different pixel groups to track rotation, and 
at least three to track zoom.

 > Delete: Eliminates all tracking points within a bounding box that you’ve drawn in the Viewer.

For more information, see “Using the Interactive Tracking Controls” later in this section.

Keyframes Interpolation Controls

The controls in the Interpolate section provide ways of dealing with occlusions, or objects that 
temporarily obscure features that you’re tracking. 

Keyframe Interpolation controls
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By marking a hole in the middle of two successfully tracked sections of a clip, you can interpolate a 
motion path to fill the gap so that the vignette moves smoothly from the point where tracking is lost 
to the point where tracking is found again. These features require the tracker to be in Frame mode 
(see the previous section).

 >Mark: Lets you mark the beginning and/or end of sections of track data that you want 
to overwrite with a linear interpolation from the window position at the first frame to the 
window position at the second mark. Once a clip has been marked in the Viewer, you 
can use the Rev, Fwd, or Between buttons to interpolate an animation motion path to fill 
the gap in tracking data. Viewer marks appear as vertical yellow lines in the tracking bar 
underneath the transport controls.

 > Between: After using the Mark button to specify both the beginning and end of a gap in 
tracking data, click Between to interpolate a motion path to fill the gap.

For more information, see “Using the Interpolate Commands” later in this section.

The Tracker Graph

The Tracker Graph provides a visual display of the tracking data that’s being analyzed. Each of the 
transform controls that can be tracked has an individual curve, which lets you evaluate each tracked 
parameter on its own.

Add keyframe and Interpolate between

A vertical slider to the right of the Tracker Graph lets you scale the height of the curve data within 
to make it easier to see it all within the graph. Above the Tracker Graph, a timeline ruler contains a 
playhead that’s locked to the playheads in the Viewer and Keyframe Editor.

You can draw a bounding box in the Tracker Graph with which to select a portion of one or more 
curves to delete sections of low-quality tracking data using the Clear Selected Keyframes command 
found in the Palette Options menu. To eliminate the current bounding box from the Tracker Graph, 
click once anywhere within the graph.
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Additional Commands in the Tracker Palette Options Menu

There are some additional commands located in the Palette Options pop-up menu.

 > Clear Track Data: Lets you delete tracking data for the current clip. When you click Clear 
Track Data, a Clear Tracking window appears with four checkboxes that let you choose for 
which window, within the current clip, to clear tracking data. By default, every checkbox is 
turned on.

 > Clear Selected Keyframes: When you drag a bounding box over parts of one or more 
curves in the Tracker Graph, this command lets you delete that part of the graph. This is 
useful when you want to eliminate sections of low-quality track data. Portions of curves that 
are cleared in this way have linear interpolation automatically applied to them, similar to if 
you used the Keyframes Interpolation controls.

 > Clear All Tracking Points: Clears the tracking points in the Power Window at the frame 
you are on.

 > Show Track: Turn this checkbox on to show the motion path produced by the tracking 
you’ve done.

 > Copy Track Data: Lets you copy track data from the currently selected window. Windows 
can be selected directly in the Viewer while the Tracker palette is open.

 > Paste Track Data: Pastes copied track data to the currently selected window. Windows can 
be selected directly in the Viewer while the Tracker palette is open.

Object Tracking Workflows

The next few examples illustrate how to use the Tracker palette’s controls in practical situations.

Using Interactive Mode to Manually Choose Tracking Features

Interactive Mode lets you manually remove or add tracking points to improve tracking performance 
in situations where the automatic image analysis in Resolve provides unsatisfactory results.

For example, you can delete tracking points within a window that correspond to overlapping features 
you don’t want to track. Suppose a car that you’re tracking drives by a sign that partially obscures 
the car. Without intervention, the PowerCurve that’s isolating the car will deform improperly when 
the car moves along and then away from the sign.

Using Interactive Mode, you can delete the tracking points that will overlap the sign you don’t want 
to track, improving the result.

To eliminate specific, unwanted tracking points from a track:

1. Open the Tracker palette.
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2. Turn on the Interactive Mode checkbox.

Selecting Interactive Mode

3. In the Viewer, drag a box around the tracking points you want to eliminate within the window, 
and click the Delete button. The points within the selection area are deleted.

Dragging a box around tracking points that need to be deleted

4. Click the Delete button. The points within the selection area are deleted.

Deleting tracking points
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Remaining tracking points ready to be used

5. Now, drag a box around the specific area where you’d like to add new tracking points, then 
click the Insert button.

6. When you’re finished tracking, click the Exit Interactive button.

Note: If you delete tracking points and then disable Interactive Mode without performing a new 
track first, Resolve goes back to using automatically placed tracking points.

In another interactive tracking example, you may sometimes run into situations where you want to 
eliminate all automatically placed tracking points altogether, placing your own in specific regions 
of the image.

To eliminate automatic tracking points, adding your own instead:

1. Open the Tracker palette.

2. Turn on the Interactive Mode checkbox.

Selecting Interactive Mode

3. In the Viewer, drag a box around all the tracking points in the window, and click the Delete 
button to eliminate all tracking points from the image.
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Selection box surrounding all tracking points

4. Click the Delete button to eliminate all tracking points from the image. 

Deleting tracking points

5. Drag a box around the specific area where you’d like to add new tracking points. In this case, 
you only want to track the top half of the woman’s face, since the bottom half is cut off by the 
fence posts.

Placing the selection box over the top of the window

6. Now, click the Insert Track Points button. 
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The Insert button of Interactive Mode automatically  

adds tracking points within the current bounding box.

 New tracking points are automatically added to whichever features are appropriate for tracking 
within the box you’ve drawn.

Tracking with the remaining tracking points

 Note: If no appropriate tracking features can be found, no points will be added.

While in Interactive Object Tracking mode you may also choose to add tracking points one by one.

To add a single tracking point:

1. Open the Tracker palette.

2. Turn on the Interactive Mode checkbox.

3. Using the DaVinci control surface, press the CURSOR button above the fourth trackball of the 
Center panel, and move the onscreen cursor to the detail of the image that you want to add a 
tracking point to.

4. Click the Set Point button, within the Interactive Mode controls of the Tracker palette. 

 This adds a tracking point corresponding to the feature of the image that you clicked, and 
you’re ready to start tracking.
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Dealing With Occlusions When Tracking

Sometimes you’ll find that you need to deal with a gap in the useful tracking data. For example, 
objects in the frame that pass in front of the feature you’re trying to track cause gaps in the tracking 
information for a clip.

In situations where a subject being tracked becomes totally occluded by another object in the 
frame, there’s an easy method of interpolating to cover holes in the available tracking data. In the 
following example, the woman walks behind another fence post, this time one that’s taller then she 
is. The window tracking her face will become completely lost at this point, but interpolation will help 
to salvage this shot.

Original clip

To interpolate a motion path using the Keyframes controls:

1. Move the playhead to the first trackable frame of the moving feature you’re correcting, and 
create a Power Window that surrounds it.
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Adding the Power Window

2. Use Track Forward to track the feature as far as you can before it becomes obscured behind 
something else in the frame.

3. When the Power Window stops tracking the feature, stop the track.

The Power Window is obscured by the post

4. Open the Tracker palette.

5. Click the Frame radio button to put the Tracker controls into frame-by-frame adjustment 
mode. This is an important step.
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Selecting frame control

6. Move the playhead to the frame where the feature you’re tracking reappears from behind the 
occlusion, then drag the window so that it again overlaps the feature.

Moving the playhead and position the window

7. Use Track Forward to continue tracking the feature until the end of the clip. Alternately, you 
could have started from the end of the clip and used Track Reverse to track the feature as far 
as possible, if that’s easier.

 Now that you’ve identified the gap in reliable tracking data for this clip, it’s time to set up 
the interpolation. 

Notice the gap in the tracking data where the window was behind the post
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8. Drag a bounding box over the portion of the curves in the Tracker Graph that fall between the 
good tracking data at the beginning and end of the shot.

9. Click the Tracker palette option pop-up menu, and choose Clear Selected Keyframes.

 The portions of curves that you selected are deleted, and have linear interpolation automatically 
applied to them so that there’s no hole in the track data or the motion of the window, which 
now moves smoothly from the last outgoing frame of reliable tracking data to the first incoming 
frame of new reliable tracking data.

Using the Keyframes Interpolation Controls

Another common example of tracking occlusion is when the feature you’re tracking moves off 
screen; examples include a person walking, or a stationary feature that moves when the camera 
pans. While you can track the feature as long as it’s fully within the frame, once it starts to move 
off screen, you may lose your track, and the window will be stuck at an awkward position on screen 
even though the feature it’s supposed to be isolating is gone.
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1. Track the moving object until it goes offscreen. 

The beginning and end frames of a clip with a window tracking the face of an actor moving offscreen

2. Move the playhead to the last reliably tracked frame in the clip, which succeeds in following 
the actor pretty far offscreen, but it doesn’t go all the way off.

The last reliable frame of tracking

3. Click the Mark button. Keyframes appear on each of the curves in the Tracker Graph.
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Adding a tracking keyframe in preparation to interpolate between 

4. Click the Frame radio button to put the Tracker controls into frame-by-frame adjustment 
mode. This is an important step.

Selecting Frame mode

5. Now, move the playhead to the frame where the window should have moved all the way off 
screen, which in this case is the last frame of the clip. Once there, click the Mark button to add 
another set of keyframes.

Adding a tracking keyframe in preparation to interpolate between 

6. Back in the Viewer, drag the window to where it would be if it had followed along with the now 
offscreen actor.

Moving the window offscreen as if it had tracked the actor all the way
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7. With the poorly tracked area of the Tracker Graph isolated with keyframes, click the 
Between button.

Select Interpolate Between

 A motion path is automatically interpolated to smoothly move offscreen, from the last reliable 
frame of track data, to the position you manually set in the last frame of the clip.

Tracks now show data between the keyframes

 As a result, playing through the clip shows that the window now moves smoothly offscreen 
along with the feature you’re tracking.

Manually Repositioning Tracks

Since interpolation generates a smoothly linear motion path, it may not work if you’re tracking an 
irregularly moving feature that becomes obscured. In these cases, you have the option of manually 
tracking a window to fit the likely trajectory of the hidden feature, frame by frame.

To manually reposition or track a window that can’t be interpolated properly:

1. Open the Tracker palette, and click Frame to change the tracking mode.

2. Click the Tracker palette Option pop-up, and choose Show Track to see the motion path in the 
Viewer. This will help you see the adjustments you’re making.

3. Move the playhead to the last frame that was successfully tracked.

4. Move the playhead frame by frame, and adjust the position of the window at each frame to 
move along with the feature that you’re trying to track.
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 Continue adjusting the window frame by frame until you’ve reached the end of the clip, or 
reached the end of the gap in tracking data so that the window is now at the beginning of the 
next successfully tracked section of the clip.

This technique may not be fun, but it’ll get the job done in a pinch. You can also use this technique 
to reposition specific motion path points in the middle of an otherwise successful track to make 
them fit better. 

Tip: You can also turn on the motion path by pressing the SHOW TRACK soft key on the Center 
panel of the DaVinci control surface when you’re in OBJECT TRACK MODE.

Image Stabilization

The Image Stabilization mode of the Tracker palette lets you smooth out or even steady unwanted 
camera motion within a clip. The analysis is performed in such a way as to preserve the motion of 
individual subjects within the frame, as well as the overall direction of desirable camera motion, 
while correcting for unsteadiness.

Image stabilization in DaVinci Resolve consists of three steps. First, you analyze the clip. Second, 
you choose the Stabilization settings you want to use. Third, you click Stabilize to calculate 
the result.

The Stabilizer mode of the Tracker palette

As with Object Tracking, you can choose which aspects of motion to stabilize, but this must be 
done before you do the initial image analysis.
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Analyze Controls

The Analyze controls automatically scan through the entire clip, identifying trackable features that 
can be used to stabilize the shot.

A series of four checkboxes let you turn on and off which axes you’d like to stabilize. These checkboxes 
must be selected before you perform an analysis in order to restrict the data that’s generated.

 > Pan: Enables horizontal stabilization.

 > Tilt: Enables vertical stabilization.

 > Zoom: Enables stabilization of size.

 > Rotate: Enables stabilization of orientation.

Note: Once stabilization has been done, disabling these checkboxes does nothing to alter the 
result. To make changes, you need to enable or disable the necessary checkboxes first, and then 
reanalyze the clip.

The next three buttons let you perform the stabilization analysis.

 > Track Reverse button: Initiates tracking from the current frame backward, ending at the first 
frame of the clip.

 > Pause button: Stops tracking (if you’re fast enough to click this button before tracking 
is finished).

 > Track Forward button: Initiates tracking from the current frame forward, ending at the last 
frame of the clip.

Interactive Mode Controls

The Interactive controls let you make manual changes to the automatically generated tracking point 
cloud that Resolve creates, so you can try different ways of obtaining better stabilization results in 
challenging situations.

 > Interactive Mode checkbox: Turns the Interactive stabilization mode on and off. When 
you enter Interactive mode, you can manually alter the point cloud that Resolve uses to 
stabilize the image. You’ll then make your analysis while in Interactive mode. When you 
exit Interactive mode, your manual changes to the point cloud are eliminated, and Resolve 
again uses automatically placed point clouds to do all stabilization.

 > Insert: Lets you add tracking points to whatever analyzable features exist within a bounding 
box that you’ve drawn in the Viewer. Inserted stabilization points are automatically placed.

 > Set Point: Lets you use the cursor (using the DaVinci Resolve control surface), to manually 
place individual tracking points, one by one, with which to track a feature. If there is no 
trackable pixel group at the coordinates where you placed the cursor, a tracking point will 
be placed at the nearest trackable pixel group. You must place at least two tracking points 
at different pixel groups to track rotation, and at least three to track zoom.
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 >Delete: Eliminates all stabilization points within a bounding box that you’ve drawn in the Viewer.

The procedures for using Interactive Mode for stabilization are the same as for tracking. See the 
“Object Tracking Workflows” section earlier in this chapter.

Stabilization Parameters and Controls

There are four controls in the Stabilization group:

Stabilization selections

 > Strong: Lets you choose how tightly you want to use the stabilization track to eliminate motion 
from a shot. With a value of 100, stabilization is maximized in an effort to “lock” the shot in 
place and eliminate all camera motion. This value is a multiplier. Since some clips might look 
more natural with looser stabilization, choosing a number lower than 100 lets a percentage 
of the original camera motion show through. Zero (0) disables stabilization altogether. 
Additionally, you can invert the stabilization by choosing -100, as described in the section 
on performing a match move below, and you can use a negative value either lower or higher 
than -100 to under or overcompensate when inverting the stabilization, simulating the effects 
of parallax where foreground and background planes move together but at different speeds. 

 > Smooth: Lets you apply mathematical smoothing to the analyzed data used to stabilize 
the clip, and is meant to be used when the Strong parameter is less than 100, allowing 
camera motion in the shot while eliminating unwanted wiggling. Lower values perform less 
smoothing, allowing more of the character of the original camera motion to show through, 
while higher values smooth the shot more aggressively.

 > Zoom: When this checkbox is turned on, the image is resized by a large enough percentage 
to eliminate the blanking (black edges) that is the result of repositioning the image to 
eliminate unwanted camera motion. The higher a value Smooth Frames is set to, the more 
Resolve will need to zoom into an image to eliminate these blanked edges. If you turn 
this off, the image is not zoomed at all, and whatever blanking intrudes into the image is 
output along with the image, on the assumption that you’ll have dedicated compositing 
artists deal with eliminating this blanking by filling in the missing image data in a more 
sophisticated manner. You may also leave this checkbox turned off if you’re planning on 
animating the Input Sizing Zoom parameter to dynamically zoom into and out of a shot 
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being stabilized to eliminate blanking only where it occurs, using only as much zooming as 
is necessary for each region of the shot.

 > Stabilize: After you’ve tracked the clip and adjusted the previous two controls, you need to 
click Stabilize to calculate the resulting effect of the Strong, Smooth, and Zoom controls on 
your clip. Whenever you make changes to the Strong, Smooth, or Zoom parameters, you 
need to click Stabilize to recalculate the resulting effect on your clip.

Using Stabilization

Image stabilization in DaVinci Resolve is easy, but you need to follow a specific series of steps for it 
to be successful.

To stabilize an image:

1. Open the Tracker palette, and choose Stabilizer from the Palette mode pop-up menu.

2. Turn off any of the Analyze checkboxes (Pan, Tilt, Zoom, Rotate) that correspond to transform 
axes you don’t want to smooth.

3. Click the Track Forward button to track the clip forward (or Track Reverse if you’d rather start 
from the end of the clip and work backwards).

Multiple tracking points are automatically placed to analyze the motion of the image for stabilization

 This analyzes the clip, but no stabilization is yet applied.

4. Adjust the Strong parameter to reflect what kind of stabilization you want. If you want to eliminate 
all possible motion from the shot, leave Strong set to 100. If you want to use stabilization to 
smooth out the shot but leave some motion in the frame, reduce the strong parameter to be 
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less than 100 but greater then 0. This parameter is a multiplier, so higher numbers reflect a 
higher percentage of smoothing being applied to the clip’s range of motion, and lower numbers 
reflect a lower percentage of smoothing being applied to the original range of motion. 

5. If you’ve set the Strong parameter to a value less than 100 to calm the motion in the shot, rather than 
lock the shot completely, you can also adjust the Smooth parameter to mathematically smooth 
what motion that remains in the shot. This lets you even out any “wobbling” that you don’t want, 
while retaining the camera motion that you do want. The Strong and Smooth parameters work 
together, so experiment with different values in each parameter to get the result you need.

6. Choose how you want the edges of the stabilized clip to be handled using the Zoom checkbox:

 > If you want Resolve to zoom into the image as much as is necessary to prevent blanking 
(black edges) from intruding into the frame (the result of repositioning the image to steady 
camera motion), then turn on the Viewer Zoom checkbox.

 > If you want to leave the scale of the image alone, allowing blanking (black edges) to intrude 
into the frame so that you either (a) have an effects artist deal with filling in these holes 
later, or (b) manually animate the Input Sizing Zoom parameter to eliminate blanking in a 
dynamic way, then turn off the Viewer Zoom checkbox.

7. With all of these controls adjusted, click Stabilize. The clip is immediately transformed to apply 
the amount of stabilization you selected via the Smooth Frames slider.

8. Play the clip and examine the stabilization effect. If you need to make any changes, choose 
new Strong and Smooth Frames values, then click Stabilize.

 Any time you change any of the Stabilization parameters, you need to click Stabilize to 
recalculate the resulting transform to your clip.

Using Stabilization to Create a Match Move

In some circumstances, such as when you’re using the HSL Qualifier to create transparency for 
a composite (using the Alpha Output described later in this chapter), you may find you need to 
apply the motion from a foreground clip to the background clip so that the two clips appear to be 
moving as one. This is referred to as doing a “match move,” and is a necessary step when creating a 
composite for purposes of doing a sky replacement, for example. This can be done in a simple way 
using the Stabilizer mode of the Tracker palette.

To match the motion of a background clip to a foreground clip:

1. First, edit a foreground clip onto track V2, and a background clip onto track V1, and follow the 
instructions in the section titled “Using a Qualifier Key to Create Transparency” later in this 
chapter to create a region of transparency in the foreground clip that lets the background 
show through.
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Creating transparency to replace the sky in a superimposed clip with a sky image edited into a lower video track

 In this example, the sky is being keyed so that it can be replaced with a more attractive 
photo of a sky.

Before (top) and after setting up a sky replacement by connecting an HSL qualifier of the blue in the sky  

to the Alpha Output to create transparency
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 If you’re planning on match moving a still image, you must first turn the still image clip into a 
compound clip in the Edit page, otherwise this match moving procedure won’t work. If you’re 
match moving a movie clip, this isn’t necessary. Also, depending on the range of motion you’re 
going to be matching, you’ll probably need to use a background image that’s somewhat larger 
than the region you’re keying, to make sure you have full coverage as the layer moves to match 
the foreground motion. If necessary, you can zoom into the image using the Zoom parameter 
in the Transform section of the Edit page Inspector.

2. In this example, the foreground clip happens to have a camera pan, which gives the composite 
away as the sky doesn’t move along with it. To move the compound clip of the sky image to 
match this pan, open the Tracker pallet.

3. Choose its Stabilizer mode, and then click the Analyze Forward button to analyze the motion of 
the entire clip. Then, click the Tracker palette’s Option menu, and choose Copy Track Data.

4. Select the clip that you want to match (in this case the sky image compound clip), then open 
the Tracker Palette’s Option menu and choose Paste Track Data.

5. Now, for this to work correctly, you need to set the Strong parameter to –100, and click the 
Stabilize button. Setting a negative value inverts the tracking data you copied in step 3, which 
enables it to become a match move. If you’re feeling extra tricky, you can set the Strong 
parameter to a little less then –100, say –94, which introduces a disparity of foreground and 
background motion that simulates parallax..

Inverting the Strong parameter with a negative number to create matched motion

 At this point, playing through the clip should result in a nicely matched correspondence 
between the movement of the foreground and background layers.
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The background sky layer after it’s been matched to the motion of the foreground layer, the sky now  

follows along with the motion of the camera in the superimposed clip

Tracking and Stabilizing with the DaVinci Control Surface

All of the tracking commands are available via the DaVinci Resolve control surface.

To open and close tracking controls:

 > Press OBJECT TRACK MODE at the top of the T-bar panel.

All of the tracking controls appear on the soft keys of the Center and T-bar panels.

To do simple tracking:

 > Use the TRACK FWD, TRACK REV, and STOP TRACK soft buttons on the left side of the 
Center panel.

 > Press SHOW TRACK if you want to see the resulting motion path.
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To turn tracking on and off for Pan, Tilt, Zoom, and Rotate:

1. Press the P/T/Z/R ENABLE soft key.

 The middle four soft keys of the Center panel change to display PAN ON/OFF, TILT ON/OFF, 
ZOOM ON/OFF, and ROTATE ON/OFF.

2. Use these buttons to toggle any of these checkboxes on or off, then press BACK to go back to 
the other tracking controls.

To interpolate between two separately tracked ranges of frames:

1. Use the transport controls to move the playhead to the first frame you want to place a mark, 
and press MARK.

 A Viewer Mark appears on the tracking bar, identifying either the beginning or the end of the 
gap in that clip’s motion tracking data.

2. If necessary, use the transport controls to move the playhead to the second frame where you 
want to place a mark, and press MARK.

 A second Viewer Mark appears in the tracking bar, identifying both the beginning and end of 
the gap in that clip’s motion tracking data.

3. To perform the interpolation, do one of the following:

 > If you marked both the first and last tracked frames that surround a gap in tracking data, 
press the INTRPLT BETWEEN soft key.

 > If you marked the last tracked frame in the first half of the clip, then use the transport 
controls to move the playhead to the first tracked frame of the second half of the clip and 
press the INTRPLT REV soft key.

 > If you marked the first tracked frame in the second half of the clip, then use the transport 
controls to move the playhead to the last tracked frame of the first half of the clip and press 
the INTRPLT FWD soft key.

To move the playhead to different “cue” frames:

 > Press the CUE START, CUE LOWER, CUE UPPER, or CUE END soft keys on the T-bar panel.

To use Interactive mode:

1. Press the INTERACTIVE soft key at the left of the center panel.

 Additional button controls appear on the soft keys of the Transport panel, including INSERT 
(POINTS), DELETE (POINTS), CLEAR (POINTS), and SET POINT.
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2. Do one of the following:

 > To eliminate all tracking points, press the CLEAR soft key.

 > To add a single tracking point, press CURSOR (above the fourth trackball), use the fourth 
trackball to position the on-screen cursor over the feature you’d like to add a tracking point 
to, and then press the SET POINT soft key.

 > To eliminate a range of tracking points in order to prevent the tracking of an undesirable 
feature, use the mouse to draw a bounding box around the tracking points you want to 
remove, and press the DELETE soft key.

 > To add a range of tracking points to a specific feature, use the mouse to draw a bounding 
box around the feature you want to track, and press the INSERT soft key.

3. Use the TRACK FWD, TRACK REV, and STOP TRACK soft buttons on the left side of the 
Center panel to perform the necessary tracking.

4. Press the INTERACTIVE soft key again to leave Interactive mode.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

649

ADVANCED COLOR FEATURES12

This section covers effects that aren’t, in and of themselves, considered color corrections. However, 
they allow you to make stylistic and corrective alterations to the image that other applications 
typically apply with “filter” operations.

Blur Palette Effects

The Blur palette has three different modes of operation—blur, sharpen, and mist. While the 
functionality of the blur and sharpen modes somewhat overlap, each mode provides dedicated 
controls that the other ones lack.

As with virtually everything else in the Color page, the operations performed in the Blur palette 
can be limited as a secondary operation using HSL Qualifiers, Windows, or Imported mattes, which 
makes it easy to apply these effects to specific portions of the image.

Many of the controls in the Blur palette consist of three ganged sliders, one for red, one for green, 
and one for blue. 

By default, these ganged sliders move together as one, resulting in each color channel of the image 
being equally affected. A small orange button to the left of each control’s name lets you ungang 
these sliders, in order to apply degrees of adjustment to individual color channels.

Blur

The default mode, Blur lets you apply an exceptionally high-quality Gaussian blur, or another equally 
high-quality sharpening operation to your image. This mode of operation has the simplest controls.

Two sets of linked parameters let you adjust the extent and directionality of blur or sharpening. 
Which is applied depends on the direction in which you adjust the Radius control.

Blur Radius controls are ganged by default, but can be unganged

Blur Effects
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 > Radius: This is the primary control for adding blur or sharpening. The default value of 0.50 
results in no effect being applied to the image. Raising the radius slider increases blur, to 
an incredibly soft maximum value of 6.00. Lowering the radius increases sharpness, with a 
minimum value of 0.00 providing maximum sharpness.

Tip: If you raise the Radius slider all the way to 1.00 and the image isn’t blurred enough, add 
another node and use it to add another blur operation.

 > H/V Ratio: Lets you add directionality to the current operation. At the default value of 0.50, 
the image is affected in both the horizontal and vertical directions equally. Raising H/V 
Ratio makes the effect increasingly directional along the horizontal axis, while lowering 
makes the effect increasingly directional along the vertical axis.

To adjust the Blur controls using the DaVinci control surface:

1. Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Trackball’s 
main page.

2. Use the BLUR AMOUNT and H/V RATIO knobs to add either blur or sharpening.

3. When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.

Sharpening

While the Blur controls also let you apply sharpening simply by lowering rather then raising the 
Radius sliders, the actual Sharpen mode provides additional controls specifically for tailoring 
sharpening operations.

Sharpening with Coring Softness and Level
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 > Radius: This is the primary control for adding blur or sharpening. The default value of 0.50 
results in no effect being applied to the image. Raising the radius slider increases blur, to a 
maximum value of 1.00. Lowering the radius increases sharpness, with a minimum value of 
0.00 providing maximum sharpness.

 > H/V Ratio: Lets you add directionality to the current operation. At the default value of 0.50, 
the image is affected in both the horizontal and vertical directions equally. Raising H/V 
Ratio makes the effect increasingly directional along the horizontal axis, while lowering 
makes the effect increasingly directional along the vertical axis.

 > Scaling: Multiplies the amount of scaling being applied by the Radius control for  
sharpening operations. The scaling parameter has no effect if Radius is set to 0.50 or  
above for blur effects.

The Coring Softness and Level parameters work together to allow you to be selective about which 
parts of the image you’re sharpening, without the need to build a secondary operation.

 > Coring Softness: Lets you limit how much of the image is being sharpened, based on the 
threshold of image detail defined by the Level parameter. With Level at 0, Coring Softness 
adjusts the blend between sharpening of the most detailed areas of the image (such as 
the eyes, lips, and dimples of a face), and low detail areas of the image that are not being 
sharpened at all (such as the cheeks, forehead, and chin).

 > Level: Sets the threshold at which image detail is omitted from a sharpening operation 
when Coring Softness is raised. The default setting of 0 sets the threshold low enough 
to omit all but the most highly detailed edges of an image. Raising Level gradually omits 
areas of reduced complexity, which results in more of the image being included in a 
sharpening operation.

To adjust the Sharpening controls using the DaVinci control surface:

1. Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Center panel’s 
main page.

2. On the Center panel, press the IMAGE MODE soft key repeatedly to cycle to the RESOLVE 
IMAGE SHARPENING controls.

3. Use the SHARP AMOUNT, SCALING, LEVELS, and SOFTNESS knobs to create the desired 
sharpening effect.

4. When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.
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Mist

The Mist mode lets you combine blur and sharpen operations in such a way as to create effects 
similar to those achieved via “Vaseline on the lens” or Pro-Mist optical filters.

Mist including Mist Mix control

Unlike the Blur or Sharpen modes, where the Radius sliders provide immediate access to the 
desired effect, the Mist mode requires you to lower the Radius and Mix sliders together to get a 
desirable result. By varying the amounts of Radius and Mix, you can create many variations on the 
mist effect.

 > Radius: When creating a Mist effect, you first need to lower Radius to sharpen the image. 
This operations then combines with a lowering of the Mix parameter to provide the 
combination of detail and blurring that results in a mist effect.

 > H/V Ratio: Lets you add directionality to the current operation. At the default value of 0.50, 
the image is affected in both the horizontal and vertical directions equally. Raising H/V 
Ratio makes the effect increasingly directional along the horizontal axis, while lowering 
makes the effect increasingly directional along the vertical axis.

 > Scaling: Multiplies the amount of scaling being applied by the Radius control, and lets you 
intensify a mist effect beyond the Radius slider’s ordinary range. The scaling parameter has 
no effect if Radius is set to 0.50 or above for blur effects.

 >Mix: After you sharpen the image using the Radius slider, decreasing the Mix parameter 
adds a superimposed blur that mixes with the high-detail areas of the picture to create the 
mist effect.
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To adjust the Mist controls using the DaVinci control surface:

1. Press the VECTORS button on the T-bar panel, or the VECTORS soft key on the Center panel’s 
main page.

2. On the Center panel, press the IMAGE MODE soft key repeatedly to cycle to the RESOLVE 
MIST EFFECT controls.

3. Use the RADIUS, H/V RATIO, SCALING, and MIX knobs to create the desired mist effect.

4. When you’re finished, press the PRIMARIES soft key to return to the Center panel’s main page.
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DaVinci Resolve has a powerful tool set for making geometric transforms, using advanced 
algorithms for optical-quality sizing operations. This section covers the nuts and bolts of resolution 
independence in DaVinci Resolve, and how to use the Sizing palette.

Resolution Independence in DaVinci Resolve

DaVinci Resolve is a resolution-independent application. This means that, whatever the resolution 
of your source media, it can be output at whatever other resolution you like. This also means that 
you can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same timeline, and 
scaling each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, 
and then output at another resolution. This also makes it easy to output multiple versions of a 
program at different resolutions, for example, outputting both HD and SD sized versions of the 
same program.

Finally, the controls found in the Sizing palette let you transform clips individually, either to push 
into a clip for creative intent, or to pan and scan media of one format to fit better into a different 
output format.

Using High Resolution Media in Lower Resolution Projects

Every set of transform and sizing parameters and settings that resize clips is combined intelligently, 
so that the highest resolution media is always used as the source for any transform. For example, 
if you’re using 4K media within a 1920x1080 project, and you need to enlarge a clip using the Input 
Sizing palette’s Zoom parameter, the image is scaled relative to the native 4K resolution of the 
source, and the result is fit into the current timeline resolution. This automatically guarantees the 
highest quality for any image transform you make.

Timeline Resolution

This is one of the most fundamental settings in your project, defining its frame size. You can choose 
a predefined resolution from the “Set timeline resolution to” pop-up menu, or you can type a 
custom resolution into the X and Y fields below.

Media used in a project does not have to match the timeline resolution, in fact it’s common to 
mix resolutions within the same timeline. Clips that don’t match the current resolution will be 
automatically resized according to the currently selected Image Scaling setting (described below).

As mentioned earlier, you can change the timeline resolution at any time. When you do so, all Power 
Windows, Sizing palette adjustments, tracking, keyframing, and other geometric operations are 
automatically and accurately scaled to fit the new resolution.

2D Transforms
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Pixel Aspect Ratio (PAR)

The Timeline Format settings, found in the Master Project Settings, let you specify a Pixel Aspect 
Ratio in addition to the frame size. Defaulting to Square Pixel, which is appropriate for high definition 
projects, there are also options for 16:9 anamorphic, 4:3 standard definition, or Cinemascope. Which 
options are available depends on what timeline resolution you’ve selected.

In addition, each clip has individually adjustable PAR settings, for situations where you’re mixing 
multiple types of media within a single project. For example, if you’re mixing SD clips with non-
square pixels and HD clips with square pixels, you can sort out all of the SD clips in the Media 
Pool and assign them the appropriate NTSC or PAL non-square pixel ratio PAR setting. For more 
information, see Chapter 3, “Working in the Media Page.”

Image Scaling

If a clip’s native resolution doesn’t match the Timeline Resolution, then the currently selected Input 
Scaling Preset dictates how the mismatched clip will be handled. The default setting is “Scale 
entire image to fit,” which shrinks or enlarges the image to fit, in the best way possible, the current 
dimensions of the frame, adding letterboxing or pillarboxing as necessary.

The Image Scaling parameters are found in the Project Settings window, and there are two sets of 
parameters that let you set the quality and method used for these automatic transforms.

Image Scaling filters let you choose the mathematical method used to resize clips:

 > Uses sharper filter: Usually provides the best quality in projects, using the optical quality 
processing unique to DaVinci Resolve.

 > Uses smoother filter: May provide a more pleasing result for projects using clips that must 
be scaled down to standard definition, as this filter exhibits fewer sharp edges at SD 
resolutions.

 > Uses bilinear filter: A lower quality setting that is less processor intensive. Useful for 
previewing your work on a low-performance computer before rendering, when you can 
switch to one of the higher quality options.

 > Input scaling preset: Checking this box lets you choose an Input Sizing preset to apply to 
the project.

 >Output scaling preset: Checking this box lets you choose an Output Sizing preset to apply 
to the project.
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Input Image Scaling options let you choose how clips that don’t match the current project resolution 
are handled. The illustrated examples below show an SD clip being fit into an HD project using each 
of the different options.

 > Center crop with no resizing: Clips of differing resolution are not scaled at all. Clips that are 
smaller than the current frame size are surrounded by blanking, and clips that are larger 
than the current frame size are cropped.

 > Scale full frame with crop: Clips of differing resolution are scaled so that the clip fills the 
frame with no blanking. Excess pixels are cropped.

 > Scale entire image to fit: The default setting. Clips of differing resolution are scaled so 
that each clip fills the frame without cropping. The dimension that falls short has blanking 
inserted (letterboxing or pillarboxing). 
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 > Stretch frame to all corners: Useful for projects using anamorphic media. Clips of differing 
resolutions are squished or stretched to match the frame size in all dimensions. This way, 
anamorphic media can be stretched to match full raster, or full raster media can be squished 
to fit into an anamorphic frame. An added benefit of this setting is that it makes it easy to 
mix anamorphic and non-anamorphic clips in the same project.

Output Image Scaling

Another group of settings found in the Image Scaling panel of the Project Settings lets you 
optionally choose a different resolution to be output via your video output interface, for monitoring, 
outputting to tape, or rendering. If you set the resolution in the Render Settings list of the Deliver 
page to something other than the Timeline Resolution, these settings are used to make the change. 
This can be used in situations where you’re working on a high resolution 4K project, but you want to 
monitor using an HD display, and output HD resolution media for approval.

 > Lock to timeline format: Turned on by default, so that these settings mirror the Image 
Scaling and Input Image Scaling settings described above. Turning this checkbox off lets 
you choose different settings for monitoring, outputting to tape, or rendering, using the 
other settings in this group.
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 > Set output resolution to: Lets you choose an alternate resolution.

 > For “X x Y” processing: Lets you specify a different custom alternate resolution.

 > Pixel aspect ratio is: Lets you specify an alternate pixel aspect ratio to match the alternate 
timeline format.

 >Mismatched resolution files: Lets you choose an alternate way of handling mismatched 
resolution files given the alternate resolution you’ve chosen. These options work identically 
to those of the “Input Image Scaling” group.

Edit Page Transform Parameters and Imported Sizing Information

A set of Transform parameters corresponding to each clip in the Timeline is available from the 
Inspector. These parameters operate independently of the Sizing controls found in the Color page, 
and exist primarily to store incoming transform data from imported AAF and XML projects coming 
from other applications.

The transform parameters in the Inspector of the Edit page

If, when importing an AAF or XML project file, you turned on the “Use sizing information” checkbox, 
then every clip that had position, scale, rotation, or crop settings applied in the originating NLE will 
have those adjustments applied to these transform parameters.

The transformation applied by these parameters is combined with whatever Input and Output 
Sizing adjustments are being made to output the final geometric result.

Edit, Input, Output, and Node Sizing on the Color Page

The Sizing palette on the Color page has another dedicated set of keyframable transform 
parameters that work with the DaVinci Control Surface to let the colorist apply pan and scan 
adjustments while working through a project. These parameters work independently of the Edit 
page Transform parameters, allowing you to keep imported transform settings separate from other 
transform settings that you apply. However, for convenience the Edit sizing controls are available in 
the Color page as well.
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Format Resolution on the Delivery Page

By default, the Format Resolution setting in the Render Settings of the Deliver page matches the 
Timeline Resolution when “Match timeline settings” is enabled in the Output Scaling Preset in 
Project Settings.

Choosing a new resolution from the “Set Resolution to” pop-up menu lets you override the current 
Format Resolution setting before rendering. Using this control, you can queue up multiple jobs, 
each set to a different resolution, to output multiple formats during a single render session. For more 
information on rendering and setting up jobs for the Render Queue, see Chapter 10, “Deliver.”

The Four Color Page Sizing Modes

The Sizing Palette on the Color page can be put into three modes: Input Sizing, Output Sizing, and 
Node sizing. 

 >  Edit Sizing: These controls mirror those found in the Inspector of the Edit page.

 > Input Sizing: These controls let you make sizing adjustments to individual clips that affect 
their overall geometry (pan, tilt, zoom, and rotation). These controls are useful for doing clip 
by clip pan and scan adjustments.

 >Output Sizing: These controls are nearly identical, except that they affect every clip in the 
entire timeline, all at once. Output sizing is useful for making a formatting adjustment to an 
entire timeline, such as changing an HD timeline to an SD timeline with simple adjustments 
to crop and pan the resulting framing.

 >Node Sizing: Lets you add targeted sizing adjustments at any point within the node tree. 
Like Input Sizing, Node Sizing is specific to a particular clip. Unlike Input Sizing, Node Sizing 
is affected by operations that split color channels (such as the splitter/combiner nodes) 
and limit the image (such as qualifiers and windows). You can also add as many node sizing 
adjustments to a clip’s grade as you need.

Sizing Order of Processing on the Color Page

Input Sizing adjustments are applied before all image processing that takes place in the node 
graph, including Node Sizing, while Output Sizing adjustments are applied after image processing 
in the node graph.

Using Node Sizing

Using Node Sizing, you can apply individual sizing adjustments on a per-node basis. All Node Sizing 
adjustments within a grade are cumulative, and any keyframing done to Node Sizing parameters is 
stored in that node’s Node Format keyframe track in the Keyframe Editor. Two good examples of 
Node Sizing include realigning color channels individually in conjunction with the Splitter/Combiner 
nodes, or duplicating windowed regions of an image by moving them around the frame.
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Example 1: Using node sizing on individual color channels:

1. Choose Nodes > Add Splitter/Combiner Node to add this node structure to the current grade.

2. Select one of the three Corrector nodes connected between the Splitter and Combiner nodes 
that corresponds to the color channel you want to transform.

Adding the Splitter/Combiner nodes to use Node Sizing on individual color channels 

3. Open the Sizing palette, choose Node Sizing from the mode pop-up, and use the Sizing 
parameters to transform that channel as necessary. For example, if you have an old video clip 
with misaligned color components, you could pan a misaligned channel to the left or right to 
try and improve its alignment.

       

Before and after panning the green channel

Example 2: Using Node Sizing to duplicate a windowed area of an image to cover a blemish:

1. Create a new node.

2. Open the Window palette, create a Circular window, and then shrink and reposition it to 
surround a feature you want to remove.

3. Open the Tracking palette, and track the window to follow the feature to be removed.
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4. After the track is complete, now move the window to an adjacent area of clean detail that’s 
right next to the feature you want to remove. This is the area of the image you’re going to 
duplicate and cover the unwanted feature with.

5. Now, open the Sizing palette, choose Node Sizing from the mode pop-up, and use the Sizing 
parameters to move a duplicate of the windowed area to cover up the unwanted feature.

       

Before/After using Node Sizing to clone an area of the image to cover up the actor with a plant to create a clean background

When you’re done, playing through the clip should show that the duplicated area of the image is 
still tracking the feature you want to remove.

Sizing Controls

Input, Node, and Output Sizing share many of the same controls. When the Sizing palette is set to 
Input Sizing mode, the controls transform each clip individually. If you’re simply pushing in on one 
or two clips, or making individual pan & scan adjustments to account for a change in format, these 
are the controls you want to use.

The Sizing palette



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

662

ADVANCED COLOR FEATURES12

 > Pan: Moves the clip along the horizontal, X axis. Positive values move the clip right, negative 
values move the clip left.

 > Tilt: Moves the clip along the vertical, Y axis. Positive values move the clip up, negative 
values move the clip down.

 > Zoom: Positive values enlarge the clip, negative values shrink the clip.

 > Rotate: Positive values rotate the clip clockwise. Negative values rotate the clip 
counter-clockwise.

 >Width: Positive values stretch the image wider, negative values squish the image narrower.

 > Height: Positive values stretch the image taller, negative values squish the image shorter.

 > Key Lock: (Node Sizing only) Lets you choose how regions of the image that are isolated by 
one or more windows will be transformed. There are two options:

 >Off: While off, the transform controls will move the windowed region to another area 
of the frame, effectively duplicating the windowed area.

 >On: While on, the transform controls will move other areas of the frame into the 
windowed regions, effectively covering up the windowed area with another portion 
of the picture.

 > Flip Image: Two buttons let you flip the image in different dimensions.

 > Flip Horizontal control: Reverses the image along the X axis, left to right.

 > Flip Vertical control: Reverses the clip along the Y axis, turning it upside down.

Sizing OSC

An onscreen control currently mirrors the sizing parameters, showing you a preview of the 
transformed image, shown by an orange outline, relative to the size of the frame, shown in gray. 
Zoom and reset controls make it easier to see the full display.

Blanking Controls

Output Sizing mode also has a set of Blanking controls that you can use to add custom blanking 
to a clip or project. For example, you can use these controls to add nonstandard letterboxing or 
pillarboxing to an image. Along with all other Output Sizing adjustments, blanking is added last in the 
image processing pipeline, so it’s not affected by any of the color or contrast adjustments you make.

 > Left: Adjusts the left pillarbox.

 > Right: Adjusts the right pillarbox.

 > Top: Adjusts the top letterbox.

 > Bottom: Adjusts the bottom letterbox.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

663

ADVANCED COLOR FEATURES12

Blanking presets are also available by choosing from the Color > Output Blanking submenu. 
Choosing one of these options automatically sets the Blanking parameters of the Sizing palette’s 
Output Sizing mode. The following presets are available: 

 > 1.33: SD or 4:3

 > 1.66: European theatrical

 > 1.77: HD or 16:9

 > 1.85: Theatrical flat aspect ratio

 > 2.35: Original anamorphic (scope) theatrical wide-screen

 > 2.39: Current 35mm anamorphic (scope) theatrical wide-screen

 > 2.40: Current 35mm anamorphic (scope) theatrical wide-screen (rounded up for Blu-Ray)

Anti-aliasing at the edges of blanking is handled by a setting in the Image Scaling panel of the 
Project Settings. For more information, see Chapter 2.

Resetting the Sizing Palette

You can reset every control within the Sizing palette at any time by choosing Reset from the Palette 
Options pop-up menu, or by clicking the reset button in the upper left-hand corner of the palette.

Input and Output Sizing Presets

If there are Input or Output Sizing settings that you find yourself using repeatedly, you can save 
them as presets for easy recall. For example, if there’s a group of input settings that you use to 
resize a clip of a particular format to match the current project, you can save it as a preset that you 
can use whenever. 

 > Preset pop-up menu: Provides access to all the currently saved presets in the 
current  database.

 > Delete preset: To delete a preset, select it from the pop-up menu, click the trash can 
button, then click OK.

 > Add preset: To add a preset, make whatever settings adjustments you need, then click the 
plus button. When the Format Preset dialog appears, enter a name, check that the settings 
are correct, then click Save.

 > Change preset: To change a preset, load the preset you want to change, make whatever 
changes you need, then click the check button.

The Input and Output Sizing modes save different presets. Each of these sets of presets is available 
from the “Override input scaling” and “Override output scaling” pop-up menus in the Image 
Scaling panel of the Project Settings.
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Sizing Controls With the DaVinci Control Surface

There are two sets of DaVinci control surface mappings for the sizing controls. The most obvious 
controls can be seen permanently mapped to the knobs and soft keys of the Transport panel. This 
makes these controls easy to access for projects where you’re panning & scanning nearly every shot 
of a film-scanned program. 

To adjust PTZR settings:

1. Press the OUTPUT or INPUT soft key to switch between Output Sizing and Input Sizing modes. 

2. Use the PAN, TILT, ZOOM, and ROTATE knobs of the Transport panel, and the H FLIP and V 
FLIP soft keys.

To adjust Input and Output Blanking:

1. Press the INPUT BLANKING or OUTPUT BLANKING soft key on the Transport panel.

2. Use the knobs labeled LEFT, RIGHT, TOP, and BOTTOM to make a blanking adjustment. 

3. Press SIZING when you’re finished.

Another set of DaVinci control surface mappings appears when you press the SIZING button of 
the T-bar panel. In this case, the Center panel knobs and soft keys update to a page showing 
the following:

 > Ref Wipe Sizing Adjustments: These controls, on the middle screen of the Center panel, 
let you reposition a still from the Gallery that’s being displayed in a split screen. This can 
make it easier to compare features that would otherwise be obscured by the still’s position 
on screen.

 > Input Sizing Adjustments: The Input Sizing controls are displayed on the right screen of the 
Center panel. These are similar to the mappings on the Transport panel, but the Center 
panel’s second row of knobs also exposes PITCH, YAW, H SIZE, and V SIZE controls, and 
there’s an additional MODIFY PAR button that lets you change the pixel aspect ratio 
of a clip.

 >Output Sizing Adjustments: If you press OUTPUT soft key on the Center panel, the knobs 
and soft keys change to show the Output Sizing controls. Press BLANKING to expose all 
the preset aspect ratios on the Transport panel, along with the USER which allows you to 
expose user definable presets.

To save and recall user definable blanking aspect ratios:

1. Press SIZING on the T-bar panel.

2. Press the OUTPUT soft key on the Center panel.
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3. Press the OUTPUT BLANKING soft key on the Transport panel, and then enter the blanking 
aspect ratio as a number (e.g., 2.4) using the number pad on the Transport panel to set your 
customized blanking.

4. Press the BLANKING soft key on the Center panel.

5. To apply the new ratio, press the BLANKING soft key on the Center panel, then press USER on 
the Transport panel, and press one of the USER 1-5 soft keys.

Tip: With the Input Sizing Adjustments controls exposed on the Center panel, you can set the 
Transport panel to display the Output Sizing controls, for simultaneous presentation of every sizing 
control that’s available.
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Stereo 3D Palette

This palette contains all the controls necessary for working on stereoscopic (colloquially known as 
3D) projects. It provides controls for choosing which eye to grade, adjusting convergence, swapping 
and copying grades and media between matching left- and right-eye clips in paired timelines, auto-
processing the color and geometry of left- and right-eye clips to match, stereo monitoring setup, 
and controls for floating windows.

Stereoscopic 3D palette

Your project must contain stereo 3D clips in order to open this palette. For more information on 
setting up a stereo 3D project, see the “Stereoscopic Workflows” section of Chapter 9, “Preparing 
and Conforming Projects.”

Stereo Eye Selection

Most colorists work by grading one eye first (typically the left), and rippling their grades to the 
other eye, making separate adjustments to each eye’s clips when necessary to match undesirable 
variation between cameras.

The first three buttons in the Stereo 3D palette let you choose which eye to grade while you’re 
working, as well as whether or not to ripple each clip’s grade to the matching opposite-eye clip. 
Whenever you switch eyes, the 3D badge above each clip’s thumbnail changes color (blue for right, 
red for left) and the thumbnails themselves update to show that eye’s media.

The Left eye is master and ganged with the right
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 > Left button: Displays the left-eye image and grade.

 > Ripple Link button: When enabled (orange), all changes you make to the grade of the 
currently selected eye are automatically copied to the correspondingly opposite eye. 
When disabled (gray), grades made to the currently selected eye are made independently.

 > Right button: Displays the right-eye image and grade.

Tip: You can also choose which eye you’re viewing and grading by right-clicking a clip’s thumbnail 
and choosing Stereo > Switch Eye or by choosing View > Switch Eye To > Left Eye or Right Eye.

Using Ripple Link When Grading Stereo 3D Clips

You would turn Ripple Link off to suspend rippling when you want to make an individual adjustment 
to the grade of one eye to obtain a better match between the two. When you’re finished matching 
the two clips, you can turn it back on to resume automatic grade rippling. 

Stereo 3D grade rippling is always relative, so differences between the grades that are applied to 
the left- and right-eye clips are preserved. In fact, when you add or remove nodes to or from one 
eye, the same nodes are automatically added to or removed from the corresponding clip it’s paired 
with, regardless of whether or not Ripple Linked is enabled.

Important: Regardless of whether or not Ripple Link is enabled, local versions created for one stereo 
3D-identified clip are automatically available to the paired timeline.

Stereo 3D Geometry Controls

The next group of parameters lets you adjust the geometry of stereo 3D clips. The Pan, Tilt, and 
Zoom controls are provided as a convenience, and simply mirror the same parameters found in the 
Transform palette’s Input mode. Convergence, Pitch, and Yaw are the three parameters that are 
unique to the Stereo 3D palette.

Stereoscopic 3D Geometry controls

 > Convergence: Adjusts the disparity between the left and right eyes, to define the point of 
convergence (POC), or the region within the image where the left- and right-eye features 
are in perfect alignment. If necessary, Convergence can be animated using the Stereo 
Format parameter group in the Sizing track of the Keyframe Editor.
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Features that overlap perfectly in both right- and left-eye clips are at zero parallax, putting 
that feature’s depth at the screen plane. Matching features that are divergent in the left- 
and right-eye clips have increasingly positive parallax, and appear to be farther away from 
the audience. Matching features that are divergent and reversed in the left- and right-eye 
clips have increasingly negative parallax, and appear to be closer to the audience than the 
screen plane.

 > Linked Zoom button: When enabled (orange), both the left- and right-eye clips are 
automatically zoomed whenever Convergence is adjusted so that both eyes always fill the 
screen. When disabled (gray), changes to Convergence will cause the opposing left and 
right edges of each eye’s clip to have blanking intrude. 

 > Pitch: Pivots the image around the horizontal center plane of the frame.

 > Yaw: Pivots the image around the vertical center plane of the frame.

Sizing Repositioning in Stereo 3D

Generally, you’ll want to reposition stereo 3D clips with Ripple Link turned on, but you may 
occasionally find yourself needing to make a manual adjustment to one eye in particular with Ripple 
Link disabled. As with color adjustments, Sizing adjustments made with Ripple Link disabled are 
only applied to the clip in the current timeline. When Ripple Link is turned on, all Sizing adjustments 
are automatically copied to the correspondingly numbered shot of the other stereo 3D timeline.

Warning: It is not advisable to use the Rotate parameter when transforming stereo 3D clips. 
Geometrically, rotation tilts a stereo pair of clips inappropriately, and ruins the “side-by-side” 
convergence that’s necessary to create the stereoscopic illusion.

Protecting Stereo Adjustments When Copying Grades

Each version of a grade has independent stereo adjustments stored along with the Sizing settings. 
To prevent accidental overwrite of convergence and alignment data when copying grades from 
one clip to another, you can right-click within the Gallery and choose one of the following options 
to turn them on:

 > Copy Grade: Preserve Convergence

 > Copy Grade: Preserve Floating Windows

 > Copy Grade: Preserve Auto Align

When enabled, these options lets you overwrite a clip’s grade without overwriting specific Stereo 
3D parameters.

Tip: Stereo 3D and Sizing settings are processed before node-based corrections in the Resolve 
image processing pipeline.
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Swap and Copy Controls
Another set of controls lets you swap and copy grades, and swap clips, in situations where you need 
to reverse what’s applied to a pair of left- and right-eye clips.

Swap and Copy grades between eyes

 > Swap Grade: Exchanges the grades that are applied to the left- and right-eye clips.

 > Swap Shot: A checkbox that, when enabled, switches the actual media used by two 
corresponding left- and right-eye clips. Useful in situations where the eyes of a stereo 3D 
clip were mislabeled, and you want to switch the clips without rebuilding both EDLs.

 > Copy Left to Right: Copies the left-clip grade to the corresponding right-eye clip.

 > Copy Right to Left: Copies the right-clip grade to the corresponding left-eye clip.

Batch Grade Management for Stereo 3D Projects

There are also a series of batch-processing commands that are useful for stereoscopic grading that 
are available when you right-click one or more selected clips in the Thumbnail timeline: 

 > Stereo Batch Copy: Copies every grade from the left-eye clips to the right-eye clips.  

 > Stereo Batch Sync: Copies grades from one eye to the other only when their node graphs have 
the same number of nodes. This prevents you from accidentally overwriting a custom grade 
with a different node structure that was necessary to match two eyes for a problem shot.

The Copy Grade, Swap Grade, Swap Shots, Ripple Link, and Switch Eye commands are also available 
from the Stereo submenu of the Timeline contextual menu. 

Automatic Image Processing for Stereo 3D

It’s common during stereoscopic shoots for minor divergences in geometry and color to appear in 
the source footage. To make the process of grading stereo 3D media less onerous, DaVinci Resolve 
provides a set of auto-adjustment controls that gives you a starting point for matching left- and 
right-eye clips together.

Auto align and color match buttons
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Auto Process—Stereo Alignment

For the stereoscopic effect to work without causing headaches, it’s critical that both eyes are aligned. 
This can be tricky to adjust using manual controls, but is something that can be automatically 
analyzed. You can perform stereo 3D alignment to a single clip, or you can select a range of clips to 
align all of them automatically at once. There are two options. Which is more appropriate depends 
on the type of geometry issues you’re needing to address.

 > Transform Alignment: Analyzes the image and makes vertical and rotational adjustments to 
line up the left- and right-eye images as closely as possible.

 > Vertical Skew: Analyzes the images and makes a vertical-only adjustment to line up the 
left- and right-eye images.

To align one or more clips automatically:

1. Select one or more stereo clips in the Thumbnail timeline of the Color or Format pages.

2. Choose which frame of each clip you want to use for the analysis by opening the Stereo 3D 
palette, clicking the Option menu, and choosing Auto Process > First or Auto Process > Middle.

3. Do one of the following:

 > Using the Stereo 3D palette, click either of the Stereo Alignment buttons. The button to the 
left is for Automatic Transform, while the button to the right is for Automatic Vertical Skew.

 > Right-click the thumbnail, and choose Transform Alignment or Vertical Skew from the 
contextual menu.

The Stereo Alignment window appears, and a progress bar shows the remaining time this 
operation will take.

Auto Process—Color Matching

Due to the design of different stereo 3D rigs, sometimes the color and contrast of one eye’s media 
doesn’t precisely match that of the corresponding eye. DaVinci Resolve provides two commands for 
quickly and automatically matching two eyes together.

 > Stereo Color Match (Primary Controls): Uses the Lift/Gamma/Gain controls to match one 
eye to the other. The result is a simple adjustment that’s easy to customize, but may not 
work as well as Custom Curves in some instances.

 > Stereo Color Match (Custom Curves): Uses the Custom Curves to create a multipoint adjustment 
to match one eye to the other. The result can be more effective with challenging shots.

 > Stereo Color Match (Dense Color Match): Performs a pixel by pixel, frame by frame color 
match that is incredibly accurate. This operation is processor intensive, so if you’re going to 
batch process many clips, or if you’re matching long clips, you’ll want to make sure you have 
adequate time. Because this is so precise match, it’s recommended to use Dense Color 
Match after you’ve used one of the stereo alignment commands.
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Tip: For the best results, it’s recommended to use automatic color matching in a separate node, 
independent of other corrections.

Stereo 3D color match works differently depending on whether or not one of the stereo 3D-paired 
clips has already been graded. The following procedure shows how to match a pair of left- and 
right-eye clips before you make any manual adjustments of any kind.

To match a pair of left- and right-eye clips automatically:

1. Select one or more clips in the Thumbnail timeline of the Color page.

2. Do one of the following:

 >Open the Stereo 3D palette, and click one of the two Color Match controls.

 The Color Matching window appears, and a progress bar shows the remaining time this 
operation will take. You can also use automatic color matching to match an ungraded clip to 
a paired clip that’s already been graded. This only works for grades consisting of one or more 
primary corrections; secondary corrections cannot be auto-matched.

To match an ungraded clip automatically to a paired stereo clip that’s graded:

1. To suspend stereo grade linking temporarily:

 >Open the Stereo 3D palette, and turn off the Ripple Link button

 > Right-click the Thumbnail timeline, and choose Stereo > Ripple Link > Solo.

2. Make a primary adjustment to a clip in the left-eye timeline to create a simple base grade. 
The left-eye clip now has a grade, and the right-eye clip does not.

3. Do one of the following to switch eyes:

 > In the Stereo 3D palette, click Right.

 > Right-click the Thumbnail timeline again, and choose Stereo 3D > Switch Eye.

 This procedure only works when you use the Stereo Color Match commands on the ungraded 
clip of a left- and right-eye stereo pair, to match it to the graded clip.

4. To make the match, do one of the following:

 > In the Stereo 3D palette, click one of the two color match controls.

 > Right-click one of the clips, and choose one of the two options from the Stereo Color 
Match submenu.

 Both clips should match one another very closely.
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Stereo 3D Monitoring Controls

To output both eyes to a stereo 3D display, you need to click the Vision: Mono or Stereo radio 
button, and then choose a display mode from the Output pop-up menu.

Monitoring controls for Stereo 3D

 > Vision: Two radio buttons let you choose between Mono, where only one eye is monitored in 
the Viewer and your video output interface, and Stereo, where both eyes can be displayed in 
the Viewer and output to video in a variety of different formats. For more information about 
outputting Stereo 3D to an external display, see Chapter 4, “Stereoscopic Workflows.”

 >Output: A pop-up menu that provides different stereo viewing options for previewing 
stereo 3D signals in different ways. By default, this option is also linked to the Viewer display 
Internal Video Scope options. For detailed descriptions of each stereo 3D viewing mode, 
see the following section, “Output Options.”

 > Link Viewer to Waveform: When enabled (orange), the Viewer and internal video scopes 
both use the same option for stereo 3D viewing as specified in the Output pop-up menu. 
When disabled, you can choose different stereo 3D viewing options for the Viewer and 
internal video scopes.

 > Viewer: Lets you choose a stereo 3D viewing option for the Viewer.

 >WFM: Lets you choose a stereo 3D viewing option for the internal video scopes.

 > Cbd Size: If any stereo 3D viewing options are set to Checkerboard, this parameter becomes 
enabled, and lets you define the size of the checkerboard boxes, in pixels.

Dual 4:2:2 Y’CbCr stereoscopic video streams are output via HD-SDI on selected Blackmagic I/O 
devices when you turn on the ”Enable dual SDI 3D monitoring” checkbox on the Master Project 
Settings panel of the Project Settings. You can select either Side-by-Side or Line-by-Line output 
to be fed to your stereo-capable display, depending on your display’s compatibility. For more 
information, see the “Stereoscopic Workflows” section of Chapter 6, “Conforming Projects.”
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Output Options

Additionally, the Viewer and video scopes can be set to display both “eyes” in one of a variety of 
different modes.

 > Side by Side: Displays both images side by side. Each eye is squeezed anamorphically to fit 
both eyes into the same resolution as the GUI viewer.

 > Line by Line: An interlaced mode where each eye is displayed on alternating lines. The 
thickness of the lines as seen in the Viewer depends on how zoomed in you are.

 > Checkerboard: Displays both eyes via an alternating checkerboard pattern. This is an 
excellent mode for identifying regions of the image where there’s variation in color or 
geometry between the two eyes.

 > Anaglyph (B/W): Each eye is desaturated and superimposed via Red/Cyan anaglyph 
to show the disparity between both eyes in different regions of the image. Left-eye 
divergence is red, and right-eye divergence is cyan. Regions of alignment between both 
eyes appear grayscale. 

Anaglyph modes are useful for evaluating the geometric differences between both eyes, 
as well as for identifying the point of convergence (where both eyes align most perfectly) 
that places a region of the image at the screen plane. 

Red/cyan color coding also identifies the direction of parallax. For any given feature, disparity 
such that red is to the right and cyan is to the left indicates positive parallax (backward 
projection away from the audience). Red to the left and cyan to the right indicates negative 
parallax (forward projection towards the audience).

 > Anaglyph (Color): Similar to Anaglyph (B/W), except that regions of close alignment are 
shown in full color. Incidentally, both anaglyph modes can be previewed on ordinary 
displays using old-fashioned red/cyan anaglyph glasses, enabling stereo 3D monitoring on 
non-stereo 3D-capable displays.

 > Difference: Superimposes grayscale versions of both eyes using the difference composite 
mode. Corresponding left/right-eye pixels that are perfectly aligned appear black, while 
pixels with disparity appear white. This mode is extremely useful for evaluating geometric 
differences between both eyes, as well as for identifying the point of convergence, without 
the distraction of color that the anaglyph modes present.

 > None: Only displays the eye corresponding to the currently selected timeline in the 
Viewer. However, this option also works in conjunction with the “Enable dual SDI 3D 
monitoring” checkbox in the Master Project Settings of the Project Settings which, 
when turned on, outputs each eye to an individual HD-SDI output of your Blackmagic 
I/O card. For more information about outputting Stereo 3D to an external display, see 
Chapter 4, “Stereoscopic Workflows.”
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The viewer set to display an anaglyph stereo image in color

Floating Windows

Floating Windows are meant to correct for “Window violations,” where elements of the image with 
negative parallax, that project forward from the screen plane towards the audience, are cut off by 
the edge of the frame. In these instances, differences between the images being shown to the left 
and right eyes can result in a visual paradox that’s difficult for viewers to reconcile. Specifically, when 
a forward-projecting element is cut off by the left or right edge of the frame, one eye sees things 
that the other eye does not.

If the subject is moving quickly, this may not be an issue, but if the cut off (or occluded) element 
lingers onscreen, it causes problems for viewers that defeat the stereo 3D illusion. The viewer’s 
binocular vision (or stereopsis) is providing one depth cue, while occlusion is providing a completely 
different depth cue. 

To fix this, you can use Floating Windows to crop the cut off object from the eye on the side of the 
object that’s cut off, thus eliminating the portion of the stereo image that is unseen to the other eye 
that causes the problem.

The objective of using Floating Windows is to manipulate the illusion of the viewer’s “window into 
the scene.” In addition to fixing Window violations, it has been proposed that Floating Windows 
can be used as a creative tool by manipulating the geometry of this Window to alter subtly the 
viewer’s perception of the screen orientation.

 > By cropping the right-hand side of the right-eye frame, you also create the illusion that the 
right edge of the “window into the image” is tilted farther forward toward the viewer. 

 > By cropping the left-hand side of the left-eye frame, you create the illusion that the left 
edge of the Window is tilted toward the viewer. 

 > If you crop both the left-hand side of the left-eye frame and the right-hand side of the right-eye 
frame, you create the illusion that the entire plane of the “virtual screen” is coming toward you. 
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 > If you apply opposite-angled Windows to the left- and right-eye clips at one or both of the 
edges of the frame, it appears to “tilt” the screen toward or away from the viewer.

Tip: For more information about Floating Windows, see www.dashwood3d.com/help/stereo3d-
virtual-floating-windows/ and river-valley.tv/the-dynamic-floating-window-a-new-creative-tool-for-
3d-movies/.

Animating Floating Windows

Floating Windows can be animated using the Float Window keyframing track, found within the 
Sizing track of the Keyframe Editor, to push the edge of the frame in as needed, and then pull it back 
out when the partially occluded subject has moved fully into the frame. For more information about 
animating keyframing tracks, see Chapter 6, “Keyframing.”

Floating Window controls

Floating Windows have the following controls and parameters.

 > L/R/T/B buttons: Lets you choose an edge to which to apply a Floating Window. Click the 
button corresponding to the edge you want to adjust. Each edge has its own position, 
rotate, and softness settings.

 > Position: Adds masking to the currently selected edge.

 > Rotate: Rotates the currently selected edge, letting you create an angled Window.

 > Softness: Feathers the edge of the currently selected edge, letting you create a soft 
Window that can be less noticeable to viewers.

To add a Floating Window to fix a Window violation:

1. Choose to which eye you want to add the Floating Window. 

 > To apply a Floating Window to eliminate a Window violation on the right-hand side of the 
screen, click the right eye view. 

 > To apply a Floating Window to eliminate a Window violation on the left-hand side of the 
screen, click the left eye view.
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2. Choose which edge you want to adjust by clicking the L or R buttons.

 > To eliminate a Window violation on the right-hand side, click R.

 > To eliminate a Window violation on the left-hand side, click L.

3. Adjust the Position parameter as necessary to crop the portion along the edge of the selected 
eye that’s not visible in the other.

4. Optionally, if you feel that the Window adjustment you’ve just made is too obvious, increase 
the Softness parameter to make that edge less noticeable.

Stereo Controls on the DaVinci Control Surface

If you’re doing convergence adjustments and stereographic work throughout a program, you can 
use many of the controls described in this section from the DaVinci control surface.

To show the Stereo Transform Controls page on the Transport panel:

1. Press the 3D soft key. The Transport panel’s knobs and soft keys are remapped with all available 
Stereoscopic commands.

2. When you’re finished, press MAIN.

To show the Floating Windows controls on the Center panel:

1. From the main page of the Center panel, press the 3D soft key. The Floating Windows, Auto 
Match, and Auto Align controls appear on the Center panel. 

2. Press the 3D OVERLAY soft key to expose the Stereoscopic sizing controls on the Transport 
panel. Press 3D OVERLAY again to return to the ordinary sizing controls.

3. When you’re finished, press the MAIN soft key to return exit the 3D control page.
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Data Burn In

The Data Burn In palette lets you display select metadata as a “window burn” that’s superimposed 
over the current image in the Viewer. This window burn is written into files that you render in the 
Deliver page, and it’s also output to video, for viewing on your external display, or for 
outputting to tape.

Data Burn-in palette

Window burns are useful as a reference when creating offline media that you need to keep track of 
later. It’s also useful for watermarking review files that you don’t want to be distributed accidentally, 
for adding logos or “bugs” to programs in preparation for broadcast, or for temporarily displaying 
timecode or clip names to refer to on your monitor when reviewing dailies with a client.

Tip: There’s also an Output Option checkbox on the Deliver page, “Burn in this text,” that lets you 
quickly enter a line of custom text to output as a window burn without using the Data Burn In palette.

Viewer displaying a logo, custom text, timecode and file path
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Project vs. Clip Mode

The Palette mode pop-up menu lets you choose whether you want to edit burned-in metadata on 
a clip-by-clip basis to be applied when rendering individual source clips, or one set of burned-in 
metadata that will be displayed for the entire duration of the Timeline, to be applied when rendering 
either individual source clips or as one single clip.

Setting Up Burned-In Metadata

Setting up different clip and project metadata to output as a window burn is easy.

To set up a window burn:

1.  Choose Project or Clip mode from the Palette mode pop-up menu.

2. Turn on the checkboxes of whatever items of metadata you want to display in the “Add to Video 
Output” column. More information about the available items appears later in this chapter.

 The first item of metadata is centered near the bottom of the frame, above Action Safe. Each 
additional item of metadata you turn on for display is added above whichever items are already 
displayed, regardless of their position in the “Add to Video Output” list.

3. Click any currently enabled item of metadata from the list to highlight it in orange, and edit 
that item’s Custom Output parameters at the right. More information about the available 
parameters appears later in this chapter.

To reset the current window burn setup:

 > Click the Options pop-up menu, and choose Reset to reset the current mode of the Data 
Burn In palette.

Saving and Loading Burn-In Presets

If there are common sets of metadata that you regularly use and switch among, you can save each 
set up as a preset for future use.

To save a burn-in preset:

1. Click the Preset name field, and type a name.

2. Click the Preset Options pop-up menu, and choose Add Preset. That preset is added to the 
list of saved presets.
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To delete a burn-in preset:

1. Choose a preset from the Preset menu.

2. Click the Preset Options pop-up menu, and choose Del Preset.

To modify a burn-in preset:

1. Choose a preset from the Preset menu.

2. Edit it however you like.

3. Click the Preset Options pop-up menu, and choose Update Preset.

Data Burn-In Options

The leftmost column in the Data Burn In palette contains a scrollable list of all the options that you 
can add to the video output as a window burn. Each option has a checkbox that lets you turn it on 
or off. You can also select in the Option pop-up if you would like the item name rendered as a prefix 
to the burn-in data.

Note: If two clips overlap in the Timeline, the metadata that matches the currently visible clip in the 
Viewer is what will be displayed in the window burn. 

 > Record Timecode: The timecode relative to the Timeline, as set in the Conform Options in 
the Master Project Settings of the Project Settings.

 > Record Frame Number: The number of frames from the first frame of the Timeline.

 > Source Timecode: Each clip’s individual timecode.

 > Record TC & Frame Num: Both metadata options combined in one line.

 > Source TC & Frame Num: Both metadata options combined in one line.

 > Source & Record TC: Both metadata options combined in one line.

 > Audio Timecode: The timecode of audio that’s been synced to a clip.

 > Keycode: Also referred to as edge-code, the identification codes running along the edge 
of film stocks that provide an absolute reference for which digital frames correspond to 
which film frames.

 > Source File Name: The full file path, including file name, of the media file that’s linked to 
the current clip.

 > Record File Name: The file name as defined in the Render Settings list of the Deliver page.

 > Source Clip Name: The file name of the media file that’s linked to the current clip, without 
the file path.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

680

ADVANCED COLOR FEATURES12

 > Custom Text1: A line of text that you type into the Text field of the Custom Output 
parameters. You can use any characters you like.

 > Custom Text2: A second line of text that you can customize.

 > Custom Text3: A third line of text that you can customize.

 > Logo1: Lets you superimpose a graphic over the image in a customizable location. 
Compatible graphics formats include PNG, TGA, TIF, BMP, and JPG. Alpha channels are 
supported for transparency in logos.

 > Logo2: Lets you superimpose a second graphic.

 > Logo3: Lets you superimpose a third graphic.

 > Reel Name: The currently defined reel number for the current clip.

 > Shot: Shot metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

 > Scene: Scene metadata, if it’s been written to the file by a camera, or entered into the 
Metadata Editor on the Media page.

 > Take: Take metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

 > Angle: Angle metadata, if it’s been written to the file by a camera, or entered into the 
Metadata Editor on the Media page.

 > Day: Day metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

 > Date: Date metadata, if it’s been written to the file by a camera, or entered into the Metadata 
Editor on the Media page.

 > Circled Take: Corresponds to Good Take metadata, if it’s been written to the file by a 
camera, or entered into the Metadata Editor on the Media page.

 > Camera: Corresponds to the Roll/Card metadata, if it’s been written to the file by a camera, 
or entered into the Metadata Editor on the Media page.

 > Roll/Card: Corresponds to the Roll/Card metadata, if it’s been written to the file by a 
camera, or entered into the Metadata Editor on the Media page.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

681

ADVANCED COLOR FEATURES12

Tags For Populating Text Fields With Metadata

When entering custom text using any of the appropriate options listed above, you can use tags 
to automatically populate a custom field with data from the current clip. If necessary, you can also 
use multiple tags together as long as they’re separated by commas, spaces, or a dash. When using 
these tags, the tag is replaced by the metadata it references in the window burn.

 > Tape Number from EDL: %T

 > Resolution of the rendered file (i.e., 2048x1556): %R

 > Event number from the EDL: %E 

 > Clip number as displayed in the Timeline thumbnail: %I 

 > Version name of the rendered file: %V 

 > Stereo project, Left or Right eye: %{eye}

 > Reel Number extracted from source filename/clipname: %L 

 > Shot: %{shot}

 > Scene: %{scene}

 > Take: %{take}

Custom Output Options

The parameters in the Custom Output panel let you modify the look, position, and in some 
cases content, of the selected metadata item. Pan and Tilt are individually customizable for each  
metadata item.

You have the option of independently styling each item of metadata, depending on whether the 
Gang Render Text Styles option is checked in the Option pop-up. When turned on, all text metadata 
share the same font, size, color, background, justification, and opacity. When turned off, each item 
of metadata can have individual settings.

 > Font: Defaults to Courier, but you can choose any font that’s installed on your system.

 > Size: Defaults to 48, but you can choose standard increments from 6 to 72.

 > Color: Defaults to white, but you can choose from a range of predefined colors in this 
pop–up menu.

 > Background: Defaults to black, although the apparent color is influenced by the Opacity 
setting. For a more garish look, you can choose from a range of predefined colors in this 
pop-up menu.

 > Justify Text: Defaults to Center. The only other option is Left.
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 >Opacity: Defaults to 0.50. Lets you define the transparency of the burned-in metadata’s 
background color.

 > Pan: Lets you change the horizontal orientation of the current item of metadata. The default 
value is the center of the frame, relative to the current project’s frame size.

 > Tilt: Lets you change the vertical orientation of the current item of metadata. The first item 
of metadata is centered near the bottom of the frame, above Action Safe. Each subsequent 
item of metadata you turn on is automatically placed above the previous item of metadata, 
regardless of its order in the “Add to Video Output” list.

 > Show for first: Turning on this checkbox lets you specify a number of frames during which 
the current item of metadata will be displayed before dissolving away over one second. 
When enabled, the current item of metadata will cut onscreen with the beginning of each 
new clip, remain onscreen for the duration specified, and then dissolve away.

 > Show for last: Turning on this checkbox lets you specify a number of frames before the end 
of each clip during which the current item of metadata will appear onscreen after fading up 
over one second, before cutting away with the end of the clip.

 > Text: A text field that lets you enter custom text to display as one of three possible custom 
text items.

 > Logo: A field that displays the file path of any currently selected graphic that you’re displaying 
as one of the three possible Logo graphics. Compatible graphics formats include PNG, 
TGA, TIF, BMP, and JPG. Alpha channels are supported for transparency in logos.

 > Import File button: Lets you choose a graphics file to use as a logo.
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Node Editor Basics

By default, every clip has one node in the Node Editor that contains the first corrections you make 
to a clip. However, you also have the option of creating multiple nodes, where each node contains 
one or more corrections that affect the image.

Node Editor

The specific arrangement of nodes you create lets you exert precise control over the order of 
operations performed by your grade, which provides many advantages. This section covers different 
ways of creating, editing, and arranging node trees to harness the full power of DaVinci Resolve.

The Node Editor Interface

As you work within the Node Editor, you may find the need to zoom into or out of it to get a better 
look at the node tree, and to pan around the working area to deal with large collections of nodes.

To expand the size of the Node Editor’s working area:

 > Drag the border between the Node Editor and the Gallery to the left or right to make it 
wider or narrower.

 > Right-click anywhere within the Node Editor (except on a node) and choose Toggle Display 
Mode, which hides the Viewer and moves the Node Editor to the right of the Gallery, 
enlarging it considerably. Right-click and choose Toggle Display Node again to return to 
the default layout.

 > You can toggle Display mode using the DaVinci control surface by pressing SHIFT UP and 
the DISPLAY/CURSOR button above the fourth trackball on the Center panel.
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To zoom and pan within the Node Editor, do one of the following: 

 > Scroll up to zoom in, scroll down to zoom out.

 > Use the Node Editor’s zoom slider.

 > Click and drag the gray area of the Node Editor to pan around.

 > Right-click and choose Zoom In or Zoom Out.

 > Right-click and choose Zoom to Window to fit the node tree to the current size of the 
node graph.

 > Right-click and choose Original Size to return the node graph to the default size.

The Components of a Node Tree

Ambitious grades may require trees of multiple nodes to create the necessary effect. This section 
covers the mechanics of putting nodes together into the structures that are described in more 
detail later in this chapter.

Every serial and parallel node you add is a “corrector” node, which is capable of either primary or 
secondary correction, depending on whether or not you enable the Qualifier/Window/Matte 
controls. As a result, each Corrector node has two inputs and two outputs, which lets you separately 
manage the RGB image channel, and the Key channel. The Key channel can be used to define areas 
of isolation for image processing operations, or transparency for compositing.

A single node, the round RGB and triangular KEY inputs and outputs are clearly visible

Nodes are attached to one another via “connections,” seen as lines that connect one node to 
another. Image data flows from left to right, starting with the Source bar all the way at the left of 
the Node Editor, through each node in the tree, and ending at the Output bar at the right of the 
Node Editor.
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A simple serial arrangement of corrections

Here’s an explanation of the different components of a basic node tree, and how they fit together:

 > Source Bar: The source is the clip as processed by the Sizing and Source decode settings, 
ungraded. It’s represented by the gray bar to the center left of the node graph. The Source 
bar outputs RGB data, and is connected to the RGB input of the first node in your tree. 
You can connect the Source bar to more than one Corrector node, creating multiple 
simultaneous streams of image processing that you can eventually recombine in different 
ways using the Parallel or Layer Mixer nodes.

 >Nodes: Each node in the node graph represents a collection of image processing 
operations that can be enabled or disabled separately from any other node in the graph. 
By separating operations into multiple nodes, you’re able to precisely control image 
processing operations to create many different corrections and effects. The RGB input and 
output of each node in the Node Editor must be connected for a grade to be enabled. 
Each node’s thumbnail image shows the state of the image at that particular stage of the 
grade, giving you a visual indication of what that node is doing.

 > RGB Inputs and Outputs: The yellow dots at the upper right and left of each node are used 
to connect the RGB image output from one node to the RGB input of the next node. For a 
Corrector node to have an effect, you must connect both its RGB Input and its RGB output 
to neighboring nodes in the tree.

 > Key Inputs and Outputs: The blue triangles at the bottom right and left of each node are 
used to route the key channel generated by a node’s Qualifier or Window controls, or 
imported via a Matte clip that you previously associated with a clip in the Media page. 
When you connect the Key output of one node to the Key input of another, you basically 
copy the first node’s key to the second node. You can also combine the Key outputs of 
multiple nodes in various ways using the Key Mixer node.

 >Output Bar: The RGB output of the last node in a tree must be connected to the Output 
bar, which “completes the circuit” of image processing, and passes that correction on 
to the next stage in the DaVinci Resolve image processing pipeline. If the output is not 
connected, the node tree has no effect on the clip. You can only connect one RGB output 
at a time to the Output bar.
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 > Second Source Bar (for HDR): You can access the alternate highlight exposure of RED HDR 
media by exposing this optional second Source bar. For more information, see “Node 
Tree Structures.”

 > Alpha Output Bar: It’s possible to create regions of transparency for compositing directly 
in DaVinci Resolve by connecting a Key output to an optional Alpha Output bar. For more 
information, see later in this chapter, “Manipulating and Combining Keys.”

Node Badges and Labels

Nodes appear with various labels and badges to help you identify what each node is contributing 
to the overall grade. How long a label and how many badges appear depends on the size of each 
node, as set by the Node Editor’s Zoom slider.

Nodes showing the kinds of labeling and badges that are available for identifying what operations each node is performing

 >Node number: Nodes are numbered in the order in which they were created, making it 
possible for you to select specific nodes by number via the DaVinci Control Surface.

 > Adjustment badges: As you apply various operations within a node, up to four badges 
appear at a node’s default size in the Node Editor (three if a Color Space label appears) 
identifying which operations have been applied. At larger sizes, more badges can appear 
at once. Each palette has a badge. If you apply more operations than a node has area to 
display, a single “downward arrow” badge appears.

 > Color Space labels: If you switch a node to use a color space other then RGB, that color 
space’s three letter label appears between the node number and any Adjustment badges 
that appear.

Labeling Nodes

Nodes can be labeled to identify a particular node’s function in your grade. This can make it easier 
to revise a grade months later. Node labels are also saved when you save a still, so labels can also 
make it easier to decipher a saved grade down the road. At each node’s default size in the Node 
Editor, nodes can appear with up to 12 characters of text, although larger nodes can accommodate 
more text.
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To label a node:

1. Right-click a node and choose Change Label.

2. Type a label into the Change Node Label dialog, and click OK.

 The label you entered appears above the node in the Node Editor.

Selecting Nodes

The node that’s currently selected in the Node Editor is highlighted in orange, and is referred to 
as the current node. When you adjust any of the parameters or settings in the Color page, you’re 
adjusting parameters within the current node. You can only select one node at a time.

To select a node, making it the current node, do one of the following:

 > Double-click any node in the node graph.

 > Using the Transport panel of the DaVinci control surface, press the PREV NODE or 
NEXT NODE buttons.

 > Using the Transport panel of the DaVinci control surface, enter the number of the node you 
want to select using the keypad, and then press the SELECT NODE button.

When you select another clip in the Timeline, the default behavior is that the last node that was 
selected when you worked on that clip is the one that’s selected when you move to that clip again. 
However, a setting in the Project Settings window, “Switching clips,” lets you change this behavior. 
For more information on this option, see Chapter 3.

Disabling Nodes

In the process of creating a node tree, it’s often useful to turn nodes off to disable their effect on 
your grade. It’s also useful to turn the entire node tree off and on in order to see “before and after” 
views of the current clip. Disabled nodes are not processed during rendering, and they remain 
disabled when you save that grade along with a still in the Gallery and then apply that grade to 
another shot.

To toggle individual nodes off and on:

 > Click the number of any node in the node graph to disable that node by itself. 

 > Select a node, and choose Nodes > Enable/Disable Current.

 > Press Control-D.

 >On the DaVinci control surface, press the DISABLE CURRENT button (on the T-bar panel).
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To turn every node off and on at once: 

 > Press Option-D to toggle all nodes off and on. 

 >On the DaVinci control surface, press SHIFT-DOWN and then the DISABLE CURRENT 
button (on the T-bar panel).

Important: When you turn every node off and then on again, every node is re-enabled, even nodes 
that had previously been individually disabled.

Bypass All Grades

You can also use a separate command to disable grading altogether. This is useful if you’ve toggled 
specific nodes off in the node tree, and you want a before and after look at the node tree with those 
nodes turned off. When Bypass All Grades is enabled, grading is disabled for all clips in the entire 
Timeline until you disable it.

To toggle grading off and on, do one of the following:

 > Click the disable grading button at the bottom right-hand corner of the Node Editor.

 > Choose View > Bypass All Grades (Shift-D)

Resetting Nodes

If you’re dissatisfied with your current operations and want to start over, there are three ways you 
can reset nodes in the Node Editor. These are available as items in the Color menu, and buttons on 
the DaVinci control surface’s T-bar panel.

 > Reset Selected Node Grade: Resets the currently selected node, eliminating all keyframes, 
to the default parameter settings.

 > Reset Grades and Keep Nodes: Resets every node in the current node tree, without 
affecting the node tree’s structure; all nodes remain where they were. However, each node 
has been reset to the default parameter settings, and all keyframes have been eliminated.

 > Reset All grades and Nodes: Deletes every node and keyframe, and restores a single node 
set to the default parameter settings.

Previewing and Restoring Node Trees

There are two other methods of quickly dealing with unwanted changes you’ve made to node trees, 
without needing to use undo.

 > Preview Memory: Lets you preview the effect of any saved grade on the current clip. To 
preview, choose Color > Preview Memory (Shift-Command-M), and then right-click any 
saved still in the Gallery (or Memory) and choose Add Correction. If you like the effect, 
then you can leave it be. If you don’t like the effect, then choosing Color > Preview Memory 
again reverts the clip to the original grade.
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 >Original Memory: This command lets you quickly revert a clip’s grade to its original state 
when you first selected that clip. This is useful for getting immediately back to a clip’s original 
grade if you’ve made a series of changes that you then regret. Selecting another clip in the 
Timeline and then reselecting the clip you made changes to resets what is considered to 
be the current grade.

Caching Specific Nodes to Improve Performance

You can flag specific nodes to be cached, along with all nodes appearing upstream in that node 
tree. By caching nodes using processor-intensive effects, you free up real-time capability for the 
remaining downstream nodes in a grade. Choosing Playback > Render Cache > User only caches 
nodes that you’ve flagged for caching.

When you choose Playback > Render Cache > Smart mode, Resolve automatically caches any nodes 
that use Motion Blur, Noise Reduction, or OFX plug-ins, without you needing to do anything.

To flag a node and all corrections made in upstream nodes for caching:

 > Right-click any node and choose Node Cache > On from the contextual menu.

Editing Node Trees

There is no limit to the number of nodes you can create and connect to one another, and you can make 
as many or as few parameter adjustments as you like within each node. The following procedures 
describe the ways you can add nodes to the node graph as you build each grade’s node tree.

Adding Nodes

The simplest thing you can do to add to the complexity of a node tree is to add additional nodes, 
in order to add more adjustments to the current grade.

Basic methods of adding nodes to the tree:

 > To add a serial node after the currently selected node: Press Option-S key, choose Nodes 
> Add Serial from the menu, or press the ADD SERIAL button on the T-bar panel of the 
DaVinci Resolve control surface.

 > To append a serial node to the very end of the node tree: Press Option-A, choose Nodes 
> Append Node from the menu, or press the APPEND NODE button on the T-bar panel of 
the DaVinci Resolve control surface.

 > To add a serial node before the currently selected node: Press Option-Shift-S, or choose 
Nodes > Add Before Current, or press SHIFT DOWN and then ADD SERIAL on the T-bar 
panel of the DaVinci Resolve control surface.

 > To add nodes in parallel to the currently selected node: Press Option-P, choose Nodes > 
Add Parallel from the menu, or press the ADD PARALLEL button on the T-bar panel of the 
DaVinci Resolve control surface.
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 > To layer nodes with the currently selected node: Press Option-L, choose Nodes > Add 
Layer from the menu, or press the ADD LAYER button on the T-bar panel of the DaVinci 
control surface.

 > To add a disconnected node to the node graph: right-click anywhere within the node 
graph’s background, then choose Add Node > Corrector from the contextual menu. 
Disconnected nodes have no effect on a node tree until they’re connected.

Adding Nodes with Windows Turned On

There are also dedicated commands for adding serial nodes with Circular/Linear/Polygon/Curve 
windows automatically turned on, for convenience. 

To add a node to the tree with a Window automatically enabled:

Choose an item from the Nodes menu, or press the button on the T-bar panel of the DaVinci 
Resolve control surface that corresponds to the following:

 >Node + CPW: Circular Power Window (Shift-C)

 >Node + LPW: Linear Power Window (Shift-Q)

 >Node + PPW: Polygonal Power Window (Shift-G)

 >Node + PCW: Power Curve Window (Shift-B)

Whenever you add a node to a tree, it’s numbered consecutively to come after the next most recent 
node you’d added, regardless of the order in which it appears in the node tree. For example, if 
you’ve already added three nodes, and then you decide to add another node in between Nodes 1 
and 2, the new node will be Node 4, and the order of the nodes will be 1, 4, 2, and 3.

Deleting Nodes

If there’s a node that you no longer need, you can choose to remove it completely from the node 
tree to remove its effect permanently.

To delete a node, do one of the following:

 > Select a node, then press the Forward-Delete key.

 > Right-click a node, and choose Delete Node.

 > Using the DaVinci Resolve control surface, select any node, and press the DEL-CURRENT 
button (on the T-bar panel).

After you’ve deleted a node, the node to the left and right of the node you deleted are automatically 
connected so that the node tree is unbroken. Also, all the nodes in a tree are renumbered after the 
deletion of any node, so there’s no discontinuity in node order. For example, if you have three 
consecutively numbered nodes in a tree and you delete the second one, the node that was formerly 
number 3 is renumbered to be 2.
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Disconnecting and Reconnecting Nodes

For a node tree to work, every node in the Node Editor must be connected into a working node 
tree, from the Source bar, through each node in the tree, to the Output bar. Any disconnected node 
will result in that clip’s grade being disabled. However, you may find the need to disconnect some 
parts of a node tree in order to reconnect them in different ways.

To disconnect two nodes:

 > Click a link to select it (selected links turn yellow), and then press the Forward-Delete key.

 > Right-click a link and choose Delete Link.

To connect two disconnected nodes:

 > Click-and-drag from the RGB or Key output of one node to the corresponding RGB or Key 
input of another, and when the dotted line turns solid, release the mouse button.

You can connect any node’s RGB or Key output to as many inputs as you want, but you can only have 
one connection going to a node’s input. The exception to this is a node with multiple inputs, designed 
to combine the output of multiple nodes. These include the Parallel, Mixer, and Key Mixer nodes.

To insert a disconnected node between two other nodes:

 > Drag a disconnected node onto the connection between any two other nodes in a node 
tree, and when a plus icon appears over the node you’re dragging, drop it to insert the node.

Rearranging Node Order

The order in which nodes are connected in your tree affects the result of a grade. For example, 
if you boost the highlights in the first node, and then you try to isolate a portion of the picture in 
a second node that you now realize has been clipped, you may to need to change your order of 
operations to optimize your corrections.

To reorder two or more nodes:

1. Delete every link that connects the nodes you want to rearrange.

2. Drag the nodes into the new order you want them in the node graph (it pays to be tidy), and 
then reconnect the RGB outputs and inputs until all nodes in your tree are reconnected in the 
order you want them.

Keeping Node Trees Organized

It’s a good idea to keep the arrangement of your nodes in the node graph clean and neat. It’ll make 
it easier to read your tree if you need to revisit a grade later on, and it will also make it easier for other 
colorists working on the same project to figure out what you’re doing. The following procedures 
describe how to rearrange the nodes in your tree, and the node tree working area, to help you keep 
on top of your grades.
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To move a node to another position in the grid:

 > Click a node with the pointer and drag it to a new position.

Another nice organizational feature of the Node Editor is an automatic tooltip that appears whenever 
you hover the pointer over a particular node, that shows you a concise list of all the operations 
applied to that particular node.

Copying Nodes and Node Settings

You may save time when assembling complicated node trees by recycling nodes or node settings 
from previous grades.

Copying Nodes From Other Clips

When constructing node trees, you may sometimes find it necessary to copy nodes from one clip’s 
grade to another. This can be accomplished by exposing the node tree of any still that’s saved in the 
Gallery, or any clip in the Thumbnail timeline, and copying individual nodes from the exposed node 
tree to the Node Editor.

Dragging a node from a node graph to the node editor

To copy nodes from any still in the Gallery:

1. Right-click a still in the Gallery, and choose Display Node Graph. A Node Graph window 
appears displaying that still’s node tree.

2. Drag any node from the node tree directly over any connection line in the Node Editor. When 
a small plus icon appears over the Corrector node icon you’re dragging, drop the node to 
insert it into that connection.

3. Click Exit when you’re finished.
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To copy nodes from any clip in the Timeline:

1. Click the thumbnail in the Timeline of the clip to which you want to copy nodes.

2. Right-click the thumbnail of the clip you want to copy nodes from, and choose Display 
Node Graph.

 Note: The Display Node Graph command only appears in the contextual menu of a clip in the 
Thumbnail timeline that is not currently selected.

3. Drag any node from the node tree directly over any connection line in the Node Editor. When 
a small plus icon appears over the Corrector node icon you’re dragging, drop the node to 
insert it into that connection.

4. Click Exit when you’re finished.

Using this mechanism, you can also copy every node in the node tree using the Apply Color button, 
or copy just the Sizing (Pan/Tilt/Zoom/Rotate parameters) using the Apply Sizing button.

Copying Node Settings

You may also find yourself needing to copy one node’s settings to another node. In particular, this 
is the only way of copying tracking data or keyframes from one node to another, either within the 
same grade, or from one grade to another.

To copy a node’s settings to another node:

1. In the Node Editor, select the node with settings you want to copy, and choose Edit > Copy 
(Command-C).

2. Select the node you want to paste these settings to, and choose Edit > Paste (Command-V).
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There are several ways you can organize nodes in a tree. Each method lets you control a group of 
image processing operations in different ways to achieve specific results. This section covers how to 
use Serial nodes, Parallel nodes, and Layer nodes, as well as how to use LUTs, work with HDR media 
that lets you combine two different exposures using two different Source bars, and apply additional 
project-wide adjustments using the Timeline grade.

Serial Node Structures

The simplest, and most common node structure is a serial cascade of nodes, where a linear series 
of nodes is connected, one after another. 

Serial nodes, the output of one node goes into the next

Much of the time, this method of constructing a tree of multiple operations is all you need to do. It’s 
a simple and intuitive way of organizing your adjustments, similar in principle to the stacks of layers 
used in other grading and compositing applications to apply multiple operations to a clip.

Controlling What Feeds a Node’s RGB Input

When you create a grade using serially arranged nodes, each node’s output is used as the next 
node’s input, so the order in which the nodes are arranged determines the order of image 
processing operations. 

In the following screenshot, the node tree shows a series of three operations that are applied to a 
log-exposed, low-contrast clip. The first node expands clip contrast and increases saturation. The 
second node isolates the green foliage to intensify its color. The third desaturates and warms the 
image. At right, you can see the result of this node tree.

Node two pulls a clean key from the image data fed it by node one

Node Tree Structures
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If, instead, we reversed the order of Nodes 2 and 3, the result will be a less effective key.

By comparison, node three pulls a less then optimal key from the image data fed it by node two

Because the secondary operation is sampling the desaturated image, rather than the source, the 
HSL Qualifier’s key has less image data to work with, and thus you get an inferior result.

Parallel Node Structures

Another way to organize your corrections is to use a Parallel node structure, which lets you apply two or 
more overlapping adjustments at a single stage of a node tree. You can use the Parallel node structure 
for organizational reasons when there is a group of secondary corrections that you want to apply all at 
once. You can also use this structure for the unique way it blends overlapping image adjustments.

The Parallel Mixer node that makes this possible has multiple RGB inputs and a single RGB output. This 
lets the Parallel Mixer mix together multiple Corrector nodes, outputting a single image as a result.

When you add a Parallel node to an existing node, DaVinci Resolve automatically adds one Corrector 
node below the current node, and adds a Parallel Mixer node to its output.

Adding a Parallel node to Node 2 automatically adds the Parallel Mixer

Tip: If you want to create a series of Parallel nodes that connect to the output of the currently 
selected node, create a Serial node before you create your first Parallel node.

If you’re manually connecting another node to a Parallel Mixer node, you must first create an 
additional input to connect it to.
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To create an additional, unconnected input on a Parallel Mixer node:

 > Right-click a Parallel Mixer node and choose Add One Input.

Ordinarily, the RGB input of every Corrector node that’s connected to a Parallel node is connected 
to the output of the same node. This results in a stack of nodes that take the same state of the image 
as their input. This makes it easy to apply multiple secondary operations without worrying about 
whether or not a change to one will affect the keys of the others.

Further Parallel nodes can be added as you wish with each using a common source

If you add another node in parallel, the Parallel Mixer automatically adds another input. You can 
have as many nodes in parallel as you need. 

The adjustments made by all nodes that are connected to a Parallel Mixer are combined equally, 
regardless of which nodes are highest. In the following example, a separate overlapping Window is 
applied by each of three nodes in parallel.
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As you can see in the image at right, the three tints created by the overlapping Windows are all mixed 
together equally; the colors blend with one another as if they are optically mixed. Most of the time, 
this is exactly what you want when you’re blending overlapping naturalistic color adjustments.

Converting Parallel Mixers to Layer Mixers

On the other hand, if you need your overlapping color adjustments to have priority over one another, 
or if you want to combine multiple adjustments using composite modes, then you may want to use 
the Layer Mixer node instead. If you’ve created a Parallel Mixer structure and you want to convert it 
to a Layer Mixer, you can.

To change a Parallel Mixer node into a Layer Mixer node:

 > Right-click a Parallel Mixer node and choose Morph Into Layer Mixer Node.

Layer Mixer Node Structures

The Layer Mixer is structurally quite similar to the layout used by the Parallel Mixer. However, there 
are two key differences. First, the Layer Mixer node combines multiple adjustments with priority 
given to the image adjustment in the lowest overlapping node input. Second, you have the option 
of combining all of the Corrector nodes that are connected to a Layer Mixer using one of several 
different composite modes, to create a wide variety of visual effects.

Because of their similarities, layering nodes with the Layer Mixer works in much the same way  
as creating a Parallel node structure. 

Layer Mixer Prioritization

In the following example, the same node structure from the Parallel Mixer example is shown, this 
time with the three overlapping color adjustments mixed together using the Layer Mixer.

The Parallel Mixer blends all input nodes together
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Now, instead of the three adjusted color tints being blended, you can see that the green tint, which 
is connected to the lowest input of the Layer Mixer, is dominant and covers the overlapping regions 
of the two other adjustments. Meanwhile, the blue tint, which is connected to the middle input 
of the Layer Mixer, covers the overlapping portion of the orange tint, which is connected to the 
highest input of the Layer Mixer.

Rearranging which connections are attached to which Layer Mixer inputs changes each node’s 
priority, and like the Parallel Mixer, you can add more inputs if you need to connect more 
nodes manually.

The Layer Mixer’s prioritization is most useful when you have an overlapping adjustment that you 
need to override any other adjustments happening on that stack. In the following example, two 
nodes are connected to the Layer Mixer node. Node 2 is applying a high-contrast, cool look to the 
entire clip. Node 3 isolates the skin tone, which is unflattering with the background stylization, and 
applies a different, more naturalistic adjustment.

The Layer Mixer prioritizes nodes connected to lower inputs such that each node’s output completely obscures whatever is behind it
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Using the layer mixer, grades on Node 4 will have a greater priority over Node 2, so the final grade combines  

the high contrast from Node 2 with the adjusted skin tone from Node 4

Because of the Layer Mixer’s prioritization, the adjustment made to the man’s skin tone completely 
covers the adjustment made to the node that comes above it, providing the best of both worlds 
with one simple adjustment.

Tip: If you want to “solo” overlapping nodes that are connected to the Layer Mixer to see their 
individual adjustment, turn on Highlight (Shift-H, or the HILITE button on the Transport panel of the 
DaVinci control surface). This lets you view just that node’s effect, regardless of what other nodes 
adjustments are overlapping.

Using Composite Modes With the Layer Mixer

You have the option of combining the adjustments made by all nodes connected to a Layer Mixer 
node using the same Composite modes that are available when compositing clips in the Timeline. 
This lets you combine different overlapping image adjustments using compositing math to achieve 
creative effects or utilitarian fixes.

The following simple example shows two overlapping Corrector nodes connected to a Layer 
Mixer node that’s set to the Add composite mode. Node 2 has no adjustment, but Node 4 has an 
extremely high-contrast curve adjustment applied, along with a push to orange in the highlights 
and a blur, that effectively isolates the highlights of the image and fires them up.
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Combining two nodes using the Layer Mixer set to Add to create a glowing effect

By adding both treatments together, a hot glow has been created, blowing out the highlights of 
the image. Many, many other effects are possible using the different composite modes that are 
available. For more information on composite modes, see Chapter 7, “Edit Page Effects.”

Adjusting Layer Node Strength Using Key Output Gain

Whether you’re combining overlapping corrections, or mixing different adjustments using 
Composite modes, you’ll run into situations where you want to reduce the influence of one 
overlapping adjustment relative to the other nodes that are connected to the Layer Mixer node. 
This can be accomplished using each overlapping node’s Key Output Gain parameter, located in 
the Key palette.

Using the Output Gain parameter in the Key palette
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Key Output Gain defaults to 1.00, but lowering this value reduces the strength of that node’s 
contribution to the Layer Mixer. Using the previous example, selecting Node 4 (the high-contrast 
image used to create the glow), opening the Key palette, and reducing the Key Output Gain 
parameter to 0.50 reduces the intensity of the glow effect by half.

You can use Key Output Gain to mix the proportion of any number of overlapping adjustments in 
order to create the perfect combination for your purposes.

Tip: You can also use the Key Output Gain parameter to mix the proportion of adjustments being 
combined using the Parallel Mixer node.

Converting Layer Mixers to Parallel Mixers

You can easily convert a Layer Mixer to a Parallel Mixer should you discover that you need to mix 
your overlapping corrections evenly rather then combine them with priority. Keep in mind that you’ll 
lose the ability to use Composite modes.

To change a Layer Mixer node into a Parallel Mixer node:

 > Right-click a Parallel Mixer node and choose Morph Into Parallel Node.

Applying a LUT Within a Node

Look up tables (LUTs) are frequently used to create a starting point adjustment for media acquired 
with some sort of logarithmic (log) exposure. DPX log film scans, digital media using the ARRI 
ALEXA’s Log-C encoding, Sony’s S-Log exposure setting, or RED R3D media that is debayered using 
the REDFilmLog setting are all examples of media using a logarithmic exposure curve, designed 
to protect as much detail in the highlights and shadows of a digitally encoded image as possible. 
While log-encoded media retains a lot of image data, the picture is initially flat and unsuitable for 
use without grading. The exposure and color must be adjusted to “linearize” the media, making it 
look the way it’s supposed to, in order to start grading. You can do this manually, or, as a shortcut, 
you can use a LUT that’s tailored to your type of media and the exposures you’re using.

LUTs are also commonly used in onset workflows where dailies are managed with corresponding 
LUTs. These LUTs were used to monitor the media as it was being recorded, and define a baseline 
reference for how each scene is meant to look, at least so far as field monitoring is concerned.

In either instance, LUTs, when used in this way, are adjustments that are applied to affect the look 
of a clip, in much the same way as you’d make adjustments using any of the contrast or color 
controls in the Color page. While there’s an entire group of LUT controls in the Look Up Tables 
section of the Project Settings, those are designed to apply LUTs, in different parts of the image 
processing pipeline, to the entire Timeline. This is useful when you want to apply a single color and 
contrast transformation to the entire program at once, but less so if you want to apply different 
LUTs on a per clip basis. (For more information on using the Look Up Table settings, see Chapter 2, 
“Project  Settings.”)
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DaVinci Resolve lets you apply LUTs within a grade by connecting a LUT to a particular node in the 
Node Editor. 

To apply a LUT within a node:

 > Right-click any node, and choose a LUT from the 1D Input LUT, 1D Output LUT, or 3D 
LUT submenus.

LUTs that you apply using the 3D LUT or 1D Output LUT submenus impose their transformation 
after all other Color page adjustments applied by that node. This means that you can use Color 
and Contrast controls to trim whatever effect the selected node’s LUT is having on the image. 
For example, if the contrast adjustment made by an applied LUT clips the highlights of the image 
too much, you can use that node’s Contrast controls to lower the highlights, restoring detail to 
the image.

The LUT submenus list whichever LUTs have been installed on your workstation. For more information 
on installing LUTs, see Chapter 3, “Project Settings, Caching, and Preferences.”.

RED HDR Input Support

The RED EPIC and SCARLET cameras are capable of shooting in an HDR mode that effectively 
“brackets” two different exposures of each frame. The resulting image data stores two channels 
of image data: the regular exposure, and a “highlight exposure” that’s underexposed by a user-
selectable margin (+3, +4, +5, or +6 ƒ-stops difference).

By default, the Input bar in the node graph feeds the regular exposure to your grade’s node tree. 
To take advantage of the additional “highlight” exposure, you can add an additional Source input 
to the node graph that feeds a second stream of image data that you can mix with the regular 
exposure in different ways.

Note: You can also take advantage of the highlight exposure of RED HDR media by enabling and 
adjusting the Magic Motion controls in the Camera Raw palette.

To set up a node tree combining the normal and highlight HDR versions:

1. Using the first default node (Node 1), grade the image to see if you even need to use the 
alternate exposure that’s available. We’ll assume for this example that you do. In this example, 
the sky of the default exposure is pretty blown out, but there may be detail that can be 
retrieved using the highlight exposure.
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Using HDRx images with the Layer Mixer

2. Create a Layer Mixer node by choosing Nodes > Add Layer (Shift-L), or press the ADD LAYER 
button of your control surface.

 Two nodes are created, a Layer Mixer node that’s added after Node 1, and a third node 
(Node 3) that’s connected to a second RGB input of the Layer Mixer node in parallel to Node 1.

The Source currently supplies two input, but you can add a second source which is the short exposure in the HDR image

3. Right-click anywhere within the node graph (except on a node) and choose Add Source from 
the contextual menu.

 A second Source bar appears underneath the first, which outputs the highlight exposure of 
the image as a separate image stream.
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A node tree that uses a Layer Mixer node to mix two Corrector nodes,  

each connected to separate outputs for the regular and highlight exposures.

4. Delete the connection between the top Source bar and Node 3, and then connect the bottom 
Source bar to the RGB input of Node 3.

 Immediately, the image in the node thumbnail and Viewer updates to show the darker, 
underexposed version of the HDR image. This is because, by default, the Layer Mixer is mixing 
100% of Node 3 over Node 1.

5. Select Node 3 and use one of the following two procedures to create a useful combination of 
the two exposures:

 >  To create a mix of the two exposures, open the Key tab, and drag the Post Mixing Gain 
slider to the left to lower the contribution of Node 3 to the overall image (you can also do 
this using the DaVinci control panel by pressing the KEY MODE soft button, and then using 
the Post Mix Gain rotary control). Using dynamics (keyframing), this is a good way to animate 
a dissolve from the regular exposure to the highlight exposure if you’re going from a dark 
environment to a bright environment in the same take and you want to create a smooth 
transition between both exposures.

Dissolving between the regular and highlight exposures of RED HDR media using the  

Post Mixing Gain slider of a Corrector node connected to a Layer Mixer node.
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Tip: You can also use the Blend Type and Blend Bias parameters in the Camera Raw palette to blend 
the two exposures without building a dedicated node tree.

 > To use the highlight exposure to selectively put detail back into the image (for example, to 
retrieve blown-out windows), use a Power Window, HSL Qualification, or a combination of 
the two to isolate the region you want to retrieve in Node 3. (Be careful if you’re using HSL 
Qualification to combine both exposures, as keyed edges can be tricky to blend.)

Isolating a region of the image to replace using the highlight exposure image of a RED HDR clip

Final node display with isolations
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Clip vs. Timeline Grading

The Node Editor has two modes. The default Clip mode lets you create individual grades for each 
clip or group in the Timeline. However, the Timeline mode lets you apply a single grade simultaneously 
to every clip in the Timeline, as seen in the Thumbnail timeline in the following screenshot. 

A paragon of sophisticated grading, the author applies a red edge vignette to every clip in the project  

simultaneously using the Timeline grade.

There are a variety of reasons you might want to do this. For example, if you’re working on a 
commercial spot, you might elect to use Clip grades to do general correcting and scene-to-scene 
balancing, and then use the Timeline grade to apply a single stylistic grade to the entire spot 
simultaneously. That way, any changes the client wants made to the style of the grade can be 
instantly applied to the whole spot.

Another example would be using the Timeline grade to apply corrections meant to address QC 
issues running throughout a program, desaturating highlights or selectively darkening a specific 
shade of red wherever it appears.

A Note About RED HDR Media and Performance

Since RED HDR media records two complete streams of image data, DaVinci Resolve must 
simultaneously decode two separate tracks whenever you add a second Source bar. (If you don’t 
add the second Source bar, only the first stream is decoded.)

Because of this, whether you’re relying on your computer’s CPU to decode RED media, or you’re 
using a single RED ROCKET card, you’ll get half the performance when using the highlight stream 
of an HDR clip. 

To improve performance, you can set any RED HDR clip’s Render Cache Mode to “User” by 
choosing Color > Render Cache Mode, pressing Option-R, or pressing the CACHE MODE button 
on the T-bar panel of your control surface repeatedly until you toggle to User mode. DaVinci 
Resolve renders all cached clips in the background, so the next time you play a cached clip, it will 
play at full speed.

If you regularly use RED HDR media, two RED ROCKET cards are recommended for optimal 
decoding performance.
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To switch between Clip and Timeline grading modes:

 > Choose the mode from the pop-up menu at the top right of the Node Editor.

Selecting Track mode in the Node Editor

Note: When you reset the Timeline grade using the Color > Reset All Grades and Nodes command, 
the Output Sizing parameters are reset as well.

Timeline Grades and Saved Stills

When you save a Gallery still, the Clip and Track grades are both saved. However, when you apply a 
grade from that still, you only apply either the Clip grade, or the Track grade, depending on which 
mode the Node Editor is in. For more information on saving and applying grades, see Chapter 7, 
“Copying and Managing Grades.”
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Each node’s key input and key output makes it possible to route key channel data from one node 
to another so you can apply isolated corrections. Furthermore, the Key Mixer lets you combine 
a variety of keys from different nodes to create more detailed keys with which to tackle complex 
operations. This section covers all the ways you can recombine key data, as well as how keys can 
be used in conjunction with the Alpha Output bar to create regions of transparency in a clip for 
compositing right within DaVinci Resolve.

Outside Nodes

Whenever you use a Power Window or HSL Qualifier to limit a correction within one node, a special 
node structure lets you automatically create a second node, called an Outside node, to apply 
additional adjustments to the inverse of the region you isolated in the previous node. Outside 
nodes make it easy to apply separate corrections to an isolated subject and its surroundings. 

In the following example, the sky has been isolated using a Power Window, and an Outside node 
has been added to make an additional correction to everything else within the shot.

The Outside node automatically has its key input inverted

To add an Outside node to a node, creating a secondary correction:

1. Select a node that has been limited using a Power Window or HSL Qualifier.

2. Do one of the following:

 > Choose Nodes > Add Outside

 > Press Shift-O

 > Press the ADD OUTSIDE button on the T-bar panel of the DaVinci control surface.

 A new node is created immediately after the selected node, with the RGB and key outputs of 
the first node automatically connected to those of the new node. 

When selecting the new node and opening the Key palette, you can see that the Key Input’s Invert 
control is on by default, which is what inverts the key from the previous node.

Manipulating and Combining Keys
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The Key Input’s Invert control is on by default for each node

If, instead of inverting the incoming key, you want to copy the existing key in order to perform 
another operation to the same isolated region, you can disable the key input’s Invert control.

Feeding Keys From One Node to Another

One of the most powerful aspects of the Node Editor is the ability to create keys based on a 
specific part of the node tree, and feed the result into a completely different correction somewhere 
else in the node tree. This is one of the reasons for the separate key input and output on every 
Corrector node.

The key that’s created whenever you use the HSL Qualifier, create one or more Windows, or use 
an external matte can be output from one node’s key output and fed to the key input of any other 
node in a tree. There are many reasons to do this, but the following example shows a common 
problem you can solve with this technique.

Using a key from one node to make an adjustment with a different node:

1. Use Node 1 to apply a basic primary correction, increasing contrast and balancing the color to 
achieve a pleasing ambient color temperature. 

2. Add a Serial node (Node 2), followed by a Layer Mixer node which also adds Node 4 (as seen 
in the following screenshots). Then, completely desaturate Node 4 and add contrast make it 
super-high contrast black and white, desaturate Node 2 just a bit, and right-click the Layer 
Mixer node to choose the Overlay blend mode with which to combine these two layers.

 The result is a highly stylized image, but the skin tone on the actor’s face and hands in the 
resulting image are too monochromatic, and you want to give them some differentiation. 
Simply adding another node after the Layer Mixer and keying the skin tone may not work well 
because the low level of saturation will make a key difficult to pull. 
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Serial nodes to create a stylized image

3. Add another node after the Layer Mixer (Node 5 in the screenshot), and then right-click in the 
gray background area of the Node Editor, and choose Add Node > Corrector to create an 
unattached node, (Node 6).

4. Connect the RGB output of Node 1 to the RGB input of Node 6, and then connect the Key 
output of Node 6 to the Key input of Node 5. Now you’re ready to pull a high-quality key from 
the very first correction in Node 1, skipping all the complication coming afterwards.

5. Use the HSL Qualifier in Node 6 to pull a good strong skin tone key based on the primary 
image. Given the way the node tree is now set up, that key is fed to Node 5, and will limit 
whatever adjustments you make there.

Using Node 6 to pull a key from the image output by Node 1, and feeding that key to Node 5
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 So now things are almost ready for an adjustment to be made to the actor’s skin tone, however 
the same automatic setting that makes it easy to create Outside nodes is inverting the key that 
Node 6 is feeding to Node 4, which is isolating everything except for the skin tone. This is the 
opposite of what is needed.

6. Double-click Node 5 to select it, open the Key palette, and click the Key Input Invert control 
so that Node 5’s key is identical to Node 6’s key.

Using the Key palette to control the key levels

7. Now, you can make your adjustment to Node 6’s grade, to lower the contrast, brighten, and 
increase the saturation of the actor’s skin tone.

Inverting the key being input into Node 5, to make an adjustment to the actor’s skin tone

As a result of this operation, the background remains desaturated and contrasty, while the actor’s 
skin tone has the richer color we need for the shot.
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Before/After Selective adjustment of skin tone

This example could have been handled in a variety of different ways, but the point is that you can add 
nodes that connect to the state of the image at any part of a node tree, and use them to generate 
keys to feed to any other node, regardless of what’s happening to the picture in between.

Using External Mattes

The External Matte node has evolved over the years. What was once purely a means for importing 
matte channels for defining opacity and limiting adjustments has expanded to become a way to 
import the RGB channels of a media file to be used for overlaying grain, texture, and stylized distress 
onto an image, and even as a way to use the channels of a clip itself as a matte.
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Matte clips are added to your project in the Media page. You can add them by attaching them to a 
clip, so a particular matte is only available to a particular clip as part of a Clip Grade, or you can add 
unattached mattes that stand alone in the Media Pool, which are then available to any Track Grade. 
For more information about adding Matte clips in the Media page, see “Adding and Removing 
External Mattes” in Chapter 4, “Media.”

Whether attached or unattached, mattes operate within a grade using EXT MATTE (external matte) 
nodes. EXT MATTE nodes have the following outputs: 

An external matte connected to the first node of a grade

 > RGBY Outputs: Four blue triangular key outputs let you output the Red, Green, Blue, and 
Luma channels of a matte clip as a key that you can attach to any other node’s key input. 
An interesting aspect of these four outputs is that each one is dedicated to individual R, 
G, B, and Y color channels. Ordinarily, External Matte clips are written with the matte data 
written simultaneously to all three RGB channels. However, you could also render separate 
mattes to each color channel, so that the Red channel has one matte, the Green channel 
another, and the Blue channels still another, thereby exporting three separate mattes within 
a single media file, for convenience. You can then use each one of these mattes individually 
by connecting the correct output of the Ext Matte node.

 > RGB Output: A round orange RGB output lets you connect the RGB image data of a matte 
clip to any other clip’s RGB input. This is especially useful when you’re combining a matte clip 
with the current clip using a Layer Mixer node, to create a textured composite of some kind.
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External Mattes to Limit Adjustments

Going back to the External Matte node’s original use, mattes are typically grayscale media files that 
represent image opacity, and are meant to be used either as alpha channels for creating opacity 
within a corresponding RGB clip, or as a matte for limiting effects. 

An example of a matte channel would be the key created by a green screen keyer. If you output just 
the key, that would be an external matte. If you receive an external matte along with an effects clip, 
you can attach the matte to its corresponding RGB clip in the Media page. Then, you can access 
that matte via an External Matte node in the Node Editor, so you can use the key it outputs to limit 
different kinds of corrections you want to apply. 

In the following example, the keyed matte of a green screen composite clip is used to apply different 
corrections to the inside and outside of a keyed composite, in order to make the subject match the 
background more convincingly.

A matte attached to clip Makeup_composite.mov, as seen in the Media Pool

To use an attached matte to limit an adjustment within a Clip Grade:

1. Right-click any node, and choose the attached matte you want to use from the Add Matte 
submenu of the contextual menu. OpenEXR files with RGBA passes embedded within them 
(RGBA + RGBA + RGBA etcetera) expose multiple entries in this submenu. 

 By default, the EXT MATTE node that appears has its first output connected to the Connect 
one of the EXT MATTE node’s triangular key outputs to the key input of a node you want 
it to limit.

2. Select the node to which the EXT MATTE node is attached, and add an Outside node to make 
it possible to add adjustments on either side of the matte.
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Node Editor displaying the influence of the external matte on multiple nodes when the keys are linked 

3. If necessary, select Node 1, and use the Key palette controls to modify the incoming key, 
inverting or blurring it as necessary to create the isolation you need.

 Note: Don’t select the EXT MATTE node, because it exposes different controls in the Key 
palette for transforming, flipping, looping, and freezing the matte.

 At this point, you can add adjustments to the inside and the outside of this composited shot 
to improve the composite.
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Before/After: An external matte is used to apply separate grades to the foreground and background of a previously composited clip

Ideally, external mattes are exported so that they match the size and duration of the RGB clip 
they’re supposed to accompany. If they don’t match or if you’re using some other grayscale clip as 
an external matte to create some sort of effect, then there are parameters in the Key palette that 
you can use to retime or transform a matte so it works better in your grade.

To slip the sync of a matte relative to the clip it’s attached to:

1. Select the Ext Matte node you want to slip.

2. Open the Key palette, and raise or lower the Offset parameter until the matte is perfectly 
aligned with the clip it’s supposed to match.
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To transform a matte:

1. Select the Ext Matte you want to transform.

2. Open the Key palette, and turn off the Lock Matte checkbox.

3. Use the Pan, Tilt, Zoom, Rotate, Width, Height, HFlip, or VFlip parameters to adjust the matte 
so it has the correct geometry.

It’s worth mentioning that you can attach as many external mattes to a single clip in DaVinci Resolve 
as you like. For example, if a CGI shot has been delivered with a set of isolation mattes for each of 
three characters in the scene, you can import all three mattes and use them to isolate adjustments 
that you want to make in the Node Editor. 

External Mattes to Add Texture

You can also use external mattes as creative tools, to add grain and texture. For example, you might 
use a more abstract animated matte, or a grayscale film scan of dirt and dust, to apply correction 
for effect.

Light leak and dirt and dust images From Warren Eagles’ Scratch FX collection (FXPHD), designed to add texture to your grades

Once attached to a clip, external mattes can be exposed in the Node Editor, and their key output 
can be used just like any other key in a node tree. 

To use an attached matte to create texture a Clip or Track Grade:

1. When applying a matte as part of a Clip or Timeline Grade, right-click any node and choose 
the attached or unattached matte you want to use from the Add Matte submenu of the 
contextual menu. Unattached mattes appear in the Add Matte > Track Mattes submenu.  

2. Disconnect the EXT MATTE node’s Key output connection to the Key input of the node it’s 
connected to by default.

3. Add a Layer Mixer to the end of the node tree.

4. Disconnect the bottom Corrector node’s RGB input, and then connect it to the EXT MATTE 
node’s round RGB output.
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A node tree set up to feed an EXT MATTE node’s RGB output to the input of a node connected to a Layer Mixer, 

in order to blend it with the grade using composite modes

5. Right-click the Layer Mixer node, and choose Overlay from the Composite Mode submenu to 
blend the Ext Matte node most effectively with the grade.

6. If necessary, you can use the grading controls of the Corrector node to which you’ve attached 
the EXT MATTE node to change the characteristics of the texture clip, desaturating it for 
instance. You can also select the EXT MATTE node itself, open the Key palette, and use the 
Transform, Offset, Loop, or Freeze controls described later to change how the matte appears.

The resulting texture effect, blended with the grade using the Overlay composite mode

 Tip: If you want the texture you create to be unaffected by blur or sharpening operations 
within the grade, be sure to add it to the very end of the node tree
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External Mattes to Create Transparency

You can also use an EXT MATTE node to create transparency in a clip, for compositing with clips 
underneath it on the Timeline.

To use an attached matte to create transparency in a clip:

1. Right-click any node, and choose the attached matte you want to use from the Add Matte 
submenu of the contextual menu.

 Adding an EXT MATTE node to a Clip Grade applies the effect to only that clip, whereas 
adding an EXT MATTE node to a Track Grade applies the effect to the entire Timeline.

2. Right-click any empty area of the Node Editor, and choose Add Alpha Output to reveal the 
output bar on the right that lets you assign a key to be used to define clip transparency.

3. Connect one of the EXT MATTE node’s triangular key outputs to the Alpha Output bar at the 
right of the Node Editor.

The node setup for using an external matte to composite two layer

 The areas of the matte defined by the key are now rendered transparent.

The final composite created using the external matte node 
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Key Palette Controls for the External Matte Node

When you select an EXT MATTE node, the Key palette displays different parameters only for mattes. 
Be aware that you must turn off the Lock Matte checkbox before you can make adjustments to 
transform the matte.

The Key Palette showing a texture layer added as an EXT MATTE node

 > Transform: Standard Pan, Tilt, Zoom, Rotate, Width, and Height parameters let you 
transform a matte to fit the image better.

 > Flip Image: Two buttons let you flip the matte clip horizontally or vertically.

 >Offset: Adjust this parameter to offset the start point of a matte clip.

 > Lock Matte: When turned on, locks the sizing of a matte to whatever changes are made to 
the Input Sizing of that clip, so the matte transforms to follow the clip.

 > Loop: Turning on this checkbox enables matte clips to loop endlessly, which lets shorter 
matte clips cover longer durations.

 > Freeze: Turning on this checkbox freezes the matte clip on a single frame. Adjust the Offset 
parameter to choose which frame to freeze on.

You can also use external mattes as creative tools. For example, you might use a more abstract 
animated matte, or a grayscale film scan of dirt and dust, to apply correction for effect.
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Using the Key Mixer

The Key Mixer node lets you mix keys output from multiple Corrector nodes, combining them in 
different ways to create a single key output. This makes it possible to build much more intricate 
keys than you can with a single Qualifier or set of four Windows. In particular, the Key Mixer node is 
the only way to combine multiple keys made using Qualifiers and Windows, adding, subtracting, or 
intersecting them to create a highly specific result.

Adding Two Keys Together

In the following example, you’ll learn how to set up a Key Mixer to combine the keys output by 
two Corrector nodes in a node tree. Then you’ll learn how to change the way the input keys are 
combined using the Key palette.

To combine two or more keys using the Key Mixer:

1. Right-click anywhere on the gray area of the Node Editor, and choose Add Node > Key Mixer.

2. Create two Corrector nodes, then attach their RGB inputs to the RGB output from an 
appropriate node in the main part of the tree, and attach their key outputs to the key inputs of 
the Key Mixer.

3. Next, attach the key output of the Key Mixer node to the key input of the node you want to use 
to make the correction. Remember, the objective is to use the key that’s output by the Key 
Mixer to limit the adjustment being made using another node, in this case Node 4.

Setting up the node tree you’ll need to combine two keys together

 Keep in mind, especially since this is a significant reordering of nodes in the Node Editor, that 
every node needs to be connected properly for the overall grade to work.
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4. Now that the node structure is fully connected, use Windows, Qualifiers, or both to create keys 
in each of the nodes that you connected to the Key Mixer. In this example, Node 2 is isolating 
the main skin tone, and Node 3 is isolating the blue of his jeans.

 By default, all keys connected to the Key Mixer are added together, as you can see in the Key 
Mixer’s thumbnail. 

 However, you can use the controls in the Key palette to change this, in order to isolate the 
intersection of two keys, or to subtract one key from another.

Combining multiple keys with the Key Mixer

 If you wanted, you can use the controls in the Key palette to change this, in order to isolate the 
intersection of two keys, or to subtract one key from another. This is covered in the next section.

5. Continuing with the previous setup where both keys are added together by default, selecting 
Node 5 and dropping the saturation to be very faint stylizes the entire background, while 
leaving the various hues of the man we’ve isolated alone.

Final grade, the talent in color with a B&W background
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Subtracting One Key from Another

The way multiple keys are combined within the Key Mixer depends on a pair of Key Input buttons 
you can toggle using the Key palette. In the following example, a partial blue tint is washed 
throughout the midtones of the image using a qualifier, but you want to exclude the red sign from 
this operation. Using the Key Mixer, you can subtract one key from another.

A selective blue tint added to the midtones of the image includes the red sign

To change the Key Input settings for a node connected to a Key Mixer:

1. In this example, Node 2 is isolating part of the midtones of the image, and feeding its key 
through the Key Mixer to node 5, which is using it to apply a partial blue tint. However, in 
preparation for subtracting the skin tone from this operation, Node 3 is isolating the sign.

A node setup in preparation of subtracting the Bar sign from the midtone isolation being used to add a partial blue tint
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2. To reveal the controls you’ll use to change how the key from Node 3 interacts with the key from 
Node 2, double-click the Key Mixer to select it, then click the line connecting Node 3 to the 
Key Mixer to select that input.

The connection from Node 3 to the Key Mixer is selected and highlighted yellow

3. Open the Key palette; the Input Link parameters are labeled with the number of the connection 
line that you’ve selected, in this case Input Link 2.

The Key Mixer parameters change when a Key Mixer is selected

4. Use the two buttons next to the Key Input label at the upper left of the Key Mixer palette, 
Invert and Matte, to control how the keys interact within the Key Mixer.
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 > To subtract Node 3’s key from that of Node 2: Select the Input Link 2 connection, and turn 
off both the Key Input Matte button and the Key Input Invert button.

 > To limit the output to the intersection of both keys: Select the Input Link 1 connection, and 
turn off the Key Input Matte button.

 >  When you’re finished, the result should resemble the following screenshot.

The result of subtracting a key of the sign from a key of the overall midtones of the image,  

and using that to add a selective blue tint

Adding Inputs to Key Mixer Nodes

New Key Mixer nodes have two key inputs by default. If necessary, additional inputs can be added 
in order to combine even more keys with one another.

To add inputs to the Key Mixer:

 > Right-click a Key Mixer node, and choose Add One Input.

When combining three or more keys, the interaction of keys using the Key palette controls becomes 
even more complex, but the rules outlined above still apply.
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Using the Key Palette

The Key palette contains parameters and controls that you can use to modify key channel data 
being fed into or routed out of the currently selected node. 

Key palette showing controls when a Node is selected

For example, the Key Input Invert control is always enabled, which is why the Outside node works 
automatically. Clicking this control results in keys that are fed into that node exactly mirroring the 
original key.

The controls that are available in the Key palette vary depending on what kind of node you 
have selected:

 > Corrector Nodes: Have three sets of parameters. Key Input parameters let you make 
adjustments to keys being fed through a node’s Key Input connection. Qualifier parameters 
let you make adjustments to the internal key created with the HSL Qualifier or Window 
controls. Finally, the Key Output parameters let you make adjustments to the key data 
being output by a node’s Key Output connection, and includes the incredibly powerful 
Offset Gain parameter that governs the strength of that node’s contribution to the overall 
grade. This functionality is covered more extensively in the next section.

 > Ext Mattes: Have two sets of parameters. Transform parameters let you make geometric 
transformations to a matte so it fits the clip it’s being applied to better. An Offset control 
lets you slip the sync between an external matte and the clip to which it’s applied. This 
functionality is covered in the section on External Mattes.

 > Key Mixer Nodes: Have two sets of parameters that are dependent on which of the 
connections attached to a Key Mixer’s key inputs is selected. Input parameters let you 
adjust how much of a contribution a key makes to the total key mix, and whether the 
contribution is additive or subtractive.

The Output parameters let you adjust the inversion and strength of the key that’s output 
by the Key Mixer. This functionality is described more extensively in the Key Mixer section.

Layer Mixer and Parallel Mixer nodes have no adjustable controls in the Key palette.
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Corrector Node Key Input Controls
 > Input Invert: Inverts the key being fed into the key input. On by default, which is why Outside 
nodes work to automatically adjust everything outside of the secondary operation taking 
place in the node before.

 > Input Matte: Lets you switch the key input between Matte and Mask modes. In Matte mode 
(on by default) the key input combines via intersection with keys generated internally using 
the Qualifier or Windows palette. In Mask mode, the key input is added to the internal 
key instead.

 >Gain: Controls the strength of the key connected to the key input.

 >Offset: Controls the contrast of the key connected to the key input.

 > Blur Radius: Blurs the key connected to the key input

 > Blur H/V Ratio: Alters the horizontal/vertical ratio of the blur that’s being applied to the  
key input.

Qualifier Controls
 >Qualifier invert: Inverts the key created by that node’s Qualifier palette.

 >Qualifier matte: Lets you switch the interaction of the keys generated by the Qualifier 
and Window palettes between Matte and Mask modes. In Matte mode (the default), the 
Qualifier and Windows palettes combine via intersection. In Mask mode, they’re added 
together instead.

 >Gain: Lets you raise or lower the strength of the key generated by the Qualifier palette.

 >Offset: Lets you adjust the contrast of the key generated by the Qualifier palette.

Key Output Controls
 >Output invert: Inverts the overall key.

 >Gain: Using the key output, this parameter governs the strength of that node’s contribution 
to the overall grade. Setting Gain to 0 results in that node having no effect at all, while the 
default setting of 1.00 applies the full strength of any adjustments made with that node. 
The maximum setting of 2.00 increases the intensity of any part of the key output that’s less 
than 100 percent white. You can also use this parameter to keyframe the key output to fade 
that node’s contribution in or out with one set of keyframes.

 >Offset: Lets you adjust the contrast of the Output key. This has no effect if the entire key is 
100 percent white (a solid key).
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The Many Uses of Key Output Gain

Several of the techniques discussed in here and in “Secondary Qualifiers,” can be further customized 
using the Key Output Gain parameter, which makes it easy to control the strength of a node’s effect 
on your grade with a single adjustment. In the following example, two simple Serial nodes are 
applied to a clip, with the first one expanding image contrast, and the second one using a variety of 
controls to add some extreme warmth to the highlights.

A tint applied only to the highlights of the image

If you decided that you want to reduce the amount of warmth added by the second node without 
readjusting the controls you used to create the effect, you could open the Key palette and lower the 
Key Output Gain parameter to fade the effect with a single adjustment.

Four versions of this grade shown using the Versions option of the Split Screen controls,  

with Output Gain set to 1, .75, .5, and.25 for comparison

This principle also works for controlling the strength of individual nodes that are being combined in 
parallel, that are combined using the Layer node, or for simply fading out the effect of any node in 
the node tree you want to “turn down” a bit.
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Isolating and Splitting Color Channels

Resolve provides two different methods of making channel-specific adjustments, depending 
on whether you need to apply an adjustment to just one channel within a single node, or apply 
separate adjustments to all three channels across several nodes.

Enabling and Disabling Individual Node Channels

Within the contextual menu of each node in the Node editor is a series of four options:

Disabling channels and switching color spaces

 > A Color Space submenu that lets you change the color space that node works in between 
RGB (the default red/green/blue), YUV (actually Y’/Cb/Cr), HSL (Hue/Saturation/Lightness), 
and LAB (Luminosity/A/B).

 > Three checked Enable Channel 1-3 options let you turn individual channels off or on, limiting 
which channels operations within that node will affect.

In combination, these controls let you choose a color space for a node to work within, and then 
choose which channels of that color space you want to affect with that node’s adjustments. In the 
following example, you’ll see how to use these features to selectively sharpen just the Y’ (luma) of 
an image without affecting the chroma, which can be a more subtle effect than simply sharpening 
the entire image.
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To use channel disabling and color space conversion to sharpen luma only:

1. Add a node with which to apply the sharpening you want to the current clip.

2. Right-click the new node, and choose YUV from the Color Space submenu of the 
contextual menu.

3. Apply sharpening by doing one of the following:

 > Using that node’s contextual menu, uncheck Enable Channel 2 and Enable Channel 3, which 
correspond to the U (Cb) and V (Cr) channels, leaving only Channel 2 (Y) enabled. Then, 
open the Blur palette, and drag the ganged Radius sliders down to sharpen the Y channel.

 > You can also just open the Blur palette, ungang the Radius sliders, and drag the red 
slider down to sharpen the Y channel, since any control with three gangable sliders will 
automatically assign those sliders to whichever channels are used by the currently selected 
Color Space.

Before - The original image, After - Sharpening applied to only the Y’ channel of the image 

As you can see, while the Blur palette ordinarily provides separate R, G, and B controls that can be 
unganged from one another, the Color Space submenu lets you apply sharpening to the channel 
definitions of other colorspaces, providing many other corrective and creative possibilities with the 
same controls.
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Splitter/Combiner

Another method of applying corrections to individual color channels is using the Splitter/Combiner 
nodes, which break the Red, Green, and Blue channels apart into separate node tree branches, 
each capable of accepting multiple serial and parallel nodes of image adjustment. There are two 
ways you can create a Splitter/Combiner node structure.

Methods of adding Splitter/Combiner nodes:

 > To add a pre-made Splitter/Combiner node structure: Choose Nodes > Add Splitter/
Combiner Nodes (Option-Y). A Splitter and Combiner node appear already connected to 
three corrector nodes, one for each color channel.

 > To manually construct a Splitter/Combiner node structure: Right-click in any empty area 
of the Node Editor, and choose from the Add Node submenu to create a Splitter node, a 
Combiner node, and three Corrector nodes, wiring them together as necessary to create 
the desired effect.

Supported Color Spaces for Conversion

The Colorspace submenu available when you right-click a node in the Node Editor supports four 
different color spaces that you can set each node to work within. When you choose a color space 
other than RGB, all channel-specific controls (the Custom curves, Soft curves, RGB Lift/Gamma/
Gain sliders, and RGB mixer) operate on the particular channels of that color space, rather than 
the default YRGB channels. By switching color spaces, you can achieve very different kinds of 
adjustments by swinging values among mathematically different axes.

YUV converts the image into Y’, Cb, and Cr channels. The Y’ channel governs luminance, while the 
Cb and Cr are color difference channels that work within the broadcast model of color.

HSL converts the image into Hue, Saturation, and Lightness channels. Lightness is identical to 
Luminance, while Hue and Saturation are exactly as described.

LAB operates on the L, A, and B channels. The L channel governs luminance, while the A and B 
channels are color difference channels; A adjusts color on an axis from magenta to green, B adjusts 
color on an axis from yellow to blue.
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The Splitter Combiner node structure

The Splitter node takes an incoming image and provides individual outputs for each color channel 
(top/red, middle/green, bottom/blue). When you connect each of these output to a Corrector node, 
that color channel automatically connects to all three internal channels of that node, so that the 
default three nodes in a Splitter/Combiner structure are internally processing red/red/red, green/
green/green, blue/blue/blue. The Combiner then pulls the Red, Green, and Blue channels out of 
each node connected to its three inputs, and reassembles them into a single RGB image again. Of 
course, what happens in between the Splitter and Combiner is entirely up to you.

One of the simplest ways of showing the possibilities of this node structure is to combine it with 
Node Sizing in the Sizing palette. Using Node Sizing, you can correct for misaligned channels in older 
archived video, or create channel misalignments for creative looks. In the following example, a simple 
Node Sizing adjustment to a split Blue channel will create an interesting “prism vignette” effect.

To use Node Sizing on individually split channels:

1. Choose Nodes > Add Splitter/Combiner Node (or press Option-Y) to add a pre-made Splitter/
Combiner node structure to the node editor.

2. Select the middle of the three corrector nodes appearing in between the Splitter and 
Combiner nodes (Node 5 in the following screenshot).

3. Open the Sizing palette, choose Node Sizing from the Mode pop-up, and then raise the zoom 
parameter by a small amount; this example uses 1.014. 
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Zooming just one color channel using the Splitter/Combiner nodes

 As you can see in the screenshot, just the Green channel has been zoomed in on across the 
entire image. This is only possible using Node Sizing. This is cool, but not quite what you need.

4. Open the Window palette, add a Circular window, turn on its Invert control, and transform it to be 
a very soft, horizontally aligned vignette. This limits the individual scaling done to the Green 
channel to just the outer edge of the image, similar to a lens with excessive chromatic aberration.

The resulting channel split effect

You could easily keep going, applying varying amounts of zoom with different window shapes to 
each of the other color channels, and perhaps adding some blur to enhance the effect, but this 
example should show the creative potential available when using this technique.
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Compositing Using the Alpha Output
While DaVinci Resolve can use the alpha channel of imported media for compositing, the Alpha 
Output bar in the Node Editor is an optional output that you can turn on to create clip transparency 
using operations inside DaVinci Resolve to create composites against other clips on lower video 
tracks. There are many ways of using the Alpha Output, but this section will focus on three examples. 

Using a Qualifier Key to Create Transparency

In this first example, the Alpha Output will be used to composite a green screen clip with a 
background plate.

A green screen clip, ready for compositing

In preparation for this composite, the background plate is on track V1 of the Timeline, and the green 
screen clip has been superimposed on track V2.

A superimposed green screen clip on track V2 of the Timeline, above a background plate on track V1, ready for compositing.
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To create a chroma-key composite in the Color page:

1. Right-click anywhere within the gray area of the Node Editor and choose Add Alpha Output 
to add the Alpha Output bar at the left of the Node Graph.

 An Alpha Output bar appears underneath the Output bar at the right of the Node Editor.

The image Output bar with Alpha output bar below

2. Add a Serial node after Node 1 and connect its key output to the Alpha Output bar. This is a 
fast way to build this composite if you’re confident that the corrections you’ve made in Node 
1 won’t adversely affect the key (or if you know they’ll improve it by expanding the contrast of 
a flat-contrast source clip).

 Alternately, you could create a second processing branch by adding a disconnected node 
(Node 2), connecting the Source bar to its RGB input, and then connecting its key output to 
the Alpha Output bar you just added. Creating a second image processing branch from which 
to pull your key lets you key directly from the source, avoiding any problems that grading the 
first node could introduce to the key.

Node 1 grades the clip, expanding contrast to improve both the image, and its ability to be keyed.  

Node 2 uses Qualifier controls to pull the key.
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3. Use the Qualifier controls of Node 2 to key out the green background, and then turn on the 
Invert checkbox to create the proper composite. You can also use a Power Window to garbage 
matte out any elements you don’t want intruding into the shot.

An HSL Qualification to key the green feeding the Alpha Output to create transparency

4. You can also use a Power Window to garbage matte out any elements you don’t want intruding 
into the shot.

A Power Curve used to garbage matte out unkeyable lighting fixtures
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5. If necessary, you can add another node to the output of Node 2 to make whatever corrections 
are necessary to the background plate clip to make the composite blend more seamlessly, 
such as using the Hue Vs. Sat curve to desaturate green spill. Making these corrections after 
Node 2, where the qualifier is used, guarantees that any color adjustments won’t affect the key.

Adding more color adjustments to a node added after the Qualifier

With all this set up, you end up with a nice green screen composite that’s visible in both the Color 
and Edit pages.

The result, with a window garbage matte cropping out the equipment, ready for further refinement 

Using a Matte to Create Transparency

If you’ve been provided with a separate Matte clip for defining clip transparency, you can use that 
Matte clip within the node tree of a superimposed clip to create a composite using the Alpha Output.
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To create a composite using an external matte:

1. To associate an external matte with a clip, open the Media page, select the clip you want to 
add a matte to in the Media Pool, navigate to the matte file using the Library browser, and then 
right-click the matte file and choose Add as Matte. For more information on importing mattes, 
see Chapter 3, “Working in the Media Page.”

2. Open the Color page and select the foreground clip in the Thumbnail timeline, then right-click 
Node 1 in the Node Editor and choose the matte you added from the Add Matte submenu.

 An EXT MATTE node appears underneath Node 1, with the first of its four key outputs 
connected to Node 1’s key input. (Working with external mattes is covered in more detail in a 
prior section of this chapter.)

3. Now, right-click anywhere within the node graph (other than on a node) and choose Add 
Alpha Output from the contextual menu.

 An Alpha Output bar appears underneath the Output bar.

4. Drag a connection line from the second key output of the EXT MATTE node to the Alpha 
Output bar.

Using an external matte in the grade and to the Alpha output



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

739

ADVANCED COLOR FEATURES12

 You should now see a successful composite, with the external matte creating a region of 
transparency in the foreground clip though which the background clip shows through.

Use an OFX Plug-in to Create Transparency

If you’ve installed an OFX plugin capable of keying, you can right-click the node you’ve applied it to 
and choose Use OFX Alpha to route the key created by the plug-in out the KEY output of that node. 
When Use OFX Alpha is enabled, the HSL Qualifier and Window palette output is ignored, the only 
key that’s output is from the OFX plug-in.

Choosing Use OFX Alpha in the Node Editor

Before and after the final composite, created by connecting an Ext Matte node to the Alpha Output in the node graph
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Once Use OFX Alpha is enabled, and you’ve created a key using your OFX plug-in of choice, you can 
right-click anywhere within the node graph (other than on a node) and choose Add Alpha Output 
from the contextual menu to make the Alpha Output bar appear, and you can then connect the KEY 
output from the node with the OFX plugin to the Alpha Output to use it to create transparency.

Setting up a composite using an OFX plugin

Note: When Use OFX Alpha is enabled for a node, you cannot use a window to create a garbage 
matte within that node as you would when keying with the HSL Qualifier. To create a garbage matte 
with which to exclude unwanted and unkeyable elements from the edges of the picture, you’ll need 
to combine the key from a window in another node with the key output by the OFX plugin using a 
Layer Mixer node.

Combining an OFX key with a Window using a Key Mixer to add a garbage matte

Compositing Entirely Within an OFX Plug-In

Certain OFX plug-ins that are capable of combining two image streams to create a composite can 
now be used as of Resolve version 11.1 by exposing a “second layer input” on the node to which 
that plug-in has been applied. This makes it possible to composite the image you’re grading with 
the RGB output from an EXT MATTE node.
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Combining a clip with an EXT MATTE image using the second layer input of a node with an OFX plug-in applied to it

To create a composite using an OFX plug-in:

1.  Open the OpenFX Panel, use the Library to find the OFX compositing plug-in that you want to 
use, and drag it onto the appropriate node to apply it. The above example shows the Genarts 
Sapphire plug-in “S_MathOps,” which mathematically combines two image streams using 
one of a long list of blending modes.

2.  Right-click the node with the OpenFX plug-in applied to it, and choose Second Layer Input 
from the contextual menu. A second RGB input should appear on the left of the node, 
underneath the first.

Adding the second layer input of a node with an OFX plug-in applied to it
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3.  Open the Media page, locate the clip you want to composite in the Library, and import it as 
an unassigned matte.

4.  Open the Color page again, right-click the node with the OpenFX plug-in applied to it,  
and choose Add Matte > Track Mattes > “name of matte imported in step 3” from the 
contextual menu.

5.  By default, the EXT MATTE node that appears is connected via one of its key outputs. Delete 
the key connection, and drag a new connection line from the EXT MATTE node’s RGB output 
to the second RGB input of the node with the OpenFX plug-in. 

The composited image, node tree, and OFX parameters shown side by side

6.  At this point, the node tree is wired up to composite the clip with the EXT MATTE image, and 
you need only adjust the parameters of the OpenFX plug-in to achieve the result you desire.
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Keyframing

Whether it’s referred to as keyframing, dynamics, or marks, DaVinci Resolve provides an interface 
for automatically interpolating color adjustment parameters in various ways from one setting  
to another.

For example, if you have a clip with varying exposure settings, you can animate a series of contrast 
adjustments using Dynamic keyframes to make the changes in exposure less distracting. 

The Keyframe Editor with dynamic keyframes animating the parameters of Node 2

In another example, you can insert Static keyframes (marks) at the cut points of clips. These 
keyframes actually consist of multiple shots that are merged in a single piece of media to create 
individual adjustments for each shot, separated by a keyframe.

In both cases, you use the Keyframe Editor to create a series of keyframes with which to change 
parameters from one value to another. In this section, you’ll learn how to work with the Keyframe 
Editor to set up these kinds of animated changes.

Round static keyframes added to all parameters, enabling individual adjustment of shots merged together within a single clip
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The Keyframe Editor Interface

The Keyframe Editor has all the controls necessary to create and modify keyframes for the currently 
selected clip. If necessary, you can even make it wider in a single screen layout by clicking its expand 
button (at the bottom left of the Keyframe Editor), or use the Color page’s Dual Screen layout to 
place the keyframe editor on a second screen, for even more room.

The Node Editor shown in wide mode, pushing all other palettes to the left

The Keyframe Editor consists of the following components. 

 > The Timeline Ruler: Mirrors the record timecode of the currently selected clip; dragging 
within the Timeline Ruler moves the playhead, and a timecode display to the left shows the 
current frame.

 > The Keyframe Track Header: Each node in the current grade has a corresponding keyframe 
track, and the header contains controls you can use to manage the keyframing. 

The Keyframe Track Header

 > Track Disclosure Triangle: Exposes individually keyframable groups of parameters 
underneath the main keyframe track. 

 > Enable/Disable Button: A round orange button lets you enable or disable that track’s 
corresponding node. 

 > Lock Button: Lets you prevent any changes from being made to that track’s 
corresponding node.
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 > Auto-Keyframe Button: Turn this button on to automatically create a Dynamic keyframe 
every time you adjust any parameter within that node.

 > Keyframe Tracks: To the right of the track header, the keyframe tracks are where you 
create and edit the keyframes that animate parameter changes. A topmost “master 
keyframe track” shows every keyframe applied on every keyframe track in the Keyframe 
Editor, even keyframes applied to a keyframing track hidden inside a track with a closed 
disclosure triangle.

 > Keyframes: Each keyframe appears as a small diamond for a Dynamic keyframe or as a 
circle for a Static keyframe. Dynamic keyframes are associated with dissolves while Static 
keyframes (marks) act instantly. Grades are linked to the preceding keyframe, which may be 
a default one on the first frame of the master clip. Keyframes can be selected by clicking on 
them, or moved by dragging them to another position in the keyframe track.

 > Sizing track: The Pan, Tilt, Zoom, Rotate, and Convergence (in Stereo 3D projects) parameter 
have an entirely separate track for creating animated pan and scan adjustments.

 > Track Selection Bar: A colored bar shows the currently selected scope of keyframing: all 
tracks at once, just the current correction node, or the Sizing settings. This will be covered 
in more detail later in this chapter.

Ordinarily, the Keyframe Editor takes up the rightmost bottom third of the Color page. However, you 
can make it wider to have more room to work if you have a scene requiring complex keyframing.

To expand and collapse the Keyframe Editor:

 > Click the Expand/Collapse button at the lower left-hand corner of the Keyframe Editor.  
The Keyframe Editor widens or narrows accordingly.

To zoom into and out of the Keyframe Tracks:

 > Use the zoom slider to zoom into or out of the Keyframe Editor.

 > Right-click any keyframe track and choose Maximum Zoom to zoom all the way in.

 > Right-click any keyframe track and choose Reset Zoom to fit the entire clip into the available 
width of the Keyframe Editor.

All/Color/Sizing

Perhaps the most important control for keyframing, the Keyframe Timeline mode, lets you switch 
the scope of what tracks get keyframed when you use the Start Dynamic or Add Static Keyframe 
commands, either from the keyboard or via the buttons of your control surface. This command 
alternates among three modes:

 > All: The default mode. Adds keyframes to every track in the Keyframe Editor, keyframing 
every parameter in every node all at once, including the Sizing settings. In this mode, an 
orange bar appears highlighting the topmost “master keyframe track.”
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 > Color: Only adds keyframes to the node currently selected in the Node Editor. In this 
mode, a green bar appears highlighting the keyframe track corresponding to the node 
currently selected.

 > Sizing: Only adds keyframes to the Sizing track, which is useful when you’re keyframing “pan 
and scan” style transforms. In this mode, a blue bar appears highlighting the Sizing track.

 > EXT MATTE: Only appears if there’s an External Matte node in the node tree. Lets you 
keyframe External Matte-specific parameters in the Key palette.

Even though All is the default setting, it may be to your advantage to switch to the Color or Sizing 
keyframing modes to avoid creating a lot of unnecessary keyframes. Even though keyframing 
everything all at once is a fast way to work, the extra keyframes may slow you down when you later 
need to make adjustments to nodes that didn’t need to be keyframed in the first place.

To change the keyframing mode, do one of the following:

 > Choose an option from the Keyframe Mode pop-up at the top right of the Keyframe Editor.

 > Choose an option from the Mark > Keyframe Timeline Mode submenu.

 > Press the ALL/COLOR/Sizing button on the Transport panel of the DaVinci control surface 
repeatedly until you’ve chosen the mode you need.

Tip: This control has one other function. Choosing a mode also affects what is copied when you use 
the various grade management tools in DaVinci Resolve. For example, if you choose Color, then you 
can copy a clip’s color grade without copying its sizing. If you choose Sizing, then you can copy the 
sizing without copying the color grade. For more information, see “Copying Grades” in Chapter 13, 
“The Gallery and Grade Management.”

Keyframing Methods

There are two different types of keyframes used by DaVinci Resolve to create automated changes. 
Each type of keyframe interpolates parameters differently.

Dynamic Keyframes (Dynamics)

Dynamic keyframes are the most conventional type of keyframe you’ll use, and are the type of 
keyframe used for creating animated changes from one state to another. For example, if you need 
a grade to become brighter over time to compensate for a change in lighting conditions, you’ll use 
Dynamic keyframes.

Nearly every parameter and control in the Color page can be keyframed, but it’s important to 
understand that the Interface controls do not animate to match whatever dynamically keyframed 
changes are taking place. Instead, visible Interface controls that correspond to keyframed changes 
will jump from their initial position at one keyframe to their final position when the playhead reaches 
the next keyframe. 
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This can be most confusing with Curves, which can be interpolated using Dynamic keyframes just 
like any other control or parameter. Just keep in mind that the actual settings are animating, even 
though the controls are not.

To animate a node using Dynamic keyframes:

1. Move the playhead in the Keyframe Editor’s Timeline ruler to the frame where you want to 
begin a change.

2. Do one of the following to place a Dynamic keyframe at that frame:

 >  Choose Mark > Make Dynamic Keyframe.

 >  Press the START DYNAMIC button on either the T-bar or Transport panels of the DaVinci 
control surface.

 Dynamic keyframes are green.

3. If necessary, adjust your clip at this first position of your animated change.

4. Now, move the playhead to the frame that is at the second position of the animated change 
you’re making, and create another Dynamic keyframe using the commands described in step 2.

5. After you’ve created this second keyframe, make whatever adjustments are necessary to the 
clip to create the final look you need.

 At this point, playing from the first keyframe to the second keyframe should show a smoothly 
animated change from the first adjustment to the second.

Static Keyframes (Marks)

Static keyframes, or marks, are keyframes that are used to create abrupt, one frame changes from one 
state to another. They’re typically used to mark edit points separating one shot from another when 
multiple shots appear within a single clip. However, Static keyframes are also useful in any situation 
where you need a sudden change from one setting to another, such as when creating a lightning effect. 

Dynamic keyframes are round



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

748

ADVANCED COLOR FEATURES12

To automate a node using Static keyframes:

1. Find the frame at which you want the abrupt change to take place, and place a keyframe at 
that frame by doing one of the following:

 >  Choose Mark > Make Static Keyframe.

 >  Press the MARK button on either the T-bar or Transport panels of the DaVinci 
control surface.

 Static keyframes (marks) are white.

2. Move the playhead to any frame before the keyframe to make changes to the entire segment 
of the clip leading up to the keyframe, or move the playhead to any frame after the keyframe 
to make changes to the entire segment of the clip appearing after the keyframe. The playhead 
does not need to be on top of the keyframe, but if it is, you’ll be adjusting the second portion 
of the clip.

Note: If you’re using Static keyframes to automate grading changes between multiple shots 
appearing within a single clip, keep in mind that you can’t add nodes from one keyframe to the next 
as you would if you had split the clip in the Edit page.

Mixing and Converting Dynamic and Static Keyframes

Typically, if you’re creating multiple animated changes within a clip, you’ll want to use all Dynamic 
keyframes. Similarly, if you’re creating a series of abrupt changes, you’ll use all Static keyframes. 
However, you can mix Dynamic and Static keyframes together, so long as you keep in mind the 
following rules:

If you add a Dynamic keyframe to the right of a Static keyframe: There will be no interpolation from 
the Static keyframe to the Dynamic keyframe. However, if you add a Static keyframe to the right of 
a Dynamic keyframe, there will be interpolation.

No dynamic interpolation following the static keyframe
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If you accidentally create the wrong kind of keyframe, it’s easy to convert it into the type of 
keyframe you need.

To change one kind of keyframe into another:

1. Click the keyframe you want to convert to select it.

2. Right-click the selected keyframe, and choose either Change to Dynamic Keyframe or Change 
to Static Keyframe.

Using Specific Keyframing Tracks

If you’re simply using the Color mode of the All/Color/Sizing command to do keyframing, then 
you’ll be adding keyframes to every parameter of the currently selected node whenever you apply 
a single keyframe. However, often that’s overkill in situations where you only need to keyframe a 
single setting or group of settings.

For example, you may find that you need to keyframe a color adjustment in order to change the 
color temperature and brightness when the camera pans across a window, but you don’t want to 
keyframe the Windows palette controls because you want to adjust them independently. This can 
be done by opening a Corrector track to expose the keyframing tracks within. 

Keyframing tracks let you keyframe different sets of similarly functioning parameters separately from 
one another. For example, there’s one keyframing track for all the color adjustment parameters, and 
another keyframing track governing the parameters found within the Qualifier palette.

Keyframing tracks let you keyframe different sets of similarly functioning parameters separately from 
one another. For example, there’s one keyframing track for all the color adjustment parameters, and 
another keyframing track governing the parameters found within the Qualifier palette.

Try Creating Keyframed Changes in a Separate Node

One tip to keep in mind is that you don’t have to create keyframed changes within the same nodes 
you’re using to create other adjustments. If you want to create some automated changes without 
altering the nodes you’ve already adjusted, you can simply create a new node in which to make your 
keyframed changes. That way, if you don’t like the result, or you somehow find yourself hopelessly 
tangled up in a needlessly complicated set of keyframes, its easy to reset either just the keyframes 
or the entire node without affecting the rest of your grade.
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To reveal a node’s keyframing tracks:

 > Click the disclosure triangle next to the number of the node you’re keyframing.

To keyframe an individual keyframing track manually:

1. Make whatever adjustments you need to the currently selected node, and click its disclosure 
triangle to reveal its keyframing tracks.

2. Move the playhead in the Keyframe Editor to where you want to add the first keyframe, then 
right-click within the keyframing track you want to animate, and choose Add Static Keyframe 
or Add Dynamic Keyframe (this example shows a Dynamic keyframe).

 A keyframe appears at the position of the playhead in that keyframing track.

3. Move the playhead in the Keyframe Editor to where you want to add the next keyframe, then 
right-click within the keyframing track and again choose either Add Static Keyframe or Add 
Dynamic Keyframe (this example shows a Dynamic keyframe).

Keyframing just the Circular Power Window using its individual keyframe track 

Individual keyframing tracks within a Color Corrector node
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 Now, you can make whatever changes you need to the controls governed by the keyframing 
track you keyframed, in order to create the necessary animated effect.

Tip: You can also animate individual keyframing tracks using automatic keyframing, explained in 
more detail later in this chapter.

The Corrector Keyframing Tracks

All of the parameters governing the adjustment of color and contrast controls, as well as various 
effects, Power Windows, and other adjustments are sorted into various sub-tracks within the 
Corrector track.

 > Linear Win: Controls parameters corresponding to the Linear Window.

 > Circ Win: Controls parameters corresponding to the Circular Window.

 > Polygon Win: Controls parameters corresponding to the Polygon Window.

 > PowerCurve: Controls parameters corresponding to the PowerCurve Window.

 >Gradient Win: Controls parameters corresponding to the Gradient Window.

 > Color Corrector: Controls all parameters found in the Camera Raw, Color Wheels, Primary 
Controls, RGB Mixer, and Curves palettes.

 >Qualifier: Controls all parameters in the Qualifier palette.

 > Defocus: Controls all parameters in the Key palette.

 >NR: Controls the Spatial and Temporal Noise Reduction and Motion Blur parameters found 
in the Motion Effects palette. 

 >OFX: Controls all parameters of whichever OFX plugin is applied to the current node.

 >Node Format: Controls all parameters of the node sizing mode of the Sizing palette for the 
current node.

The Sizing Keyframing Tracks

The Sizing keyframing tracks govern sizing transforms and stereoscopic adjustments separately 
from the color controls.

 > Input Sizing: Controls the Input Sizing parameters found within the Sizing palette. 

 > Convergence: Controls the Convergence parameter in the Stereo 3D palette.

 > Float Window: Controls the Left, Right, Top, and Bottom Position/Rotate/Softness Floating 
Windows parameters.

 > Auto Align: Controls the Pitch and Yaw parameters in the Stereo 3D palette.

Tip: Output Sizing can only be keyframed when you choose Track mode in the Node Editor.
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The Ext Matte Node’s Freeform Isolation Track

If your node tree has an External Matte, the EXT MATTE node exposes a Freeform Isolation track in 
the Keyframe Editor. This is useful for time offsets or Sizing repositioning of the Ext Matte image.

Automatic Keyframing

Every track in the Keyframe Editor has an Auto-Keyframing button that can be turned on or off. 
When auto-keyframing is enabled for a particular track, every change made to a parameter or 
control associated with that keyframe track automatically generates a keyframe.

Used with a keyframing track, auto-keyframing makes it simple to set up animated changes to 
specific adjustments within a node. This is a lot easier than manually placing keyframes one by one.

On the other hand, turning on auto-keyframing for the Corrector track correspondingly enables auto-
keyframing for every keyframing track belonging to that node. In this case, keyframes will automatically 
be placed on whatever keyframing track corresponds to the parameters or controls you adjust.

Auto-keyframing selected for Circular Window on Node 1

When auto-keyframing is disabled, changes you make alter existing keyframes. How this alteration 
works depends on the location of the playhead, and the type of keyframes in the Keyframe Editor. 
For more information, see the next section.

Modifying Keyframes

Once you’ve started adding keyframes to animate changes to a grade, there are a variety of 
methods available to navigate and edit these keyframes to further customize these effects. This 
section covers the different ways you can navigate among, alter, and remove keyframes.

Navigating Among Keyframes

For many operations, it’s necessary to move the playhead directly on top of the keyframe you want 
to modify. While you can always use the transport controls or pointer to move the playhead, there 
are also commands for jumping to a specific keyframe.
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To move the playhead among a series of keyframes, do one of the following:

 > Choose Playback > Next Keyframe (Option-Grave) or Playback > Previous Keyframe 
(Option-Semicolon).

 >On the Transport panel of the DaVinci control surface, press SHIFT then STEP REV to 
move the playhead to the previous keyframe, or press SHIFT then STEP FWD to move the 
playhead to the next keyframe.

Moving Keyframes

If you need to change the timing of a series of keyframes, you can move the position of any keyframe, 
along with whatever values that keyframe contains.

To move a single keyframe using the on-screen interface:

 > Use the pointer to drag any keyframe to another location.

 > Drag keyframes in a Corrector or Sizing track to simultaneously move all other keyframes 
on the same frame within that corrector.

To move a single keyframe using the DaVinci control surface LIFT MARK button:

1. Move the playhead to the keyframe you want to move. This procedure works for either Dynamic 
and Static keyframes.

2. Press LIFT MARK on either the T-bar or Transport panels.

3. Move the playhead to the frame you want to move that playhead to.

4. Press MARK on either the T-bar or Transport panels. 

To move multiple keyframes at the same time:

1. If necessary, open the keyframe track with the keyframes you want to move.

2. Hold the Shift key down, and drag a bounding box around the keyframes you want to move. 
Selected keyframes appear highlighted in red.

3. Keeping the Shift key held down, drag anywhere within the keyframe track to move all selected 
keyframes to the left or right.

Changing Keyframe Values

Unlike many other applications, DaVinci Resolve lets you alter keyframe values when the playhead 
isn’t directly on an existing keyframe. How this works depends on the location of the playhead 
relative to the keyframes that are in the Keyframe Editor, and what kind of keyframes you’re editing.

 > If the playhead is to the left or on the first Dynamic keyframe: The Dynamic keyframe at or 
to the right of the playhead updates with the new adjusted values.



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

754

ADVANCED COLOR FEATURES12

 > If the playhead is to the left or on the last Dynamic keyframe: The Dynamic keyframe at or 
to the left of the playhead updates with the new adjusted values.

 > If the playhead is between two Dynamic keyframes: The Dynamic keyframe to the left of 
the playhead updates with the new adjusted values, but the Dynamic keyframe to the right 
is unaffected.

 > If the playhead is between two Static keyframes (marks): Adjustments made between two 
Static keyframes always affect the keyframe to the left of the playhead. The entire segment 
of the clip between that keyframe and the next is affected equally.

Changing Dynamic Attributes

By default, the transition from one Dynamic keyframe to the next is linear. However, if you need to 
alter the acceleration of value interpolation from one Dynamic keyframe to the next, then you can 
change that keyframe’s Dynamic Attributes.

To change a keyframe’s Dynamic Attributes:

1. Right-click a keyframe in the Keyframe Editor, and choose Change Dynamic Attributes.

2. When the Dynamic Attributes window appears, do one or both of the following:

 > Choose a new outgoing acceleration curve using the Start slider, affecting the interpolation 
occurring to the right of that keyframe.

 > Choose a new incoming acceleration curve using the End slider, affecting the interpolation 
occurring to the left of that keyframe.

 As you choose different acceleration curves, the display to the right shows the resulting  
curve graph.

Changing the dissolve profile
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3. When you’re happy with the curve, click OK.

By using different Start and End values, you can make animated adjustments “ease in” or “ease 
out” of a particular keyframe, to create a more gradual or abrupt transition.

Tip: The default dynamic profile start and end of each new keyframe can be set in the Editing and 
Ripple panel of the Project Settings.

Deleting Keyframes

You have the option to delete individual keyframes, or to delete all the keyframes within a particular 
grade at once.

To delete individual keyframes, do one of the following:

 >Move the playhead on top of the keyframe you want to delete, then choose Mark > Delete 
Keyframe. Every keyframe at the position of the playhead is deleted.

 > Using the DaVinci control surface, press DELETE on either the T-bar or Transport Panels. 
Every keyframe at the position of the playhead is deleted.

 > Using the pointer, click a keyframe in the Keyframe Editor to select it, then right-click that 
keyframe and choose Delete Selected Keyframe. Only the selected keyframe is deleted.

To delete every keyframe for the current clip:

 > Choose Mark > Delete All Keyframes.

Copying Keyframes

It’s possible to copy a set of keyframes from one node to another, either within the current grade, 
or in another clip entirely.

To copy a set of keyframes from one node to another:

1. Select a node to copy keyframes from, and choose Edit > Copy (Command-C).

2. Select another node to paste keyframes to, and choose Edit > Paste (Command-V).

Tip: This procedure also works for tracking data that you want to copy from one node to another, 
either in the current clip, or another clip altogether.

Keyframes and Saved Stills

If you save a still from a clip using keyframes within the grade, the keyframes are not saved. However, the 
still and grade that are saved reflect whatever parameter values were at the position of the playhead. 

For example, if a clip has a dynamically keyframed transition from a saturation of 50 to a saturation 
of 0, and you place the playhead right in the middle of both keyframes when you save a still, the 
grade and still that are saved have a saturation of 25.
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Adding EDL Marks

Just as clip grades are separate from the track grade that can be applied to the entire Timeline, 
so clip keyframes are separate from track keyframes. Keyframes you apply to the track grade work 
exactly the same as clip keyframes. However, there is one extra option you have when keyframing 
the track grade.

If you find yourself wanting to adjust a track grade individually to take into account variations from 
one clip to the next, you can use the Add EDL Marks on Tracks command to add a Static keyframe 
(mark) to the Keyframe Editor at the position of every edit point in the entire Timeline.

To add EDL Marks:

1. Choose Track from the Node Editor’s mode pop-up menu.

2. If you want to keyframe a grade, then create whatever grade you need to apply to the entire 
Timeline. If you want to keyframe Sizing settings, you don’t need to do anything else.

3. Right-click the Corrector track or the Sizing track in the Keyframe Editor, and choose Add EDL 
Marks on Tracks.

 Marks appear at the frame of every edit point in the Timeline. You may want to widen the 
Keyframe Editor to make it easier to work with all these keyframes.

After you’ve added EDL marks, you can delete them if you decide you don’t want them any more.

To delete EDL marks:

 > Right-click the Corrector track in the Keyframe Editor, and choose Add EDL Marks on Tracks.

If you’ve added your own keyframes in addition to the EDL marks, then the Delete EDL Marks on 
Tracks command only eliminates the EDL marks. Your custom marks are left alone.
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The interactive Dirt and Dust Removal tool provides an interface for dustbusting right from within 
DaVinci Resolve. This is a raster-based effect, and results in a duplicate set of “dustbusted” media 
being created within a hidden subdirectory. 

If, at any point, you’re unsatisfied with the adjustment you’ve made, you need only use the Undo 
command to return the clip you’re working on to its prior state.

Note: The Dirt and Dust Removal tool only works with DPX image sequences. Media in a raw, ProRes, 
or DNxHD format must first be converted to a DPX image sequence before it can be operated on 
with this tool.

To use the Dirt and Dust Removal tool:

 > Click the Onscreen Control pop-up menu at the bottom left of the Viewer, and choose  
Dust Removal.

Selecting the Dirt and Dust tool in the viewer OSD menu

To open the Dirt and Dust Removal tool setup options:

 > Right-click the Dirt and Dust Removal icon showing in the Onscreen Control pop-up to 
open the setup window.

Dirt & ROI Settings Parameters

In the Dirt & ROI Settings window, there are a number of parameters that you can use to optimize 
this tool for the particular problem you’re trying to solve.

 > Algorithm: The Algorithm pop-up menu lets you select the method of filtration to use when 
painting out dirt or dust. Different options provide different methods for replacing the 
problem pixels with image data copied from other frames in time, or from other regions of 
the current frame. You’ll want to choose an option that works best for the type of camera 
and subject motion happening within the clip you need to clean. For more information on 
the advantages of each algorithm, see the next section.

Dust Removal



DAVINCI RESOLVE COLORIST REFERENCE MANUAL

758

ADVANCED COLOR FEATURES12

 > Aggression: Increase or decrease the Aggression and Blend sliders depending on the 
degree of correction you want to apply.

 > Blend: Sets the % of the original image to be feathered at the edges of the repair.

 >Optimize: Turning this option on provides better-looking results, at the expense of increased 
processing time.

 > ROI Mode: Determines whether a correction is applied with a single click, or via a paint 
stroke. There are three options.

 > Click and Clean: Applies a correction with one click, and is fast to use on small dust spots. 

 > Draw and Clean: Lets you “paint” over a larger dirty area with the mouse or a pen, with 
the correction being applied at the conclusion of your paint stroke.

 > Cnc Size: Defines the width of the “brush” that’s used to paint out dirt and dust.

Algorithms for Dirt and Dust Removal

There are six algorithms you can choose from that determine how the pixels you paint over are 
automatically replaced.

 > Auto-temporal –/+ 1: When an ROI is drawn, the previous frame, the next frame and the 
current frame will all be used for analysis. The best of these 3 will be automatically selected 
and used for removing the dirt in the current frame.

 > Auto-temporal –/+ 2: This is the same as the above, but the frames used instead are the 
current frame, previous-to-previous frame (i.e., 2 frames back), and next-to-next frame (i.e., 
2 frames forward). Therefore, if the ROI is drawn on frame 100, frame 98, frame 100 and 
frame 102 will be used for analysis. The best of these 3 will be used for removing the dirt 
in the current frame. The advantage of this selection is that it will avoid the appearance of 
frozen grain, which may be possible in case of dirt against a stationary background.

 > Temporal –/+ 1: if the ROI is drawn by dragging the mouse from left to right, the next frame 
will be used for motion-compensated dirt removal. If the ROI is drawn by dragging the 
mouse from right to left, the previous frame will be used.

 > Temporal –/+ 2: if the ROI is drawn by dragging the mouse from left to right, the next-
to-next frame will be used for motion-compensated dirt removal. If the ROI is drawn by 
dragging the mouse from right to left, the previous-to previous frame will be used.

 > Spatial: In case of fast or blurred motion, using the previous or next frames may give 
unsatisfactory results. In this case, the same frame itself can be used for removing the dirt. 
This will use surrounding information in the current frame to remove the dirt.

 >Median: The Median filter performs a blending of the pixels, smoothing out the region. Use 
this when other options do not replace the image, or when there is no support information 
in which to reconstruct the original. Using small boxes will produce better results.


